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FlowLogic 8 - Introduction 
 
Layout Overview – GateLogic, GraphLogic, DocLogic and 
BeadLogic 
 
FlowLogic is divided into four sections: GateLogic, GraphLogic, DocLogic and 
BeadLogic. These sections are accessed by clicking on the tabs located at the 
top of the program window. 
 
GateLogic is where FCS files are imported, gates are drawn on plots, overlays 
are created, data array analysis is performed and gate statistics are set and 
viewed. 
 
GraphLogic is where statistical analysis is performed and graphs are created 
for both FCS-derived and independent data. 
 
DocLogic is where reports and presentations are created by adding elements 
created in GateLogic and GraphLogic. Plots, plates and statistic tables, 
amongst other items, can be added to reports to be saved as PDF or .pptx files. 
Documents can also be annotated with a range of shapes, images and text. 
 
BeadLogic is a multiplex data analysis tool. Initial sample gating and definition 
is performed in GateLogic (using PlateLogic, a plate layout and visualization 
tool) before being sent to BeadLogic for regression analysis, unknown sample 
interpolation and reporting. 
 
GateLogic, GraphLogic and DocLogic are linked, so when a gate is adjusted, 
all statistics, graphs and reports are updated automatically. 
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FlowLogic Technical Specifications 
 

• Cross-platform software that runs in Windows, Mac and Linux operating 
systems 

• Operates in both 32- and 64-bit environments 
o Maximum memory allocation in 32-bit environments is 1026Mb 

• Analysis files saved under one operating system can be opened using 
another 

• Requires Java SE Development Kit (JDK) 8 and above 
o The JDK is a free download from the Oracle website 
o M1 Apple Silicon Macs require an ARM architecture specific JDK. 

For download instructions and further information on this topic, 
please contact support@inivai.com  

 

FlowLogic Intended Operating Environment 
 
FlowLogic is designed to operate in a local computer. This includes reading 
FCS/MQD files, along with saving and reading analysis files (.glf and 
.gatelogicexperiment files).  
 
For people connected with a network drive, it is recommended to move the 
FCS/MQD files to the local computer where FlowLogic is installed and save the 
analysis files to that computer. Saved files can be synchronized to a network 
drive after saving. 
 
 

Multi-screen mode 
 
The GraphLogic, GateLogic and DocLogic windows to be separated and 
viewed simultaneously on different displays. In the GraphLogic and DocLogic 
toolbars, there is a ‘pop out’ icon. Clicking on this will open that particular panel 
in a separate window. Even when the different sections are viewed on individual 
displays, all elements will continue to update in real time with any adjustments 
to the analysis.  

The pop out icon:  

 

 

  

mailto:support@inivai.com
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To return either GraphLogic or DocLogic to FlowLogic, simply close that 
individual panel: 

 

 

The pop out icon location in: 

GraphLogic 

 

 

DocLogic 

 

 

The result of separating these three components: 
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Preferences 
 
Before beginning an analysis, customize the program by setting the program 
preferences. From the menu bar, select ‘FlowLogic’ (macOS) or ‘Edit’ 
(Windows) and ‘Preferences’. Here you can change the way the plots are 
displayed (annotation, standard or high definition, real-time updates, etc.), 
choose the specific parameter labels you would like to view, set the export 
settings, allocate system memory, define colors used in overlay plots and more. 
 

 
 
Select various preference menu options from the left-hand side of the 
Preferences window and optimize the settings using the options in the panel on 
the right. 
 
Explanations of the different Preference options are as follow: 
 
 
General  
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• Plot Options 
o Real-time plot updates – when selected, all plots (dot plots, histograms 

and overlays) are updated in real-time as gates are moved. This includes 
events at all levels of the population hierarchy, along with gate statistics. 
The coloring of events (selected in the plot side drawer in the Gate List 
tab) is also updated on all levels of the hierarchy as gates are moved. 
Deselect this option to increase program speed. When deselected, all 
plot and statistic updates will occur when the gate is released. 
 

o High definition dot plots – when selected, dot plots are displayed in the 
Workspace at a higher definition. Plots will also be exported and 
displayed in reports with whichever setting is chosen. 
 

o Show events on histogram axis – when selected, events existing beyond 
the axes will be displayed along the axes. This may affect the way the 
histogram is displayed, especially when viewing the histogram at 100%. 
 

o Show events on dot plot axis – when selected, events existing beyond 
the defined axes will be displayed along the axes. This will affect the plot 
display, especially when viewing populations based on density. 
Deselecting this option will cause the density of events to be calculated 
based on the events within the plot area only. This option does not 
impact statistics in any way. 
 

o Open density plot as default – when selected as the default settings, all 
plots opened from the File Inspector or from double-clicking within a gate 
in the Workspace will open as a density plot. This default setting will 
remain for a sample once it has been opened so changing the default 
setting in the Preferences will apply to all newly opened plots. 
 

o Save opened plots in window – when selected, plots displayed in the 
Workspace for a given folder will be remembered so that the same plots 
will be displayed when switching from one folder to another and back 
again. This is the case for all Experiment folders in all Projects (displayed 
in the File Navigator). Plots displayed in the Workspace when quitting 
FlowLogic will be displayed upon opening a saved .glf or 
.gatelogicexperiment file. 
 

o Default histogram smoothing – histograms can be smoothed by default. 
This can be particularly useful in cases where there are few events. 
Choose either None or one of the other smoothing options to apply the 
relevant algorithm to the histogram: None, Traditional, Local Max, Local 
Min, Local Mean, Box Max, Box Min, Box Mean. 

 
o Default smoothing size – the amount of smoothing can also be set, 

ranging from 2 (least amount of smoothing) to 16 (most amount of 
smoothing). 
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• General Options 
o Warn before closing FlowLogic – when selected, FlowLogic will display 

the following message asking whether to cancel the command, to quit or 
to save the current analysis before quitting: 

 

 
 

 
o Automatically release license before closing FlowLogic – when selected, 

FlowLogic will release the license automatically upon quitting. The 
license is then free to be used to run FlowLogic on a different computer. 
This feature is useful if the user commonly runs FlowLogic on two or 
more computers. 

 
o Fast FCS File Dialog – with this feature enabled, when searching for files 

to import, FlowLogic will inspect the file header to quickly identify FCS 
files. This will dramatically increase the speed in which FCS files can be 
searched and displayed. 

 
o Limit Available Fonts – limiting available fonts will reduce the available 

fonts contained in each computer to the following: 
 

 
 

This will ensure that saved analyses and reports, when opening on other 
computers, will be displayed unchanged. Limiting the available fonts 
avoids the risk that a font used in one computer is absent in another. 
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• Autosave Options 
o Enable Autosave Every __ Minutes – with this option, FlowLogic will 

automatically prompt the user to save the analysis after a defined 
number of minutes. Once the analysis has been saved, FlowLogic will 
re-save the analysis, using the same file name and type, at the defined 
time interval. The time interval can be set by typing the number of 
minutes in the field or by using the arrows to increase or decrease the 
displayed time in one-minute increments. 

 
o Enable Undo – with this setting selected, a list of the most recent actions 

is recorded and can be reversed by selecting Undo from the Edit menu 
or by selecting the action from the Undo List found in the Edit menu. 

 

• Statistics Setting  
o Stat with negative – this setting means that some statistical calculations 

on data existing below zero may come back with an error due to the 
nature of the calculation. 

 
o Stat without negative – this setting means that all statistics can be 

calculated even if there is data existing below zero. This is achieved by 
ignoring the events that exist with a negative value. 

 
 

• Import Setting (Duplicate Files) 
o Allow all files – with this setting, all files can be imported, even if there 

are two identical files. 
 
o Prevent duplicate names – with this setting, the importation of two files 

with the same file name will be prevented. This setting becomes 
important if the same experiment is repeated and therefore the same 
names are applied to the samples, although acquired at different times. 
Plate data will also produce multiple samples with the same name as the 
well name is commonly the sample name, i.e. A1, A2, etc. 

 
o Prevent duplicate files – with this setting, the importation of two identical 

files will be prevented. 
 

• Gate Options 
o Auto open daughter plots – with this option selected, the daughter 

population resulting from a gate is displayed in the Workspace when a 
gate is created. 

 
o Back gating on by default – with this option selected, populations are 

colored as a gate is created. As subsequent plots are created, the 
colored populations appear on all plots in the hierarchy. 

o Show gate label – the gate label is the gate name and the statistic 
relating to a gate. This will be displayed on the dot plot or histogram 
when this option is selected. The gate label can be moved around the 
plot area when the gate is highlighted. 
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o Hide gate label text – choosing to hide the gate label text will remove the 
gate name from the label, leaving only the associated gate statistic. 

 
o Gate Label Value – the type of statistic displayed as part of the gate label 

can be chosen from the following options: 

• Event Count 

• Percentage Parent 

• Percentage Total 

• No Stat Display – choose ‘No Stat Display’ in combination with 
showing the gate label text to display the gate name alone. 

 
o Gate Naming – the ‘Gate Naming’ option means that a box (as displayed 

below) will be displayed each time a gate is created, asking for a name 
to be assigned. The default name will be presented within the window 
each time a gate is created. If this option is not selected, then the default 
gate name is automatically assigned to the gate. The gate name can 
always be changed by right-clicking on the gate name in the File 
Inspector, choosing Rename and typing in the new name. 

 
 

 

 
 
 

• Sorting Settings 
o The Sorting Settings refer to the default order in which FCS files are 

displayed in the File Inspector. This option includes sorting by File Date 
(the date the file was created), File Name (alphabetically ordered), FCS 
Date (the date and time of acquisition), Free, Plate Position, or $SRC 
keyword. 
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Parameters  
 

 
 

 

• Axis Adjustments 
o Plot from zero – choose to plot from zero or to hide the first decade of 

events. 
o LogScaled Transformation –LogScaled axes will be displayed by default.  
o Auto Axis Adjustment – FlowLogic will determine the optimal scaling for 

the axes. 
o Import FCS Files Compensated – when selected, imported FCS files will 

load with the compensation matrix created at the time of acquisition. If 
not selected, the imported files will be uncompensated. 
 

• Parameter Labels 
o Parameters Labels – selecting Parameter Labels displays the parameter 

name on the plot axis. 
 
o User Labels – selecting User Labels displays the parameter and the 

parameter name as defined at acquisition. 
 
o Custom Labels – selecting custom labels displays a new label that can 

be created in the Advanced Functions pull-up drawer in the Parameters 
tab. Here, all three parameter label types are displayed but only the 
custom labels can be changed. Double-clicking on the existing Custom 
Label allows the creation of a new custom label. 
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• Log Axis – set the default axis labeling style 
o Auto (displays the native format) 
o 1e1, 1e2, etc.… 
o Traditional 

 

• X Axis 
o Major Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
major axis markers. Decreasing the value shortens the major axis 
markers. 

 
o Move Horiz. – increasing this value shifts the x-axis marker values, e.g. 

0, 103, 104, to the right. Decreasing this value moves the x-axis markers 
to the left. 

 
o Move Name Horiz. – increasing this value shifts the x-axis title, i.e. the 

parameter name, to the right. Decreasing this value moves the x-axis 
title to the left. 

 
o Minor Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
minor axis markers. Decreasing the value shortens the minor axis 
markers. 

 
o Move Vert. – increasing this value shifts the x-axis marker values, e.g. 

0, 103, 104, further from the axis (down). Decreasing this value moves 
the x-axis marker values closer to the axis (up). 

 
o Move Name Vert. – increasing this value shifts the x-axis title, i.e. the 

parameter name, further from the axis (down). Decreasing this value 
moves the x-axis title closer to the axis (up). 

 
o Reset – click reset to return to the default settings that were displayed 

before making any adjustments. 
 
 

• Y Axis 
o Major Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
major y-axis markers. Decreasing the value shortens the major axis 
markers. 

 
o Move Horiz. – increasing this value shifts the y-axis marker values, e.g. 

0, 103, 104, to the left. Decreasing this value moves the y-axis markers 
to the right. 

 
o Move Name Horiz. – increasing this value shifts the y-axis title, i.e. the 

parameter name, to the left. Decreasing this value moves the y-axis title 
to the right. 
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o Histogram Ticks – increasing the number in this field, will lengthen the 
major y-axis markers on histograms. Decreasing the value shortens the 
major y-axis markers. 

 
o Minor Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
minor axis markers. Decreasing the value shortens the minor axis 
markers. 

 
o Move Vert. – increasing this value shifts the y-axis marker values, e.g. 

0, 103, 104, down. Decreasing this value moves the y-axis marker values 
up. 

 
o Move Name Vert. – increasing this value shifts the y-axis title, i.e. the 

parameter name, down. Decreasing this value moves the y-axis title up. 
 
o Reset – click reset to return to the default settings that were displayed 

before making any adjustments. 
 
 
Export 
 

 
 

• Plot Export Options – selecting the following options will define the 
elements exported with dot plots and histograms. Some export file types 
can be ungrouped and edited at a later point. For file types that can’t be 
ungrouped, define the elements that you wish to be displayed on each plot 
here prior to exporting. 
o Axis – this incorporates the major and minor ticks, the axis marker values 

e.g. 0, 103, 104 and axis titles 
o Axis Values – this is the axis marker values, e.g. 0, 103, 104 
o Axis Labels – this is the axis title, e.g. parameter name 
o Statistics – statistics relating to the parameters will be exported with the 

plot. 
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o Header – this is the sample name and associated statistics. These sit at 
the top left-hand corner of the exported plot. 

o High Quality Graphs (72, 150, 300, 600, 1200 DPI) – the resolution of 
the exported image can be set in terms of dots per square inch. 

o Export Group Color when plate displays plots – dataset colors will be 
exported with the plate if set to display plots and color background with 
dataset. 

 
 
Palette 
 

 
 

• Density plot colors 
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• Set Palette – to load a density plot color scheme, select it from the drop-
down menu at the bottom of the Palette preferences window. Click Set 
Palette to confirm selection. 

• Save As – new palettes can also be created. To create a palette, highlight 
the selected region of the density plot colors. A color chart window will then 
ask to choose a start color followed by an end color. The color transition will 
then be spread over the defined region. To save a new palette, click Save 
As. The program will then save a new Gatelogic Palette File. 

• Load – to load a previously saved palette, click Load and locate the saved 
Gatelogic Palette File. 

 
 
User Interface 

 

 
 

Choose the default orientation and font settings for the statistics table in the 
View Statistics tab of GateLogic. Click Set Default to reset the settings. 
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System 
 

 
 

 

• Set Memory in MB. Check your computer’s maximum RAM 
specification and enter it below – maximizing the RAM dedicated to 
FlowLogic will improve program speed and performance. 
o Type in the available RAM available for FlowLogic in MB. 
o For example, if your computer has 4GB of RAM, enter “4000” (i.e. the 

amount of RAM in MB) 
 

• For computers running 32-bit Java, 1024 MB is the maximum amount of 
memory that can be allocated. 

 

• File Associations – for machines running Windows, double-clicking on the 
following file types will launch the program and load the files. 
o .glf Files 
o .fcs Files 
o .gatelogicexperiment Files 
o .lmd Files 
o Set File Associations 
 

• LMD file reading preferences – the portion of the LMD file, FCS2.0 or 
FSC3.0, can be set as the default portion to read. This setting applies to all 
future LMD file imports. It will not change the reading of files that have 
already been imported. 

 

• Cores – the number of cores that FlowLogic uses can be set by the user. 
This can be useful when processing extremely large files in order to aid in 
memory management. 
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PlateLogic  
 

 
 

• Non-Parametric Statistic Selected 
o Display Selected Level 
o Display Parent 
o Display File 
o Parametric Statistic Selected 
o Display Selected Level 
o Display Parent 
o Display File 

• Fill enabled by Default  

• View histo enabled by Default 

• Default Size – this is in terms of the number of wells in the horizontal 
direction (rows) and the number of wells in the vertical directions 
(columns). Change either of the numbers by clicking within the field and 
typing the new number or by using the up and down arrows to increase 
or decrease the number of wells running horizontally or vertically. 

• Default Fill Direction – the fill direction relates to the placement of 
progressive samples added to a plate. 
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• Default Well Shape – the default well shape can be set as a circle, 
square, large square or to have the entire area filled. Click on the drop-
down menu to make the selection. 

 

 
 

• Default Numeric Axis – axes (rows and columns) can be listed either 
alphabetically or numerically. To label an axis numerically, tick the box 
next to the relevant axis. If the box is not selected, the axis will be labeled 
alphabetically. It is possible to list one axis numerically (and the other 
alphabetically), both axes numerically or both alphabetically. 

• Default Statistic – choose the statistic that you wish to be displayed by 
default. 

• Mirror dataset on Insert by Default – this feature, when enabled, creates 
datasets in the plate that match the groups from the File Inspector. The 
group color is applied to the matching dataset. 

• Insert Files in Plate Order – files will be added to a plate in the order of 
A1, A2, A3, etc. 

• Autoheatmap Enabled by Default – heatmaps can be generated 
automatically when samples are dragged from the File Inspector into a 
plate in the Data Array tab located in the Advanced Functions pull-up 
drawer. If the ‘Autoheatmap Enabled by Default’ option is selected, then 
FlowLogic will perform a calculation based on the range for the selected 
statistic. The wells in the plate will then be colored from, blue to red, over 
the ranges outlined in the Default Heatmap settings in the Preferences 
window. 

 

• There are five ranges for the heatmap by default. However, extra ranges 
can be added, or existing ranges can be removed by selecting a range, 
rick clicking and choosing from the options provided. These are as 
shown below: 

 

 
 

If ‘Copy’ is selected, a copy of the selected range will be automatically 
created and placed after the copied range. 
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• C (color) – the default color assigned for each range for the heatmap can 
be changed by clicking on the color itself and choosing from the options 
provided. 

• A (bottom of range) – the default value defining the bottom end of the 
range can be changed by double-clicking within the filed in the column 
labeled ‘A’. 

 

• Type – this is the rule defining each range in the heatmap, in relation to 
the values in columns ‘A’ and ‘B’. The type options are: 

• Less than A 

• Less than or Equal to A 

• Greater than or Equal to A 

• Equal to A 

• Greater than or Equal to A and Less than B 

• Not Greater than or Equal to A and Less than B 
 

• B (top of range) – the default value defining the bottom end of the range 
can be changed by double-clicking within the filed in the column labeled 
‘B’. 

 

• The default heatmap colors can also be defined in this panel. This can 
be done by clicking on individual colors and making a selectin from the 
resulting color selection window or by applying a gradient between two 
colors. Do define a gradient, highlight all ranges, right-click and choose 
‘Gradient’. Then select the starting color followed by the ending color. 
The intermediate colors will be set automatically. 
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Overlay 
 

 
 

 

• Set overlay color – the default colors for the first 13 samples to be added 
to dot plot or histogram overlays are displayed here in the Preferences. The 
default color for each of these 13 samples can be set here by clicking on 
the color and then choosing a new one from the options provided. Overlay 
colors can be changed on individual overlays once it has been created. 

 

• Set transparency 
o Low (0-255) High – the default level of transparency can be set. This 

refers to the degree as to which a sample located behind another can 
be seen. 

o Sort the list of plots – when selected, samples will be added to an overlay 
with the highest density/histogram height at the back and lowest 
density/histogram height at the front. If ‘Sort the list of plots’ is not the 
default setting, then samples will be added in order the files are 
displayed in the File Inspector. These settings can be changed within 
the side drawer of each overlay plot by right-clicking within the Overlay 
Colors tab. 
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• Calculate statistics – statistics for all samples in the overlay can be 
displayed in the statistics tab in the overlay side drawer. The default 
selection of statistics to be displayed can be set in the Preferences 
window. The selection of statistics can be edited for each individual 
overlay within the Stat Settings tab in the overlay side drawer. 

• Display 100% - for histogram overlays, the samples can be set to be 
displayed as either the event count or as a proportion of the highest 
value, which itself is at 100%. This selection determines the default 
display setting for all new histogram overlays. The setting can be 
changed on individual histogram overlays by right-clicking within the plot 
area and selecting Display 100%. 

 

• Set Stat Column – default columns can be created in the side drawer of 
overlays, in the Statistics tab. Additional information may be required to 
define the statistic to populate these columns, which can be done in the ‘List 
of linked rows’, ‘Stat settings’ and ‘List of parameters’ tabs of the overlay 
side drawer. The different statistic columns are: 

o Color 
o Population 
o Parameter 
o Events 
o % of Total  
o % of Parent 
o Mean 
o GeoMean 
o Median 
o StdDev 
o CoefVar 
o RoCoefVar 
o % of Selected 
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Main Menu 
The Main Menu contains several key program features and functions. In 
macOS, the Main Menu is set out as follows: 
 

 
 

FlowLogic 

About FlowLogic – clicking About FlowLogic opens a window showing the 
program version, the user’s system information (including the RAM and the 
number of cores available to FlowLogic), the license holder’s username, the 
license type and the license expiration date. 

Preferences… – clicking Preferences or using the keyboard shortcut at any 
time will open the program preferences. Here there are options to set default 
options relating to: General settings, Parameter settings, Export settings, 
Palette settings for density plot displays, User Interface settings, Report 
settings, Data Array settings and Overlay settings. 

Quit FlowLogic – select quit FlowLogic or use the keyboard shortcut to exit the 
program. If the ‘Warn before closing FlowLogic’ option has been selected in the 
General program setting in Preferences, then a window will be displayed asking 
whether to save the current analysis before quitting or whether to cancel the 
command to quit. 

 

File 

• New – selecting ‘New’ will open a new, blank analysis. Before the new 
analysis is created, a prompt (shown below) will ask whether to save the 
current analysis. 

 

 
 
 

• Open – selecting ‘Open’ allows for the opening or loading of previously 
saved .glf and. .gatelogicexperiment files. Before displaying a window 
allowing the search for the saved analysis file, a prompt will ask whether to 
save the current analysis before opening a saved one. 
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• Open Append – this option allows a saved analysis file to be imported into 
the current analysis, effectively merging two analyses. 

• Save – selecting Save or using the keyboard shortcut will save the current 
analysis. If the analysis has not been saved previously, a Save As window 
will open, asking to name the analysis and to choose a file type (either a .glf 
or a .gatelogicexperiment file). If the analysis has been saved previously, 
then choosing ‘Save’ will update the saved file, incorporating all recent 
changes. 

• Save As – choosing Save As or using the keyboard shortcut will open a 
window allowing the file name and type to be set. If the current analysis has 
already been saved, then creating a new file name will create a new file. 
The original file will remain as it was when it was last saved. 

• Import FCS-MQD-LMD-LXB… – choosing this file import option or using the 
keyboard shortcut will open a search window allowing the user to locate 
FCS stored on the computer or on an external drive. To import the FCS files, 
highlight them and select ‘Choose’. 

 

 
 

• Import Folders – selecting Import Folders or using the keyboard shortcut 
opens a search window where folders containing FCS files can be imported. 
This function imports all of the files in the folder and places them into a new 
Experiment folder, which takes the name of the imported folder. 

 

 
 
 

• Export Statistics – selecting this option will allow you to export the statistics 
displayed within the View Statistics tab of the advanced functions pull-up 
drawer. A pop-up window will initially open, where the choice between .csv 
and .xlsx can be made. Following this, the file Save As window will allow the 
file name and location to be set.  

• Recent – selecting Recent opens a window displaying the 11 most recent 
analysis files. Select the file by name to open it. 

 
 

Edit – contained in the Edit menu are various display features and analysis 

tools, including copying, pasting, saving and deleting. 
 

• Undo List – the Undo List shows a list of the most recent actions. This 
visualization allows for a particular action to be identified and by selecting it 
the analysis will return to the state immediately prior to this action being 



 28 

performed. Note that the Undo option must be selected within the 
Preferences. Actions that can be undone in the undo list will be listed with 
black text. Actions listed with red text cannot be undone. 

• Keywords – opens the Keyword Configuration window, allowing specific 
keywords and their values to be selected and displayed in the File Inspector. 

• Plot Arrangement 
o Number of Windows (1 – 20) – the number of windows refers to the 

number of plots (dot plots, histograms or overlays) that are displayed 
horizontally across the Workspace before a plot is placed on the next 
row. Using this feature can greatly enhance analysis as the user can 
adjust the displaying of plots to fit a given screen size or to group 
samples in rows based on experimental groups. For example, if an 
experiment involves three groups, each with five samples per group, 
then setting up the number of windows to be displayed at 5 results in 
each group being displayed in a single row in the Workspace. This 
makes it much easier to compare differences between groups while 
viewing each individual sample. 

o Auto Arrangement on/off – Auto Arrangement is a feature that enables 
plots to keep their position in the Workspace even when individual plots 
are resized. For example, clicking the bottom right-hand corner of a plot 
and dragging it downwards will enlarge the individual plot. If there are 
other plots open in the Workspace, these will move in relation to the plot 
being resized. In this way, an enlarged plot will not obscure any other 
plot. Plots can also be moved around the screen by clicking the plot title 
and dragging it to a new location. This will result in the plot obscuring 
other plots if it is dragged on top of another. However, clicking and 
dragging the plot resizing slider at the top of the File Navigator will 
automatically place the plots back in their original order and make them 
a uniform size. The plot resizing slider can also be used to enlarge or 
shrink all plots in the Workspace together. Turning the Auto 
Arrangement off effectively makes each plot free and will all act 
independently when resizing and re-ordering. 

• Plate Arrangement 
o Number of Windows (1 – 20) – the number of windows refers to the 

number of plates that are displayed horizontally across the PlateLogic 
workspace in the Advanced pull-up drawer before a plate is placed on 
the next row. 

o Auto Arrangement on/off – this feature enables plates to keep their 
position in the PlateLogic workspace even when individual plates are 
resized. For example, clicking the bottom right-hand corner of a plate 
and dragging it downwards will enlarge the individual plate. If there are 
other plates open in the Data Array Workspace, these will move in 
relation to the plate being resized. In this way, no plates will be obscured 
when one is manually enlarged. Plates can also be moved around the 
screen by clicking the plate title and dragging it to a new location. This 
will result in the plate obscuring others if it is moved on top of another. 
However, clicking and dragging the plate resizing slider at the bottom of 
the Plate List Window in the Advanced Functions drawer will 
automatically return the plates to their original order and make them of 
a uniform size. The plate resizing slider can also be used to enlarge or 
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shrink all plates in the PlateLogic workspace together. Turning the Auto 
Arrangement off effectively makes each plate free and each will act 
independently when resizing and reordering. 

• Copy Gates – this feature copies gates in order to paste them to another 

sample in the File Inspector. To copy gates, highlight them, select Edit → 
Copy Gates (or use the keyboard shortcut). The gates are then copied to 
the clipboard ready to be pasted onto new samples. The ‘Copy Gates’ 
feature can also be accessed by right-clicking on a sample and selecting 

Copy → Copy Gates. 

• Paste Gates – once gates have been copied from a sample, highlight a new 

sample or samples and select Edit → Paste Gates (or use the keyboard 
shortcut) to paste the gates. The gates will be pasted to the sample and not 
appended or inserted into a selected level of the existing gating hierarchy. 
In effect, the gates will replace existing gates on the destination sample. In 
order to insert gates into a specified level of a gating hierarchy, select the 
level (gate) that you wish to insert the gates onto, right-click and choose 

Paste → Insert Gates. The ‘Paste Gates’ feature can also be accessed by 

right-clicking on a sample and selecting Paste → Paste Gates. 

• Paste Gates to All – once gates have been copied, selecting any gate in the 

File Inspector and clicking Edit → Paste Gates to All will apply the copied 
gates to all samples. 

• Delete Rows – rows refer to the samples and gates shown in the File 
Inspector. To delete one or more rows, highlight the row(s) in the File 

Inspector and select Edit → Delete Rows. This will delete the selected rows 
and any gates lower in the hierarchy. A window will open prior to the rows 
being deleted to confirm the action and to show the gates that will be 
deleted. 

• Delete All Gates – select any row in the File Inspector and then click Edit → 
Delete All Gates to delete all gates and clones listed in the particular 
Experiment Folder. A window (as shown) will confirm the action to delete all 
gates and clones. 

 

 
 

• Delete All Statistics – selecting Edit → Delete All Statistics will clear any 
statistics calculated and displayed in the Set Statistics Tab in the Advanced 
Functions drawer and all statistics displayed in the View Statistics Tab in 
the Advanced Functions drawer. 

• Preferences – opens the program preferences. 
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Compensation – live compensation can be performed in the side drawer of 

individual plots under the Interactive Compensation Matrix tab. Adjust the 
compensation by double-clicking in the compensation value tab and typing in a 
new value, by using the up and down arrows to adjust the compensation in 
small increments or use the slide tool to increase or decrease the compensation 
value: 
 

 
 
Once the compensation has been changed for one sample, there are several 
different options available: 
 

• Copy New – to copy the new compensation (in order to paste it to other 
samples) select the sample in the File Inspector with the newly changed 

compensation and click Compensation → Copy New. This will save the new 
compensation matrix to the clipboard. 

• Copy FCS Original – the compensation matrix that was created at the time 
of acquisition remains with the FCS file even if it is changed post acquisition. 
If you wish to apply the original compensation matrix to a file, copy the 
original FCS and paste it to any sample in the File Inspector. 

• Copy Saved – a sample compensation matrix (either the original matrix or 
an altered one) can be saved as a TXT file and applied to samples in the 
File Inspector. To select a saved matrix in order to paste it to a sample(s), 

click Compensation → Copy Saved. A window will open allowing the user 
to locate the saved TXT file. The saved compensation matrix can then be 
pasted to selected samples in the File Inspector. 

• Save New – if you wish to save an altered compensation matrix as a TXT 

file, highlight the sample in the File Inspector and click Compensation → 
Save New. A window will ask to select a destination and create a name for 
the saved file. 

• Save FCS Original – if you wish to save an original compensation matrix 
(that created at the time of acquisition) as a TXT file, highlight the sample in 

the File Inspector and click Compensation → Save FCS Original. A window 
will ask to select a destination and create a name for the saved file. 
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• Paste – once a compensation matrix (an original matrix, a new matrix or one 
copied from a TXT file) has been copied to the clipboard it can be pasted to 
FCS files highlighted in the File Inspector. Copy the desired matrix, highlight 

the FCS files in the File Inspector and click Compensation → Paste. A 
window will open displaying the matrix to be displayed. Click Yes to paste 
the matrix. 

 
 

 
 
 
 

License 
 

 

 

• Activate License… – to activate a license, enter the username associated 
with a valid license code. 

• Release License… – release a license if you wish to run FlowLogic on 
another computer. Activate the license on the second computer when you 
launch FlowLogic. 

• Remote Activation – remote activation can be used when there is no internet 
connection. When selecting this option, a window with included instructions 
will open enabling the generation and saving of a fingerprint. This can then 
be saved and transferred to a different computer with internet access. The 
fingerprint can be authenticated resulting in the generation of a license key. 
This key can be transferred back to the computer running FlowLogic in order 
to activate the license. 

• Remote Release – remote release is also used when there is no internet 
connection. The process is the same as that for remote activation. After the 
fingerprint is generated, FlowLogic will close and will require an available 
username (or fingerprint if offline) in order to run.  
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Help 
 

• Search – use the ‘Search’ feature under the Help menu to search for help 
and guidance. 

 

 
 

• Tutorials – this option links to the FlowLogic support page on the Inivai 
website, where PDF guides and demonstration videos can be accessed. 

• Memory Settings – clicking Help → Memory Settings will prompt FlowLogic 
to test the current memory settings. A window will open displaying the result 
and asking if you would like to change the memory settings. If you choose 
Yes, the program Preferences will open. From here, navigate to the System 
settings to change the memory settings. 
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Saving and Opening Analysis Files 
 

File Menu 

Once you have imported FCS files and performed an analysis you will be able 
to save the analysis as either a GLF or an Experiment. Both options can be 
found under the File menu. 

 
GateLogic File (.GLF) 

• This file type will save your analysis along with all the gates and statistics. 
The GLF will save the pathway for each of the imported FCS files. If the 
location of these files changes then FlowLogic will ask you to manually 
locate the file or select a folder to search in. 

• To open a GLF file, start FlowLogic, choose ‘Open GLF’ from the File menu 
and locate the saved GFL file. 

• To save a GLF, after importing FCS files, choose ‘Save GLF’ (or ‘Save As 
GLF’ to rename the new GLF file) from the File menu. 

 
 
GateLogic Experiment (.gatelogicexperiment file) 

• Saving your analysis as an Experiment will compress your analysis and 
FCS files together into one file. This single file can be transferred to any 
computer running FlowLogic. 

• To open an experiment file, start FlowLogic, choose ‘Open Experiment’ from 
the File menu and locate the saved experiment file. When the Experiment 
is opened, it will create a folder containing the FCS files. 

 
 
Exporting FCS files from a saved GateLogic Experiment 
FCS files can be exported from a GateLogic Experiment (.gatelogicexperiment 
file) by re-saving the analysis as a .GLF. As a .glf contains the XML and not the 
FCS files, a prompt will ask if you would like to save the FCS files in the same 
location as the new .GLF. When creating the new .glf, the FCS files contained 
in the experiment will be extracted and placed in a new folder. 
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GateLogic – FCS and MQD File Analysis 
 
GateLogic Overview  
GateLogic is composed of the Workspace, Toolbar, File Inspector, File 
Navigator and Advanced Functions pull-up drawer. 

 
 

 
File Navigator 
The File Navigator contains the ‘Jump’, ‘Batch’ and ‘Default Plots’ functions. 
The ‘Jump’ function allows the user to advance the plots displayed in the 
Workspace by a defined number of samples (the number displayed in the Jump 
Window). The ‘Batch’ function allows the user to advance one sample at a time 
and in the process, copy the gates from the original file to the next. The updated 
plots are displayed in the Workspace as the batch analysis is performed. 
Ticking the Default Plots options whilst plots are displayed in the screen will pin 
those plots to the Workspace. New plots can then be opened and when the 
Jump function is used, the original plots will remain in the Workspace whilst the 
Jump feature is applied to the more recently opened plots. Above the File 
Navigator is the plot re-sizer tool. Clicking and dragging the re-sizer button to 
the left or right enlarges or shrinks the plots displayed in the Workspace. 
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Right-clicking within the File Navigator produces a menu with additional 
functions. 

 
Experiment folders can be re-ordered within a Project folder or from one Project 
folder to another using drag-and-drop. The order of Project folders can also be 
changed using drag-and-drop. 
 

 
 
 
Resize tick box in the File Navigator 
With this option selected, the file name column in the File Inspector will resize 
to fit the longest file name in the list. 

 
File Inspector 
The File Inspector displays the FCS/MQD files that have been imported and 
any gates that have been applied to the samples. Overlays that have been 
created are displayed in a pull-up drawer at the bottom of the File Inspector. 
 

• The File Inspector also contains a number of columns containing various 
statistics, information on sample compensation and tags (particular sample 
attributes). These columns can be revealed by expanding the File Inspector 
by clicking and dragging the right-hand side to the window and pulling it to 
the right. 
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• Right-clicking on the column titles opens a menu allowing the user to sort 
the FCS files by file date, name, FCS date (the date and time of acquisition), 
make them free or by plate position. 

 

 
Files can also be re-ordered using drag-and-drop. Clicking and dragging the file 
name automatically switches the ordering to ‘Free’ and the file can be dropped 
in the desired position. The order of plots open in the Workspace will also be 
updated to reflect the order of files in the File Inspector. The files can be re-
ordered by way of File Date, Name, etc., by right-clicking and choosing the sort 
option from the list. Using drag and drop on a gate will copy and paste that gate 
or series of gates rather than re-ordering the files. 
 

• Another option from this right-click menu is to show or hide all or some of 
the statistic columns in the File Inspector. A tick next to the column indicates 
that the column is visible. 
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• Selecting Table Header from the right-click menu opens a separate window 
where new columns can be created based on keywords contained within 
FCS files. 

 
 

• Files can also be sorted in a numerical/alphabetical order (ascending or 
descending) by double-clicking on the column header. For more 
information, see page 98. 

 

• Right-clicking on a sample in the File Inspector opens a different window 
with a range of functions to aid in the analysis of the sample(s). See the 
individual sections relating to these functions for more details. 
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Workspace – Toolbar (summary) 
The Toolbar contains various gating functions and plot display options for use 
on plots open in the Workspace. 
 
Advanced Functions pull-up drawer (summary) 
The Advanced Functions pull-up drawer contains additional analysis features 
to improve efficiency and aid data mining capabilities. To access the Advanced 
Functions, click on the top of the drawer (located at the bottom of the 
Workspace) and drag it up. It can be pulled up to entirely cover the Workspace, 
if desired. The Advanced Functions drawer consists of 13 tabs: ClusterLogic, 
QCLogic, PlateLogic, Set Statistics, View Statistics, Parameters, CompLogic, 
Metadata, Compensation, Cell Cycle, Proliferation, Curve Fit and Kinetics. 

 
 

Importing FCS Files 
To begin, click File on the menu bar and select ‘Import FCS-MQD-LMD-LXB…’ 
or ‘Import Folders’ from the drop-down menu. Locate and highlight your files 
and click ‘Choose’. 
 

 

 
 
Alternatively, right-click on an Experiment Folder or drag FCS files or folders 
containing FCS files directly into an Experiment Folder in the File Navigator. 
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Opening Dot Plots/Histograms 
Imported FCS files appear in the File Inspector. Double-click on a file or right-

click→Plots→Open to open it as a dot plot. 
 
Gating tools and plot display options, including standard dot plots, density plots, 
histograms, contour plots and pseudocolor plots appear in the toolbar. 

Click the arrow in the bottom left-hand corner of a dot plot, or press space bar, 
to open the side drawer for the Gate List, Boolean Gates, Statistics, Interactive 
Compensation, Scaling, Cell Cycle Analysis, Proliferation Analysis, Curve 
Fitting and Kinetics features. 
 

 
 
 
 

Dot plot right-click menu (outside gates) 
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Right-click within a plot to open a menu with options to: 
o Perform automated titration analysis (see page 100) 
o Toggle to a histogram 
o Flip the parameters displayed on the x and y axes (dot plot only) 
o Clone a plot (see page 46) 
o Draw gates (an alternative method to selecting the gating tool from 

the toolbar) 
o Export/Save Plots 
o Create Overlays  
o Format the plot text (gate label text) 

A right-click within a gate provides the extra option to add a gate to, or remove 
a gate from a group. For more on group analysis, see page 79. 

 

Histogram right-click menu 
 

 

Right-click within a histogram to open a menu with options to: 

o Change the smoothing type and size for the histogram 
o Change the thickness of the histogram line 
o Perform automated titration analysis (see page 100) 
o Fill (color) the histogram 
o Toggle to a dot plot or density plot 
o Clone a plot (see page 46) 
o Draw gates 
o Export/Save Plots 
o Create Overlays 
o Format the plot text 
o Send the plot to a report in DocLogic 
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A right-click within a marker provides the extra option to add a gate to, or 
remove a gate from a group. For more on group analysis, see page 79. 

 

Toolbar Features 
The Toolbar, located at the top of the Workspace, contains a range of gating 
and plot display tools. Hover the cursor over each of the buttons in the toolbar 
to view the description. 
 

 
 
 
Gating Tools – to apply a gate to a plot that is open in the Workspace, click on 
the plot to select it, click on the desired gating tool and click in the plot area to 
draw/create the gate. The gating options are: 
 

• Create a polygon – a polygon gate can have any number of corners. Once 
the polygon gating tool has been selected, click around the area on the plot 
that you wish to be contained within the gate. Double-click or click on the 
original point to close the gate. Polygon gates can be moved by clicking 
within the plot and dragging it or by highlighting it and moving it using the 
arrow keys on the keyboard. Polygon gates can be adjusted by clicking and 
dragging a point or by clicking and dragging a side. 

 

 
 
 

• Create a rectangle – a rectangle gate always has four sides, each joined 
at right angles. Once drawn, the size and shape of the rectangle can be 
adjusted by clicking and dragging a corner or by clicking and dragging a 
side. 
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• Create an ellipse – an elliptical gate is created with four points (similar to 
the corners on a rectangle plot. Clicking and dragging these points will either 
adjust the width of the gate or adjust the orientation. 

 

 
 
 

• Create histogram marker – a histogram marker is used to define a region 
on a histogram. Histogram markers can be adjusted by clicking and 
dragging the points at each end. The height of the cross bar can also be 
adjusted by clicking and dragging it down or up. 

 

 
 
 

• Create a quadrant – a quadrant gate divides the plot into four areas. To 
apply a quadrant gate, highlight the plot, select the gating tool and click 
within the plot area. Quadrant gates can be adjusted by clicking and 
dragging the center point or by clicking and dragging the points at the end 
of each of the arms. These arms move independently of each other and do 
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not have to form four rectangle gates. 
 

 
Right-clicking on a plot containing a quadrant gate provides options to anchor 
one, all or a selection of the quadrant gate arms to the corresponding axis. 
Resetting the spider legs will return all arms to a vertical or horizontal 
orientation, whilst maintaining any form of anchoring that has been set. 
 

 
 

• Autogate – the autogating tool automatically draws a gate based on 
density. To use the autogating tool, highlight the plot, select the autogating 
tool from the toolbar and then hover over the plot. A gate will be displayed 
based on where the cursor is and the density of events on the plot. Without 
clicking, move the cursor around the plot to see how it affects where the 
gate is drawn. To create the gate once it is where you want it to be, simply 
click. This will effectively create a polygon gate with many points. 
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Plot Display Options – plots can be displayed in a number of different ways. 
Choose a plot display option to best display your populations. Plots are 
generally displayed as a standard dot plot (or density plot if set as a default in 
the Preferences). To change the plot display, click on the plot title to select it 
and then click on the desired plot display option. The options are: 
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Clone a plot – plots can be cloned, resulting in to identical plots at the level 
where the clone was created. The clone is labeled with a ‘C’ next to the gate 
name in the File Inspector. To clone a plot, highlight it on the plot or in the File 
Inspector, and select the toolbar button. 

 

• Copy plot graphic to clipboard – this saves a plot image to the computer’s 
clipboard to be pasted into other programs. 

 

• Save the graph image to disk – one method to export a plot is to highlight 
it in the Workspace and click the Save the graph image to disk. An option to 
save the plot as one of six different files types will be presented. 

 

 
 
 

• Delete the selected gate – one method to delete a particular gate is to 
highlight it, either on the plot or from the gate lists in the File Inspector, 
before clicking the Delete the selected gate button in the toolbar. A window 
will then be displayed asking to confirm this action. 
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The Plot Side Drawer 
Each dot plot and histogram contain a side drawer that allows the user to switch 
gates on and off, color gates, generate Boolean gates, view statistics, 
compensate samples, adjust plot scaling, reduce the percentage of dots 
displayed and zoom. 
 
Open and close the side drawer by double-clicking within the plot area (but not 
within a gate) or by using the arrow tab at the bottom left. 

 

 
 
 
Gate List 
This window has options to turn gates on and off as well as for the coloring and 
backgating of events within gates. 
 
The ‘Name’ column contains the list of gates that exist on that population and 
all populations lower in the population hierarchy. If parameters have been 
changed after creating the gate, click on the gate name within this window to 
return to the parameters where the gate is drawn. If the gate name chosen 
exists at a lower level of the hierarchy, the specific parameter combination will 
be displayed but no gate will be visible. 
 
The ‘Show’ column contains a check box allowing gates to be turned off and 
on. This is a display option only, meaning turning off a gate only removes it from 
the display but the gate is not deleted and still exists. It can easily be displayed 
again by ticking ‘Show’. 
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Clicking on the color brings up a color palette. Click on a new color followed by 
‘OK’ to change color of the gated population. These colored dots will be colored 
(backgated) on all parent plots when the box is ticked in the ‘On’ column. 
 

 
 
 
 
Boolean Gates 
Boolean gates are created in the plot side drawer. The list of Boolean gates 
that exist at that particular level of the gating hierarchy will be displayed, along 
with options to color of the new population. 
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Statistics  
If statistics have been calculated for a sample, they are made visible in this 
window. These statistics can be copied by right-clicking in the side drawer. 
 
 

 
 
 
Interactive Compensation 
Samples can be manually compensated using the slide bars, the up and down 
arrow buttons or by entering a new compensation in the text field. 
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Scaling  
Here, the scale used to display the dot plots can be set. The options include 
displaying the X- and Y-axes as ‘LogScaled’ and ‘From Zero’. Zooming is also 
available in this window. This requires the ‘Zoom’ box to be ticked. Clicking 
‘Revert’ restores the original scale. The percentage of dots being displayed can 
also be reduced using the slide bar. A defined number of events can be 
displayed by typing in a value within the Dots(n) field. When using group 
analysis, all files within the group will display the same number of events. 
Return to displaying all events in the population by clicking the “Total” button. 

 

 
 

 
Cell Cycle 
To perform cell cycle analysis, perform any pre-gating required on your DNA-
content parameters before displaying it as a histogram. Then, in the Cell Cycle 
tab in the side drawer, choose from one of the 5 algorithms: Battye, Dean Jett 
Fox, Fox synchronous, Watson improved and Watson pragmatic. 
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The histogram is colored to represent the different phases of the cell cycle and 
the data relating to each phase is displayed in the plot side drawer. This data 

can be exported with right-click → Copy Statistics. 
 
 

 
 
 
 
In the Gate List tab, extra gates, such as for apoptosis, can be turned on and 
colors can be changed. 
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Proliferation 
To assess proliferation, convert the data to a histogram displaying the 
appropriate parameter and select the Proliferation tab from the plot side drawer. 
 

 
 
 
Click ‘Fit’ to perform the curve fitting. The curves created for each peak will be 
colored on the plot and the related statistics will be displayed in the side drawer. 
The statistics can be exported by right-clicking and choosing to copy or export. 
 
 

 
 
 
The fitting of the curves can be adjusted manually by displaying the GEN 1 gate 
from the Gate List tab in the side drawer. Then, from the Proliferation tab, tick 
‘Manual position’ and/or Manual width’. With these selected the position and/or 
width of the GEN 1 gate can be adjusted. As this gate is moved, the curves 
fitting the data will update in real time. 
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If the loss factor is not set to manual, then FlowLogic will determine the loss 
factor when fitting the curves. If the loss factor is set to manual, then the curves 
will be drawn in accordance with the user defined loss factor value. 
 
To perform proliferation analysis for multiple files, add them all to a group by 

selecting them in the File Inspector and choosing ‘Group’ → ‘Add to New’. Now, 
when clicking ‘Fit’, the curve fitting will be performed on all samples but 
independently from each other. 
 
It is possible to set a control or master GEN 1 gate for a set of files. This is 
useful if there is no longer any fluorescence in the position where the first peak 
should exist. This setting of a master gate uses FlowLogic’s group analysis 
feature. In relation to proliferation analysis, this involves grouping the GEN 1 
gates for all samples in the File Inspector. As the file that is listed at the top of 
the list of files in the File Inspector dictates the setting of a gate for all other files 
in a group, drag-and-drop the file that you wish to be the master file to the top 
of the list. 
 
Then, tick ‘Manual position’ and ‘Manual width’ and add all of the GEN 1 gates 
that you wish to be governed by the master into a group. If the loss factor is not 
set to manual, then it will be re-calculated for each plot independently. The GEN 
1 gate does not need to be displayed in order to group the files and set a master 
file. However, once the GEN 1 gates are grouped, they can be displayed on 
any plot and adjusted to any position or width. This will update for the entire 
group regardless of which file in the list the adjustment was made on. 
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Curve Fit 
Curve fitting analysis can be performed on suitable histograms displaying a 
number of peaks. In the plot side drawer, select the Curve Fit tab and click Fit. 
The different peaks will be colored and the statistics relating to each peak, such 
as the area under the curve, will be displayed in the side drawer. 
 

 
 
 
 
Gates relating to each peak can be turned on and off in the Gate List tab. 
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Kinetics 
To assess cell cycle kinetics, display the data as a ratio-metric parameter 
versus time. Then toggle to a kinetics plot using the button in the tool bar. 
 

 
 
 
 

• Ratio-metric parameters can be created in the Parameters tab in the 
Advanced Functions drawer if they were not created at the time of 
acquisition. 
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• Select the Kinetics tab in the plot side drawer and click ‘Auto Gate’. This will 
create Background, Response and Resolution gates. The data will be 
displayed in the side drawer and can be exported by right-clicking and 
selecting Copy Statistics. 

 

 
 
 

Manipulating Dot Plots/Histograms 
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Backgating 
Once a gating hierarchy has been created, open the plot side drawer and 
choose the Gate List tab. 
 

 
 

 

• To backgate a population, tick the box in the ‘On’ column. This will color the 
population at all higher levels in the hierarchy. To change the color, click on 
the color box in the side drawer and choose a new color from the selection 
provided. 
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Once the gate has been selected in the side drawer, the cells are displayed at 
each level higher in the hierarchy. If real time update of plots has been selected 
in the Preferences menu, backgated events will update as the gates are moved. 
 

 
 

 
Backgating can be performed on any number of populations. 
 

 
 
 

 
Statistics – Displaying Multiple Statistics on a Plot 
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By default, the event count, ‘% of Total’ and ‘% of Parent’ are displayed for each 
gate in the hierarchy. To add additional statistics to the plot, open the Advanced 
Functions drawer and tick the specific statistic in the Set Statistics window. The 
new statistic will be calculated and be displayed in the plot side drawer and can 
be ticked to be displayed on the plot. The following example shows the 
calculation and display of the median fluorescence intensity for the R1 gate for 
the V2-A parameter. 

 

 

Untick the box in the ‘S Name’ column to display the statistic value only. 

 

With all statistics turned off, the gate name alone will be displayed (if this is the 
setting in the program Preferences). 
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Here is the gate label (the gate name) displayed on the plot without any 
statistics. 
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MQD Volumetric Statistics – cells/volume 
 

Volumetric gate statistics (cells/ml and cells/l) can be displayed on dot plots 
and histograms for MQD files. These can be displayed as part of the gate label 
statistics from the statistics tab in the plot side drawer, as described above. 

These same statistics can be calculated for a selection of files and displayed 
alongside all other statistics in a table in the Advanced Functions drawer. They 
can also be accessed in PlateLogic and GraphLogic.  

 

 

 
Manual Compensation 
 
FlowLogic allows for easy, real-time compensation. To change the 
compensation of a file, open the plot side drawer and scroll through to the 
Interactive Compensation Matrix Window. Here, the two parameters shown on 
the plot are displayed with the compensation values (set when acquiring the 
sample). 
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The compensation can be changed with the slide bar, by stepping the value up 
and down (either by 1.0 or by 0.1 at a time) or by clicking on the compensation 
value itself and entering a new value. Changes in the compensation are 
updated in real time. 
 

 
 
 
Once the desired compensation has been set, the new compensation matrix 
can be saved as a TXT file or copied and pasted onto another FCS file. Options 
relating to the saving and applying of compensation matrices can be found by 
right-clicking on a file in the File Inspector and choosing ‘Compensation’. 
 

 
 
There are a number or options related to copying and importing compensation 
matrices: 
 

• Uncompensate – removes all compensation. 

• Apply FCS original – applies the compensation matrix created at the time of 
acquisition. 



 63 

• Copy new – this copies the matrix after it has been changed in FlowLogic. 
This matrix can then be pasted onto other files. 

• Copy FCS original – this copies the original matrix created when the file was 
acquired.  The original matrix always remains with the FCS file so if a 
change is made that is unwanted, the original settings can always be 
restored. 

• Import – this imports a matrix that has been saved as a TXT file (a matrix 
altered in FlowLogic post acquisition or saved from an original file). 

• Export new – if the compensation is changed within FlowLogic, the new 
matrix can be saved as a TXT file to be applied at any future time. 

• Export FCS original - this saves the original matrix created at the time of 
acquisition as a TXT file. This can then be pasted onto files in future 
analyses. 

• Paste – once matrices have been copied or imported, they can be pasted 
onto other files. To do this, highlight the files and from the Compensation 
menu select ‘Paste’. 

 

Located in the File Inspector, the ‘Comp’ and ‘Source Comp’ columns use color 
to display information about the current and original compensation matrices 
associated with each file.  

Colors are assigned to each unique matrix. So, files that were saved at 
acquisition with a particular matrix will have matching colors in the ‘Source 
Comp’ column. Visual comparisons can also be made between the acquisition 
compensation matrix (Source Comp) associated with an individual file and the 
current compensation matrix (Comp), created in FlowLogic. A ‘Comp’ color that 
differs to the ‘Source Comp’ color indicates that the compensation has been 
adjusted within FlowLogic. 
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Boolean Gates 
• Boolean gates allow for a more powerful form of analysis by defining how 

two or more gates interact. 

 
 

 
 
 

 
Then define the Boolean function from the options ‘NOT’, ‘AND’, ‘AND NOT’, 
‘OR’ and ‘XOR’ that you wish to apply to the gate. Finally, select another gate 
from the drop-down menu and click ‘Add’ to create the Boolean gate. 

• AND – This displays all events in the intersection. 

• AND NOT – This displays the events located in the first gate minus the 
second. 

• OR – This displays the events located in both gates. 

• XOR – This displays all events within the gates but outside the 
intersection. 
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• Inverse Gate – This displays all events outside a single gate. To create 
an inverse gate, choose or type ‘NOT’ followed by the gate name, e.g. 
NOT R1 (in capital letters), into the expression field. 
 

 
• The new Boolean gate is now called G1. The color of the Boolean gates can 

be changed by clicking in the color field. Tick the ‘Show’ option to color the 
newly defined population. 

 

• The Boolean gate will also be listed in the File Inspector. 
 

• To delete a Boolean gate, select the gate in the File inspector, right-click 

and select ‘Delete’ → ‘Rows’.  
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• Auto – the Auto button opens a window displaying a range of available 
Boolean combinations given the existing gates. For the above example with 
gates R1 and R2 existing at this level of the hierarchy, there are six common 
options available in the pop-up window: 

 

 
 

Simply tick the box in the “Add” column to automatically generate the new 
Boolean population. 

If a third gate, R3, was added to the hierarchy, there would be many more 
Boolean combinations:  

 

 

 
Following is an example of each of the Boolean gate types, based on the R1 
and R2 gates listed above. The events within each Boolean gate are colored 
red. 
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Complex Boolean gates can also be created by adding to the gate definition in 
the Expression field. For example, to create the intersection between two gates 
and the events from a third gate, create the Boolean gate as: Monocytes AND 
Grans OR R4 

 

If an invalid expression is entered, an error message will be displayed. 

 
Scaling 
FlowLogic can Scale or Zoom plots, allowing you to view plots optimally. 
 

• The Scale feature can be found in the plot side drawer. Tick the Zoom box 
in the Scaling section to enable scaling. 

 

• Two red crossed squares will appear on the plot. One in the bottom left and 
one in the top right. To zoom, click and drag either of the red squares 
towards the opposite corner. 
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Features associated with scaling: 
 

• When the plot has been re-scaled, unselect the check box. This will allow 
gating tools to be selected as well as allowing access to the right-click menu 
within the plot. 

 

• By clicking the ‘Revert’ button, the original scaling will be restored. The 
scaling can be reset as many times as you wish. 

 

• When using the batch analysis tool (with the padlock on), the new scaling 
will be copied onto the subsequent plot. This can be adjusted on each plot 
individually if required. 

 

• Clicking ‘Full Display’ will display the entire dataset, which can contain 
events below zero on both axes. 

 

• Untick the ‘LogScaled’ viewing option in order to compress the scaling, i.e. 
drag the red box in the top right towards the left-hand side. 

 
The axis range for dot plots and histograms can easily be set by typing a new 
value into the min and max fields for the x and y axes in the Scaling tab of the 
plot side drawer. When files are grouped, the newly defined range will be 
applied to all files. To alter the min settings, the ‘LogScaled’ setting needs to be 
unselected, due to the nature of the compression. 
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This feature is particularly useful when viewing histograms as the range on the 
y axis can be uniformly set for all sample in the group and therefore, the height 
of the histograms can be compared directly. The adjustment is also applied to 
plots displayed in PlateLogic. 

 

 

Overlays  
• Dot plot and histogram overlays are easy to create. In addition, gates can 

be applied to overlays. This results in the gate being added to every file 
contained in the overlay. If the gate is moved it is automatically updated on 
each file. Once you have built your gating hierarchy, the fastest way to 
create an overlay is to add all your populations directly from the File 
Inspector. 

 
• Highlight all the populations to be overlayed. Adding all files at a particular 

level can be done by right-clicking on the appropriate sample and choosing 

Rows → Highlight Level (or ‘Highlight level within group’ for grouped 
samples). 

 

  



 71 

• Once the populations are selected, right-click and choose ‘New overlay’. 
The overlayed plot will be displayed in the Workspace. 

 

• Dot plots are saved in a separate window at the bottom of the File Inspector. 

 
• If the individual populations have already been drawn as dot plots, then the 

resulting overlay will also be a dot plot. Overlays can be toggled between 
dot plots and histograms using the toolbar. The parameters displayed can 
also be changed. 

 
• Plots that are displayed in the Workspace can be used to create a new 

overlay or can be added to existing overlays. Right-click on the plot and 
select ‘Add To Overlay’. Choose new or an existing overlay. Continue to add 
more plots to the overlay by right-clicking on them in the workspace or by 
right-clicking on the population in the file navigator and choose ‘Add to 
overlay’. 

 

•  
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• Right-click on the overlay to bring up a range of menu options. The options 
include renaming, smoothing and displaying the y-axis range as percentage 
(Display 100%). The transparency can also be toggled on and off. Default 
overlay colors can be set and changed in the program Preferences. These 
can be modified in the overlay plot side drawer. 

 

• To remove a file from the overlay, right-click on the plot area and select 
‘Remove’ followed by the file name. 
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• In the plot side drawer, sequentially click through the tabs to change colors 
and calculate or view statistics. 

 

 
 

• Click in the color column to make a change.  

• Re-order using drag-and-drop. 

• Tick the populations to analyze. Right-click to tick all populations from the 
same level. 

 

 
 

• Select the statistics to be calculated. 

 
• Select the parameters linked to the statistics. 
 

 
 

• Statistics are displayed and can be exported by right-clicking in the plot 
window and choosing ‘Export stats’. 
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Gating on Overlays 

• FlowLogic not only enables the easy generation of overlays but also allows 
for gates to be drawn on overlays. This feature adds a gate to all files in the 
overlay and calculates statistics in the side drawer, which can be directly 
exported. 

 

• Create either a dot plot or histogram overlay with two or more files.  
 

• Select an appropriate gating tool from the Workspace toolbar and draw the 
gate on the overlay. In this case, the gate M1 is added to all files. 

 

 
 

• If the gated population on the overlay is double-clicked, the daughter 
populations will be an overlay of the same files. 

 

• To calculate statistics associated with the gated overlay, open the plot side 
drawer and sequentially click through the tabs to select the statistics to be 
calculated. 
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• Choose the required statistics. 
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• Ensure the parameter associated with the gate is selected. 
 

 
 

• View the statistics in the final tab. 

 
 

 

• Right-click on the overlay plot and select ‘Export stats’ to save the statistics 
as a CSV file. 

 
 

Batch and Jump 
• The FlowLogic File Navigator is comprised of two main tools. Jump and 

Batch. 
 

• The ‘Jump’ tool allows you to scroll through and view large data sets, 
multiple samples at a time. 

 

• Batching can be a very useful tool when you want to apply a set of gates to 
multiple samples one by one. 

 

• Once you have applied gates to the FCS files, you can ‘scroll’ through your 
data several files at a time. For example, if you want to view 5 FCS files at 
a time, you can set the number in the Jump box to 5. Then when you click 
the up or down arrows, FlowLogic will jump through to the next 5 samples 
in order. 
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• To make the most of this feature set the numbers of windows in the edit 
menu to the number of plots in your gating strategy (i.e. the example below 
shows three dot plots with the number of windows set to three). 

 
• In order to jump, click to unlock the ‘Batch’ padlock, set the number in the 

jump box and ‘Jump’ up and down using the arrow buttons. 
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• Ticking the Default Plots options whilst plots are displayed in the screen will 
pin those plots to the Workspace. New plots can then be opened and when 
the Jump function is used, the original plots will remain in the Workspace 
whilst the Jump feature is applied to the more recently opened plots. Above 
the File Navigator is the plot re-sizer tool. Clicking and dragging the re-sizer 
button to the left or right enlarges or shrinks the plots displayed in the 
Workspace. 

•  

• Batching is performed when the Batch padlock is closed. This will prevent 
you from using the Jump function. 
 

 

• Once gates are applied to a file, click the padlock to close it and click the 
down arrow. All gates and statistics are automatically copied to the next 
sample, which will then be displayed in the Workspace in place of the 
previous file. Any modification you make to the gates will then be transferred 
as you click to the next file. 
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• All samples now have the same gating analysis and each file has been 
individually inspected. The statistics are ready to be exported. 

• An alternative to batch analysis is to create Groups. 

 

Group Analysis  
Creating groups can make analysis of multiple samples very quick and easy. If 
a gate is applied to one file in a group, it is automatically applied to the same 
parameters on all other files in the group. 
 

Select all files to be grouped, right-click and select Group → Add to new. 
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Adjustments to individual gates are automatically updated to all within the 
group, along with all calculated statistics. 
 
If copied gates are inserted into a grouped hierarchy on one file, all of the gates 
for that file will be removed from the group. This new hierarchy can then be 
copied and pasted to all other samples (or a selection) and then re-grouped. 

 
 
Right-click Menu in the File Navigator and File Inspector  
Several options to aid with your analysis are available by right-clicking on the 
FCS samples or the Experiment and Project folders in the File Inspector. 
 
File Navigator right-click menu: 
 

 
 
Experiment and Project Folders 
The File Navigator has both Experiment folders with Project folders contained 
within them. This allows for the easy organisation and analysis of FCS files. 
 

• By default, FlowLogic starts with one Experiment folder and one Project 
folder, as shown below. Right-clicking on these folders opens a menu with 
options to create new folders and delete folders. Double-clicking on the 
folder allows it to be renamed. 

 

• Right-click on the Experiment or Project folders to create, add to or delete 
folders. 

 

• Re-order the Project and Experiment folders by drag-and-drop. 
 

• FCS files can be dragged and dropped into the Experiment folders or 
imported by selecting ‘Import FCS…’ from the File menu. 
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The Replace File function allows you to swap the files used in one analysis 
with a new set of files, whilst maintaining all gates, statistical analyses, graphs 
and reports. This can be very useful if you are doing repeat experiments and 
wish to apply the same analysis. There are two options under the Replace 
Files menu: File Replace and Advanced File Replace. 

 
 

 
File Replace 
This option allows you to swap an equal number of files as exist in the File 
Inspector. When selected, you will be prompted to select the files to replace the 
current collection. If you choose fewer files than already exist in the File 
Inspector, FlowLogic will ask if you want to delete the files that are not being 
swapped. In effect, you will end up with only the files that you choose to swap 
into FlowLogic. 
 
This option does not allow you to swap a greater number of files into the File 
Inspector than are already there. Individual files can be replaced by selecting 

the files in the File Inspector and choosing Template → Replace Files (see page 
88 for more details). 
 
 
Advanced File Replace 
This option allows you to specify the individual files that you wish to swap for 
each file in the File Inspector. 
 
If you choose the Advanced File Replace option, you will receive a list of the 
files in your current Experiment Folder. 
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Once all files have been matched with their replacements, click ‘Apply’ to 
perform the replacement. 
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Save Template from a Folder - global analysis templates can be saved from 
an Experiment Folder and can contain all elements from an analysis including: 

• Gating hierarchies 

• Overlays 

• Plates and heatmaps 

• Graphs 

• Statistical analyses 

• Reports 

These templates are very useful for repeated analyses, such as screening 
experiments. There are a number of rules that need to be followed when 
creating and saving a global analysis template. For more information, see the 
section on page 224. 

 
Apply Template to Folders – to apply a global analysis template, select one 
or more Experiment Folders, right-click and choose “Apply Template to 
Folders”, locate the desired template and click “Open”. The number of files in 
the Experiment Folder must match the number in the template. For more 
information, see the section on page 226. 

 
Paste File to Folders – one or more files can be copied from one Experiment 
Folder and pasted, using this option, to another Experiment Folders.  

Top copy a file, highlight it in the File Inspector, right-click → Folder Action → 

Copy File. Then right-click on a selection of Experiment Folders, right-click → 
Paste File to Folders. A copy of the files will be added to the selected folders. 
This can be useful if you would like specific controls for different datasets. 

 
Paste Gates to Folders – Gates copied from a single file in the File Inspector 
can be pasted to an Experiment Folder in the File Navigator. This will paste the 
gates to all compatible files in that folder. Gates can also be pasted to multiple 
folders at once. To do this, highlight the desired folders before choosing ‘Paste 
to Folders’ from the right-click menu. 

If a copied gate is part of a group, then this group setting will also be pasted to 
the files within the folder.  

 
Paste Gates to Folders and Group – when selecting this option when pasting 
a copied gate(s) to a folder, all compatible files within the folder will be added 
to a group. If a copied gate is pasted to multiple folders at once, files in each 
folder will be added to a new group. 

 
Copy/Paste Header Settings – if the order of the columns in the File Inspector 
has been changed, then these settings can be copied from one Experiment 
folder and pasted to others. 
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Build Plate – this creates a 96 well plate and loads the files in successive wells 
until the row/column is filled before starting in the next row/column. 
 

Build Plate with Well ID – if the files name is the Well ID, then selecting this 
option will load the files in the wells that correspond to their names/Well ID. If 
the Well ID is outside the standard dimensions of a 96 well plate, the plate 
dimensions will automatically be adjusted to incorporate the files in their correct 
position. The Well ID has to be set as the naming option prior to creating the 
plate. Once the files have been loaded into a plate, the name can be changed 
from the Well ID to another format whilst maintaining the position in the plate. 
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Build Plate with Hierarchy – this option will build a plate with one column per 
file. As gates are created, a new row will be added to the plate, displaying the 
subsequent daughter population and each level in the hierarchy will be 
assigned to a new dataset. This allows each level of the hierarchy to be treated 
independently, such as in the type of statistic calculated. This type of plate can 
be built at any stage of the analysis as it will grow as new gates are created. 

 
Build Plate with Images – this option also builds a plate with a column for each 
sample and a row for each level of the hierarchy, although the rows will not be 
separated into different datasets. In effect, only the dot plot image is displayed. 
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FCS File Menu – right-click on the FCS file or gate name 
 

 
Tag – choose to add tags (user defined or a range of auto-tags) to highlighted 
samples. Once samples have been tagged, use the filter option in the tag menu 
to display a select number of samples based on their tags. For more 
information, see page 92. 
 
Keywords – additional information contained within FCS files can be displayed 
in the File Inspector. There is also the option to import additional keywords 
contained within a CSV file. The configuration of the keywords can be defined 

by selecting ‘Edit’ → ‘Keywords’. For more information, see page 94. 
 
Rename – rename individual files by inputting a new name or choose from the 
original FCS file name or sample name created during acquisition. 
 
Group – FCS files can be placed into groups. This means that gates added to 
one file in a group are automatically added to the rest. Statistics are also applied 
to the entire group. To add files to a group, highlight them in the File Navigator 

and select ‘Group’ → ‘Add’ to new. 
 

Plots – choosing ‘Plots’ → ‘Open’ will open all highlighted rows in the File 
Inspector as either dot plots or histograms. This is the fastest way to open 

multiple plots at once. Choosing ‘Plots’ → ‘Close’ will close all plots and 
histograms open in the workspace. This is the fastest way to clear the 
Workspace. 
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Rows – each file and gate name in the File Inspector represents one row. Use 
the Rows menu options to help select and delete single or multiple rows at a 
time. 

• Show/Hide Gates – Hiding gates results in only the file name being 
displayed. Showing gates reveals all levels of the gating hierarchy. 

• Select All/Inverse – Select all highlights every row. The same result can be 
achieved with the keyboard shortcut ‘Ctrl/⌘A’. This is useful if you want to 
open every gate as a dot plot/histogram or if you would like to delete 
everything. Select Inverse highlights all but the files that are selected before 
clicking ‘Inverse’. 

• Delete – deletes all rows that are highlighted. It may be useful to use the 
different select features in conjunction with the delete option. FlowLogic will 
warn you before deleting the rows. 

• Highlight Level – select a gate on one file. Clicking ‘Highlight Level’ results 
in the same gate being highlighted on every file in the File Inspector. This is 
very useful if you wish to open plots for a particular subpopulation for many 
samples or for creating overlays. After highlighting an entire level, choose 
to create an overlay or add the files to an existing overlay. 

• Highlight Level within a Group will only select the rows from files in the same 
group as the initial sample. 

 
Copy –  

• Copy Gates – copies the highlighted gates to paste onto other files. If you 
wish to paste gates, take note that the gate is pasted to the file and not to 
another gate. If statistics have been calculated for a sample before its gates 
are copied, the statistics will also be calculated for the new samples when 
the gates are pasted. 

 

• Copy Statistics – if statistics have been calculated for one sample, the 
selection can be copied and pasted onto other samples, resulting in the 
same statistics being calculated for the selected samples. This is relevant 
when not working in Groups. 

 

• Copy Plots – highlighted dot plots/histograms/overlays can be added to the 
computer’s clipboard and subsequently pasted into other programs. In 
Windows, multiple files can be added to the clipboard at once. These are 
pasted as .svg images. In macOS, one file at a time can be added to the 
clipboard. This image is pasted as a .pdf. 

 

• Copy Table – you can copy the data displayed in the columns of the File 
Inspector for individual files. 

 
Paste – paste copied gates either to selected files or to all files at once. 
Choosing ‘Insert Gates’ will paste the selected gates into the selected level of 
the gating hierarchy. 
 
Delete – delete all gates in the experiment, all statistics or individually selected 
rows. Rows refer to the different levels or gates in a hierarchy, so specific gates 
can be deleted, or the samples/files if the top level of the hierarchy is selected.  
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Template – 

• Replace Files – this function works similarly to that described previously in 
this section. Find Replace swaps an equal number of highlighted files with 
new files. Advanced File Replace allows you to specify individual pairs of 
files to swap. All gates, statistics and reports remain but are updated to 
match the replacement files. 

• Gate – gating templates can be saved and applied within the current 
experiment or loaded onto files in other experiments. 

 
Compensation – compensation matrices can be copied, saved and applied to 
other files within an experiment or to files in other experiments. 
 

 
 
Export –  

• Plots – single or multiple plots can be exported in .jpg, .png, .svg, .eps, 
.pdf and .ps file formats. Plots can also be copied and exported by right-
clicking on the plot in the Workspace  

• Statistics – this refers to any statistics calculated in the Advanced 
Functions drawer for the selected files 

• Raw FCS data can also be exported as a .csv file. This is the data 
without considering compensation 

• Real FCS data is the data with compensation applied 

• Table – this is the complete table displayed in the File Inspector 
 
PlateLogic – if a plate has been created in PlateLogic, additional data can be 
added to existing plates by highlighting the files and choosing Data Array 
Insert followed by the plate name. These samples will be added to the plate in 
the first available wells, in the direction defined in the plate side drawer. To 
choose the location of the inserted samples, highlight the empty wells in the 
plate before selecting the files and inserting them via the right-click menu. 
 
Overlay – overlays can be created by highlighting a gate and selecting Overlay. 
If an overlay already exists, individual or multiple gates of the same level can 
be added by highlighting them and selecting Overlay, Add To Overlay and the 
particular overlay. 
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TitrateLogic – Automatic titration analysis can be performed on specific 
populations from a selected number of files. Once gating has identified the 
population/parameter to be analyzed, display it along the x-axis, highlight the 
populations/rows in the File Inspector, right-click and choose TitrateLogic. This 
will create histograms and histogram markers for the positive and negative 
peaks, a data array view showing all populations, and two titration overlays. A 
report is automatically generated and includes graphs showing the median 
fluorescence intensities for the positive and negative signals, signal versus 
noise ratio and the stain index. For a more detailed description of the titration 
analysis, see the relevant section in this manual. For a detailed explanation, 
see page 100. 
 
MQD –  

• Ungroup MQD Files – FlowLogic can split an MQD file that was grouped 
in Miltenyi Biotec MACSQuantifyTM Software and display the individual files. 
These split files are exported/saved in a defined folder and can be re-loaded 
into MACSQuantifyTM Software. 

 
Split grouped MQD files by right-clicking on the file in the File Inspector and 

choosing ‘MQD’ → ‘Ungroup MQD Files’. When choosing this option, 
FlowLogic will ask to select a folder on the computer where the extracted 
files can be saved. The files will also be automatically loaded into the File 
Inspector, underneath the original grouped MQD file. 

• Load MQD/MQDFL gates – gates created in MACSQuantifyTM Software at 
acquisition can now be loaded in FlowLogic. If the MQD files contain the 

gate information, then right-click on the selection of files, choose ‘MQD’ → 
‘Load MQD/MQDFL’. The gating hierarchy will appear in the File Inspector 
and these can be manipulated like any other gate. Please note that the MQD 
gates when loaded in FlowLogic might not be a precise recreation due to 
the interpretation required by FlowLogic. However, in most cases, they 
should be very similar. 

 
Index Sorting – This feature displays data compiled from an index sort, in 
PlateLogic, with the corresponding plate position reflecting the sort ‘Well ID’. 
Gated events from the original sort file can display in a new plate, again in the 
true well position. This feature is optimized for BD FACSAriaTM index sort files. 
 
To export the individual event files and load them into the corresponding 
position in a plate, right-click on the file in the File Inspector and choose ‘Index 

Sorting’ → ‘Export Files’. Then choose a location where the individual event 
files will be saved. These individual files will then be loaded into the File 
Inspector. 
 
Once the files have been exported, events in the original index sort file can be 
gated and matched to the plate in PlateLogic. To do this, gate on the desired 
events in the original file, right-click on the gate name in the File Inspector and 

select ‘Index Sorting’ → ‘Match Cells in a Plate’, followed by the plate name. A 
new plate will be created showing just those samples defined by the gate. 
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Additional gates can be created on the original file and matched to either the 
plate containing all events or subsequent plates containing gated events.  

 
Folder Action –   

• Build One Folder per File – this feature will take a selection of files from 
one Experiment Folder and place them individually into new Experiment 
Folders. The new Experiment Folders will be named with the name of the 
file added to it. 

• Copy File – this feature copies a selection of files, which can be pasted into 
other Experiment Folders. To paste the selected files, select the new 

Experiment Folders, right-click → Paste File to Folders. 
 

Gate Templates 
Gating analyses can be saved as a template to be applied to other files in the 
same experiment or to files in other experiments. 
 

• After applying a series of gates to a file, right-click on the file name and 

choose Template → Gate → Save Gate Template. FlowLogic will ask you 
to name the template before saving it as a .GATELOGICTEMPLATE file. 
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• To apply a saved template, highlight one or more samples, right-click and 

select Template → Gate → Apply Gate Template… Select the template and 
click Open. FlowLogic will then apply the gates to all selected files. Statistics 
such as %Parent and %Total, located in the File Inspector, will be updated 
when the sample is opened in the Workspace. 

 

 
 

• An alternative to creating and applying templates within an experiment is to 

highlight the gates, right-click and select Copy → Copy Gates. 

• Then, highlight the samples that you wish to apply the gates to and select 

Paste → Paste Gates or To All. The keyboard shortcuts Ctrl/⌘C and 
Ctrl/⌘V can also be used to copy and paste gates. 
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Tags 
Tags can be applied to samples in order to help search through large datasets 

or to filter results. Tags can be user defined or chosen from a selection of 
automatic tags. 
 

• To create a tag, right-click on a sample in the File Inspector and select Tag. 

• To create a user defined tag, select New Tag and type in the keyword. 

• To create an automatic tag, select Auto-Tag and choose an option from the 
list. 
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• Once tags have been assigned, right-click in the File Inspector, choose Tag 

→ Filter. Set the Filter mode and then select the tag (in the example below, 
the tag is ‘Test tag’. Only those samples with the specific tag will be 
displayed in the File Inspector. 

• Auto-tags can be used effectively to display plate data that fall in a specific 
range in a heatmap. To create this type of tag, choose Plate:Heatmap from 
the auto-tag list, then filter on the specific heatmap color. 
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Keywords 
 

Displaying keywords with the Keyword Configuration window – keywords 
contained within the FCS file can be displayed in the File Inspector and 
subsequently used for reference or to sort samples. The Keyword Configuration 
window can be accessed through the Edit menu, under Keywords. 

 

 

 

 
Adding keywords to files by csv – Multiple keywords contained in a csv file 
can be imported and assigned to one or a selection of files. By default, 
keywords will be matched to the files in the order that they appear in the File 
Inspector. Files can be sorted based on any keyword that is contained in the 
FCS/MQD/LMD file or from imported keywords. Samples can be sorted either 
ascending or descending by double-clicking on the column title in the File 
Inspector. 
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Highlight the selection of keywords matched to the files that you wish to import 
and click ‘Add keywords’. The Keyword Configuration window will then open. 
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The new keywords assigned to the selected files will now be displayed in the 
File Inspector: 

 

 

To import keywords, create the CSV file in the following format, with the first 
row being the keyword heading and the subsequent rows being the keyword 
data. 
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Sorting samples in the File Inspector 
Samples in the File Inspector can be sorted (re-ordered) in several different 
ways.  

1. Right-click on column header and choose ‘Sort’ followed by a sort style: 

 

 

2. Click on one or a selection of samples and drag them to a new position. 
This will automatically set the Sort style to ‘Free’: 
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3. Double-click on the column headers to sort in numerical/alphabetical 
order: 

 

 

Samples in the File Inspector can be sorted based on the values or numbers in 
the different File Inspector columns. Double-clicking the column title will sort 
the samples in ascending order (numerically or alphabetically). Double-clicking 
again will sort them in descending order. 
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TitrateLogic 
 
FlowLogic contains a quantitative titration analysis tool that automatically 
detects the positive and negative signals for a defined parameter, creating 
titration overlays and a report displaying all populations from the analysed 
samples along with graphs displaying median fluorescence intensities for the 
positive (signal) and negative (noise) populations, the signal to noise ratio and 
the stain index. 
 
Titration analysis is generally faster and easier when all files are grouped but 
grouping is not necessary. The first step is to apply the relevant gates to identify 
the population and marker to be analysed. Display this parameter on the x-axis 
of the dot plot. From this point there are two ways to perform the analysis: 
 

1. Right-click on the dot plot and from the options choose ‘TitrateLogic’. 
 

 
2. Highlight the populations in the File Inspector, right-click → TitrateLogic’. 
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The first option will perform the analysis for all files in the Experiment folder that 
contain the matching gates. The second option will only include the selected 
populations in the analysis. 
 
FlowLogic will then clone the population, display it as a histogram and create 
signal (+ve) and noise (-ve) histogram markers by automatically detecting the 
positive and negative peaks. 
 

 
 
 
The histogram markers are not contained in the group, allowing for the 
adjustment on individual plots if required. 
 

 
 
 

The following image shows the automatic creation of histogram markers for the 
signal and noise peaks. 
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Two titration overlays are also generated and displayed in the workspace. The 
parameters used for these plots are taken from the plot selected to perform the 
analysis. The displayed parameters can be changed by clicking on the axis 
label and choosing a new parameter, as with any other plot.  
 

 
 
 
Samples can be removed and added to both plots (right-click menu) and 
switched on and off from the stacked histogram overlay (plot side drawer under 
the ‘Overlay Colors’ tab). 
 
The titration dot plot overlay can be viewed using any of the plot display options 
from the toolbar above the workspace. 
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All plots involved in the analysis are also displayed in a plate under the Data 
Array tab in the Advanced Functions drawer. This plate can be saved/exported 
by right-clicking and choosing Export → To File. 

 

 
 

In the Graph section, the data derived from the histogram markers are used to 
calculate and display median fluorescence intensity (signal versus noise), the 
robust standard deviation for the noise (-ve) marker, signal-to-noise ratio, the 
difference in median fluorescence intensity (+ve minus –ve) and the stain index. 
In theory, the highest value on the stain index graph equals the optimum 
saturating titration. If there are too many antibodies, sensitivity is reduced by 
increasing noise (SI is decreased). If there are too few antibodies, sensitivity is 
reduced by decreasing the positive signal (SI is decreased). 

 

 
 
The stain index1 is calculated using the following formula: 
 

Stain index =  

MFI = median fluorescence intensity 
RSD = robust standard deviation 
+ve = positive signal defined by the histogram marker 
-ve = negative signal defined by the histogram marker 

 
1 Telford WG, Hawley T, Subach F, Verkhusha V, Hawley RG. Flow cytometry of fluorescent 

proteins. Methods. 2012;57:318-30. PMID: 22293036. 
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A report is also automatically generated from the elements in the Analysis and 
Graph sections. These include all dot plots and histograms, the plate and the 
graphs displaying median fluorescence intensity, signal-to-noise ratio and the 
stain index. To view the titration report, click on the titration document in the 
List of Documents. Double-click on the document title to rename it. The report 
can also be saved as a PDF using the option in the toolbar. 
 
 

 
Samples of the final report: 
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Advanced Functions Pull-Up Drawer  

The Advanced Functions pull-up drawer contains additional analysis features 
to improve efficiency and increase the data mining capabilities. To access the 
Advanced Functions drawer, click on the top of the drawer (located at the 
bottom of the Workspace) and drag it up. It can be pulled up to entirely cover 
the Workspace, if desired. The Advanced Functions drawer consists of a 
number of tabs. These are PlateLogic, Set Statistics, View Statistics, 
Parameters, Geometric Gates, Boolean Gates, CompLogic, Metadata, 
Compensation, Cell Cycle, Proliferation, Curve Fit and Kinetics. 

 
 

ClusterLogic Introduction 
 
Cluster analysis in FlowLogic follows the following general workflow: 
 

1. Generate clusters using the ClusterLogic algorithm 
2. Define the clusters with the auto-phenotype feature 
3. View the cluster relationships using FlameLogic 
4. Find clusters in all files using a cluster fingerprint 
5. Add defined clusters to the File Inspector as subpopulations 
6. Validate clusters using the auto-gating feature to create a traditional 

gating hierarchy 
 
There are various options available at each stage of the above workflow, where 
you can tailor your analysis. For example, if you have FMO controls, these can 
be automatically considered in naming the phenotypes. Another example, 
matching of a cluster fingerprint can be based on phenotype, the fluorescence 
signature in any combination of parameters, or both. These options will be 
covered in the sections below. 
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Generate clusters 
 
Generate the clusters within your files using the unsupervised clustering 
algorithm. This step requires the user to select the parameters with which to 
cluster. The time required to build clusters can range from seconds to hours 
depending on the number of files, number of events in each file, the number of 
parameters and the computer’s processor.   
 
1. Import files into FlowLogic, open the Advanced Functions drawer and select 

the ClusterLogic tab. 
 
2. Within ClusterLogic, select the Builder tab followed by the Cluster tab on the 

left-hand side. Define which files to cluster and the number of events within 
each file to cluster.  
 
Build clusters for: 

• Selected files: highlight the files in the File Inspector 

• All files in the group: select one file in the desired group from the File 
Inspector 

• All files and folders: no files need to be selected. All files in the 
analysis will be included. 

 
Events to cluster: 

• All: all events in all files will be considered 

• Define: type in the number of events to be used.  
 
* It is recommended to cluster with all events, although this will take 
longer. You may choose to cluster on a smaller number for a quick 
check of the identified clusters. 
 

 
 

3. Click “Build clusters”. A window will open allowing the selection of 
parameters to cluster with (column “Level 1”). Tick to select the desired 
parameters. It is recommended to select all parameters except Time. Once 
the selection has been made, click “Build Clusters” at the bottom of the 
window. A pop-up window will indicate the process has begun. This window 
will close automatically once the clustering is complete. If you wish to cancel 
the clustering at any stage, simply close this window. 
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* The other options in the parameter selection window allow for the auto-
phenotype naming of clusters. However, this can be done after the 
clusters have been generated 

 
4. Save your analysis File -> Save As. The cluster information will be saved 

with your .glf or .gatelogicexperiment files and will be instantly accessible 
when the file is re-opened, meaning the clustering only needs to be 
performed once.  
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The Cluster Summary window 
 

After the cluster process has finished, all clusters derived from a selected file 
will be displayed in the cluster Summary window of the ClusterLogic Builder 
tab. The summary window contains a number of attributes: 
 
Summary table 
 

 

 
ID – this is the cluster rank, based on the cluster size (number of events in the 
cluster). ID1 is the largest, ID2 is the second largest, etc.  
 
Cells – this is the number of events in the cluster. If all events in the file were 
involved in the clustering, then all events will be assigned a cluster ID. However, 
many events will not exist in true clusters and these will be listed in the table as 
clusters with 1 event.  
 
Show – tick the box in this column to color the events in the cluster on the dot 
plot. 
 
Color – this is the color assigned to the cluster when displayed on the dot plot. 
Click on the solid color to select a new one from the available options. 
 
Phenotype – this is the cluster phenotype as created using the auto-phenotype 
feature. 
 
Name – this is the cluster/population name as defined by the user. This is 
editable. 
 
X mean – this is the mean fluorescence value of the cluster for the parameter 
displayed on the x axis of the dot plot. This value will change if the parameter 
selection on the dot plot is changed. 
 
Y mean – this is the mean fluorescence value of the cluster for the parameter 
displayed on the y axis of the dot plot. This value will change if the parameter 
selection on the dot plot is changed. 
 
Parameters – the MFI for each cluster will be displayed for each parameter 
saved in the file. You can scroll to the right to scan all of the values.   
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The columns of the summary table can be re-ordered by clicking and dragging 
the column heading to a new position. Each column (except for the parameters-
labelled MFI columns) can be sorted by double clicking the column title. Double-
click once to sort high to low. Double-click again to sort low to high. 
 

Summary window toolbar 
 

 
 
The toolbar contains a number of different functions 
 
Show clusters only: 

Selected files - if clusters are colored on dot plots, this option will hide all other 
events in the dot plot except for the chosen clusters but only for the files 
highlighted in the File Inspector 
 
All files – this will hide all events in all files except for those in shown clusters. 
 

Cluster name: 

Copy name – after typing in a population/cluster name, select the cluster row 
and click the icon to copy the name to the clipboard 

Paste to selected – a copied cluster name can be pasted to a selection of 
clusters  

Paste to matching phenotype – a cluster name copied from a cluster 
containing a phenotype can be pasted to all cluster with the same phenotype 
without having to select them. 
 
Build using: 

Name – when adding a cluster/s to the file in the File Inspector, selecting this 
option will rename it with the cluster name 

Phenotype – when adding a cluster/s to the file in the File Inspector, selecting 
this option will rename it with the cluster phenotype  
 
Custom – when selecting this option, the name typed in the text field will be 
applied to all selected clusters. This is particularly useful when combining 
clusters with different phenotypes, such as building a parent population made 
up of various subpopulations. 
 
Default – this will apply a default cluster name, following the sequence C1, C2, 
C3, etc. 
 
Build one cluster gate with selected – multiple clusters can be combined into 
one population and added to the file in the File Inspector. Select the clusters 
you wish to combine and select this button to build the cluster. 
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Build one cluster gate for each selected – each selected cluster will be 
added to the file in the File Inspector as an individual population.  

Add all selected clusters to the fingerprint table – this creates a new 
fingerprint for each selected cluster and adds it to the fingerprint table. These 
fingerprints contain the MFI in each parameter for the specific cluster. These 
can then be used to search through other files for matching clusters. 

Auto-gate via a cluster – clicking this icon after selecting a cluster will open 
the parameter and phenotype settings for auto-gating window. From here, 
auto-gating with hierarchy generation can be executed in order to validate a 
cluster.  

Export – export the cluster summary table as a .xlsx or .csv file 

Color wheel – set the color for a selection of clusters  
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Auto-phenotype and cluster naming  
 
FlowLogic can automatically define the cluster phenotype given two pieces of 
information: 

• The marker names 

• The fluorescence value for each parameter above which is considered 
positive fluorescence 

 
1. Name the markers – in the Advanced Functions drawer, select the 

Parameters tab. In the Custom Labels column, double-click within a row to 
edit the name. Type the marker name that corresponds to the relevant 
parameter, as listed under the Parameter Labels and User Labels columns. 

 

 
 
2. Within ClusterLogic, select the Builder tab followed by the Phenotype tab on 

the left-hand side. Define the files to have the phenotype added to the list of 
clusters.   
 
Phenotype: 

• Selected files: highlight the files in the File Inspector. 

• All files in the group: select one file in the desired group from the File 
Inspector. 

• All files and folders: no files need to be selected. All files in the 
analysis will be included. 

 
Click “Build phenotype”. 

• The Phenotype Settings window will open. In the Phenotype column, 
tick to select the parameters you wish to be considered when naming 
the phenotypes (not all markers have to be used).  

• In the +ve MFI  column, double-click to type the fluorescence value 
for which the marker expression is considered to be positive (each 
marker can have a different value). 
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* If you have FMO controls, these can be used to automatically 
determine the fluorescence value. See the explanation in the section 
“Using FMOs” 
 

Once all fluorescence values are set, click the “Build Phenotypes” button at 
the bottom of the Phenotype Settings window. 

 
3. To view the phenotypes, click on an individual file in the File Inspector. The 

list of clusters including the phenotype will be displayed in the Summary 
table of the ClusterLogic Builder tab.  
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Using FMOs to name the phenotypes 
 
Auto-phenotyping requires a fluorescence value to be added for each 
parameter in order to define where positive marker expression begins. If FMO 
controls have been acquired, FlowLogic can automatically determine the 
fluorescence value from a simple rectangle gate.  

Not all markers are required to have an FMO in order to use this feature and 
the same control can be used to set the fluorescence value for two different 
parameters. 
 
To derive fluorescence values from FMOs: 
 
1. Open the FMO as a dot plot with the x-axis showing the parameter without 

the antibody/stain. 
2. Add a rectangle gate beginning at the point of positive marker expression. 
3. Name this gate with the marker name, as defined in the Parameters tab. 
 

 
 

Then, when performing the auto-phenotyping (as described on page 111): 
 
4. When the Phenotype Settings window opens, highlight all of the gates on 

the FMOs in the File Inspector and then click “Update FMO” in the 
Phenotype Settings window. 

 

The fluorescence values will appear in the +ve MFI  column. These values 
can be edited by double-clicking on the cell and typing in a new number.  
 
The values for samples without associated FMOs can also be added by double-
clicking on the cell and typing number. 
 
Gates added to multiple parameters from one file can be used to update the 
fluorescence values for multiple markers. Just be sure to rename the gates with 
the marker name and select it before clicking the “Update FMO” button.  
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Viewing and naming clusters 

 
Viewing 

After clusters have been built, then can be coloured and viewed on the dot 
plots. This is generally easier to do after defining the phenotypes, as these 
provide an indication as to which parameters to choose for best viewing.  

To colour a cluster, open a dot plot and tick the ‘Show’ box related to a specific 
cluster. This will colour the events comprising that cluster. To change the cluster 
color, click on the solid color in the Color column and select a new one from the 
options available.  

Multiple clusters can be colored on a dot plot and the coloring will be maintained 
as parameter combinations on the plot are changed. 

 

Naming 

In addition to the cluster phenotype, names can be assigned to different 
populations. To add a name, double-click in the corresponding cell in the Name 
column of the cluster Summary table. Then, type the new name.  

 

 

Icons in the toolbar can be used to copy a name and paste it to a selection of 
clusters, or you can choose to paste a copied name to all clusters with a 
matching phenotype, by using the paste to matching phenotype icon. 

 

When adding clusters to the File Inspector, there is a toolbar option to build the 
clusters and rename with either the population Name or phenotype. This will 
save you from renaming the cluster once it is added to the file in the File 
Inspector. 
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Filters 

 
There are four categories of filters withing ClusterLogic: Cluster ID, cluster size, 
X and Y MFI and phenotype. These filters can be accessed under the Filter tab 
in the panel on the left-hand side of the Builder section of ClusterLogic. A 
modified version is available under the Match tab, where the MFI options have 
been removed. 

Clusters – Clusters are ranked in order of size (number of cells within the 
cluster). Clusters are then assigned a Cluster ID, with the largest being ID 1, 
followed by ID 2, etc. This filter can be used to select clusters from a defined 
range of IDs. The most common would be to select the x number of biggest 
clusters, such as the biggest 50. However, it is possible to display the second 
largest 50 clusters (ID 51-100) if desired. To use this filter, double-click to define 
the Cluster ID in the From and To text fields. Then, tick the box in the ON 
column. The range can be edited at any stage. 

Cells – similar to filtering on Cluster ID, clusters can be filtered on a range of 
sizes (number of cells within the cluster). The difference here, is that the exact 
number of events is entered into the From and TO columns. For example, 
choose to show only clusters with a size of 20 events to 1,000,000 events. This 
excludes all clusters with fewer than 20 events.  To use this filter, double-click 
to define the Cluster ID in the From and TO text fields. Then, tick the box in the 
ON column. The range can be edited at any stage. 

X and Y MFI – This option refers to the plot displayed in the Workspace.  Each 
cluster has an MFI for each parameter and when a plot is displayed, the 
parameter on the X and Y parameter MFIs are displayed in the Summary table. 
MFI ranges can be entered for the X, Y or both displayed parameters to isolate 
clusters in a specific portion of the plot. Tick the box in the ON column once the 
MFI values have been added. These values can be edited at any stage. 

Phenotype – Once auto-phenotyping has been performed, clusters can be 
filtered on marker expression. At the bottom of the Filter panel is a list of all 
parameters in the file (this list mirrors the list in the Custom Labels column of 
the Parameter tab). This list contains all of the markers included in the 
phenotype definitions. 

Phenotypes can be filtered by an exact phenotype by ticking the positively 
expressed markers in the Exact column. For example, ticking CD45 and CD3 
will show only clusters that are exactly CD45+CD3+ and none of the 
subpopulations.  

In order to display clusters that are at least positive and negative for defined 
parameters, tick the appropriate boxes in the +ve and -ve columns. For 
example, if you tick CD45 in the +ve column, all clusters that contain CD45 will 
be displayed, even if they also positively express other markers. So, this 
selection will display all CD45+ populations. In this case, all clusters can be 
selected and built in the File Inspector, effectively extracting the full CD45+ 
population. Be aware that all filtering options are considered, so if you have 
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chosen to display the top 50 clusters, there may be additional CD45+ clusters 
that are not part of this extraction.  

The -ve selection column is used to exclude clusters displaying a particular 
marker. For example, CD4 T cells could be identified by ticking the CD45 and 
CD3 boxes in the +ve column and the CD8 box in the -ve column.   

 

 

At the bottom of the Filter panel is an option to display Unique phenotypes. 
When clusters are identified, there will often be many with a given phenotype. 
By ticking the Unique phenotypes option, only the largest example of each 
different phenotype will be displayed. This is useful when generating 
fingerprints for a range of cell types in a given family. The fingerprints can then 
be used to search for matching clusters in a range of files and different parent 
and sub-populations can be extracted (using the filtering options) from the 
results in the Match tab. 

 
FlameLogic 
 
FlameLogic provides a schematic overview that depicts the relationships 
between different cluster families. It shows the most abundantly expressed 
markers at the top of the tree, with the various subpopulations displayed below.  
 
The FlameLogic panel is divided in two section: a collapsible folder hierarchy 
and an interactive diagram. Both sections are able to be filtered using the 
options in the Filter window. 
 



 117 

Information is displayed within each box showing: 

• The cluster family phenotype (as defined by the auto-phenotyping 
process) 

• Family cells – the total number of cells from all clusters that are linked 
by containing at least the markers listed in the phenotype at that level of 
the tree (includes subpopulations) 

• Family clusters - the total number of cells in all clusters that are linked 
by containing at least the markers listed in the phenotype (the cell count 
from a particular level of the tree and all subpopulations) 

• Cells – the total number of cells from all clusters that have the exact 
same phenotype 

• Clusters – the total number of clusters possessing the exact same 
phenotype 
 

 
The type of information can be toggled on and off using the options in the 
toolbar. It is also recommended to filter the number of clusters, e.g., 20. This 
will clarify the table by excluding non-specific clusters, such as those with only 
one event. 
 

 
 
 
Auto-gating for cluster validation can be performed by double clicking on a box 
in FlameLogic and following the steps as described in the auto-gate validation 
section of this manual.  
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Fingerprint matching 
 
After a cluster fingerprint has been created, it will be listed in the table under 
the Fingerprint tab. 
 

 
 
 
To search other files (or within the same file) for clusters with a matching 
fingerprint: 
 
1. Highlight the fingerprint in the table 
2. Choose which files to search in by selecting the appropriate option in the 

toolbar: 

• Selected files 

• All files in the group 

• All files and folders 
3. Choose the type of matching: 

• MFI (see following section for setting the MFI range) 

• Phenotype 

• MFI + Phenotype 
4. If searching based on MFI, update the MFI range window to the left of the 

fingerprint window (instructions detailed below) 
5. Click ‘Match’ in the fingerprint toolbar 
 
The resulting matches will be displayed in the ‘Match’ tab. 
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Setting the MFI range table 
 

A cluster fingerprint contains the cluster phenotype (if defined) and the MFI for 
each parameter. The phenotype and any number of MFI values can be used to 
search for similar clusters. And for each selected parameter, an MFI range in 
terms of %above and %below the cluster MFI can be defined. 

 

1. In the search column, tick the parameters that you wish to be considered 
in the matching of the fingerprint.  

2. Double-click on a value in either the MFI%Up or MFI%Down column to 
enter a new value. 

3. If you are using the same values for the MFI range in other parameters, 
highlight on row, click Copy at the bottom of the window, then select the 
other parameters before clicking Paste.  

The settings in this table will be used when searching for matching clusters 
when using the MFI options in the fingerprint toolbar. 
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Add clusters to the File Inspector 
 
From either the Builder or the Match windows, selected clusters can be added 
to the File Inspector. They will be listed with each file in the same way as a 
gated population. 
 

 
 
To add clusters, highlight them in the table and click the icon to either: 

• Build one cluster gate with selected  

• Build one cluster gate for each selected  

The first option will combine all selected clusters and generate a single 
population in the File Inspector. The second option will generate one 
population for each selected cluster. 

In addition, the generated clusters can be named automatically, by ticking the 
option in the toolbar to name with the description in the Name column or the 
Phenotype column. 

 

Auto-Gate Validation 

 
ClusterLogic contains an auto-gate feature that generates a traditional gating 
hierarchy for a selected cluster. The gated population can be compared to the 
cluster and used for validation. Statistics from the two populations can be 
analyzed, whilst the populations can be overlaid and viewed on all parameters 
to identify any subtle differences.  
 
To perform the auto-gating, select one or more clusters and add the populations 
to the File Inspector using one of the two following toolbar icons: 
 

 
 
 
Once the cluster exists on the File Inspector, click on the auto-gate via cluster 
icon in the toolbar.  
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Clicking on the icon will open the Parameter and Phenotype settings for auto-
gating window. This is where you can define the nature of the gating hierarchy, 
of which there are three options: 

1. Choose the parameter combinations for each level of the hierarchy 
2. Select the markers to be considered in the gating hierarchy and allow 

ClusterLogic to determine the combinations 
3. A combination of user defined and automatic parameter combinations. 

 
Option 3 is the most likely. This allows the user to create a ‘Singlets’ gate on 
FSC-A vs FSC-H and then let ClusterLogic determine the remaining 
combinations. 
 

 
To define the combinations, tick two parameters in the ‘Level 1’ column. To add 
another level of defined parameters, click the “+” at the top of the window. This 
will add a ‘Level 2’ column.  
 
In order for ClusterLogic to determine the combinations, tick all of the 
parameters you wish to be considered when creating the gating hierarchy in 
the ‘Parameters’ column. When all selections have been made, click the ‘Build 
Gates’ button at the bottom of the window. 
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QCLogic 

 
QCLogic provides options to check and compare files to identify and remove 
abnormalities. A report is created, which can be exported as a .txt file. 

Assessment can be performed on the flow rate, fluorescence signal over the 
time of acquisition and the metadata, which consists of attributes such as the 
compensation matrix and PMT voltages.  

QCLogic can be accessed from the pull up drawer at the bottom of the 
GateLogic window. The selection panel appears as follows:  

 

 

 
Flow Rate 
 
FlowLogic can assess the flow rate of a sample and extract events that fall 
within a user-defined range. The extracted events effective form a 
subpopulation, meaning the original dataset is preserved in the File Inspector. 
It is also possible to run an assessment, producing a written report, without 
performing the event extraction.  

 

To assess the flow rate: 

• Tick the Flow Rate option within QCLogic 

• Select the type of average, being Median, 
Mean or Time 

• Define the collection range as a percentage 
above and below the average 

• Choose to “Build report only” to create a 
statistical report without performing the actual 
extraction and generation of the subpopulation 

• Choose to “Display plots” to open the assessed 
plots in the workspace upon executing 
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Here is the result of the extraction of events within 20% of the median flow rate, 
showing the original and extracted data in pairs. 

 

 

      

 

 

 

 

 

 

 

 

 

 

 

 

And here is the corresponding flow rate extraction report, located to the right of 
the QCLogic settings. The text can be cleared by clicking on the red ‘Clear text’ 
icon or exported as a .txt file using the ‘Export text’ icon at the top of the report 
panel. If another check is performed without clearing the previous text, the new 
results will be appended. The full report can then be exported as a single .txt 
file. 

 

 

The extracted events appear as a subpopulation in the File Inspector, 
immediately below the population that the extraction was performed on. These 
can be treated as a normal gated population. Expanding the File Inspector will 
also reveal a column containing the flow rate for each sample. 
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Fluorescence 
 
The process for assessing the fluorescence signal over time is similar to that of 
the flowrate assessment. Note that FlowLogic will assess all fluorescent 
parameters together.  

To assess the flow rate: 

• Tick the Fluorescence option within QCLogic 

• Select the type of average, being Median or 
Mean  

• Define the collection range as a percentage 
above and below the average 

• Choose to “Build report only” to create a 
statistical report without performing the actual 
extraction and generation of the subpopulation 

• Choose to “Display plots” to open the assessed 
plots in the workspace upon executing 

 

Here is the result of the extraction of events within 0.2% of the median flow rate 
(the very small range was used as an example in order to show the removal of 
some events), showing the original and extracted data in pairs. 

As with the flow rate check, the results are displayed in the QCLogic report 
panel, where the text can be cleared or exported using the icons in the toolbar. 
The percentage of parent and total statistics for the extracted population can 
also be viewed in the File Inspector.  
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Metadata 

 
The metadata within a selection of files can be compared to check if the files 
match appropriately in order to be analyzed together. For example, the 
compensation can be assessed to check if any files possess a different matrix. 
In addition, any differences in the PMT voltages can be identified and reported 
to the user. 

To assess the metadata: 

• In the File Inspector, highlight the files to 
assess 

• Within QCLogic, tick the Metadata option 

• Select the checks to be performed 

• Choose to “Build report only” to create a 
statistical report without performing the actual 
extraction and generation of the subpopulation 

• Choose to “Display plots” to open the assessed 
plots in the workspace upon executing 

Here is one result showing files with different PMT voltages, along with the 
reported flow rate. Results are shown as differences to the first file as listed in 
the File Inspector.  

 

In addition to the readout in the QCLogic report panel, the identified differences 
are also added to the expandable window of the File Inspector, with the different 
attributes grouped by column with the keyword as the column title. The 
information contained within the File Inspector can be managed by right-clicking 
on the column titles and choosing from the menu items (see page 35 for more 
details). 
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PlateLogic – data array analysis 
 

PlateLogic has been designed to assess large amounts of data, such as plate 
data, utilizing a plate layout. Highlighted FCS files can be dragged from the File 
Inspector and added to a plate, where a heatmap is automatically generated. 
Various statistics can be calculated, and tags can be applied to the analyzed 
files, allowing for the easy identification of samples with a specific 
characteristic. In addition, FCS data can be passed directly to GraphLogic in 
the format that they are arranged in a plate. This process does not rely on the 
selection of a gate or statistic in PlateLogic as the whole process is performed 
in GraphLogic. 

 
To create a plate, click in the plate window and select New PlateLogic. To fill 
the plate, highlight a group of files in the File Inspector and drag them into the 
desired well in the plate. Continue filling the plate with all groups of files. It does 
not matter which gate or level of the gating hierarchy is selected and dragged 
into the plate as only the sample is recorded. Once in the plate, the specific 
subpopulation (gates) can be set and analyzed. It is also possible to add the 
same sample to multiple wells. If the same sample is added multiple times, 
each copy can be assigned to a different data set, with each dataset set to 
display a different level of the gating hierarchy. 
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Once all files have been added to the plate, use the functions in the Plate Side 
Drawer to help analyze the samples. 

 

 
 
 
Here is an explanation of the features and elements located in the Data Array 
tab: 
 
 

Plate list window – the Plate List window, located to the left of the plate 
workspace, displays all plates that have been created. To create a new plate, 
right-click within the window (but not on an existing plate) and choose New 
PlateLogic. 
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• Right-clicking on an existing plate name opens a different menu, with 
features to help manage the plates. 

 

 
 
 
• Select – the select option is used to highlight specific plates in the Plate List 

window. The two selection options are All and Inverse. Clicking Select → All 

will highlight all the plates in the window. Select → Inverse will select all 
plates that were not highlighted, while deselecting all that were. 

• Rename – select ‘Rename’ to access a field where a new plate name can 
be entered. 

• Copy Settings – once a plate has been setup to suit the specific analysis, 
the settings from that plate can be copied and pasted onto another plate. 
Simply highlight the plate name, right-click and choose Copy Settings. This 
copies the settings to the clipboard. 

• Paste – once a plate’s settings have been copied, right-click the new plate 
and click Paste, followed by one of the following options: 

 

 
 

 
• Settings – will paste the plate settings to the selected plate. 

• Settings Except Parameter – will paste the plate settings to another 
plate except for changes made in the Parameter field of the Heatmap 
Settings tab. 
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• To All – will paste the settings copied from one plate to all listed plates 

• Heatmap Only – will only paste settings associated with the heatmap. 

• Heatmap Only to All – will paste the settings associated with the 
heatmap to all other plates. 

 

• Open – highlighting a plate or plates in the Plate List window, right-clicking 
and selecting Open will open the plates in the plate workspace. 

• Close – highlighting a plate or plates in the Plate List window, right-clicking 
and selecting Close will close all plates in the plate workspace.  

• Delete – highlighting a plate or plates, right-clicking and selecting Delete will 
open a window asking if you wish to delete the specified plate. If confirmed, 
the plate will be deleted. 

 

 
 

• New PlateLogic – this will create a new plate in the same way as selecting 
New PlateLogic after right-clicking in the Plate List window. 

• Clone Plate – Highlighting a plate, right-clicking and selecting Clone Plate 
will create a copy of the selected plate and assign it the next available name. 

• Overlay Selected – if two or more plates exist with FCS files that match 
(parameters and gates), then overlay plots can be created for all 
corresponding wells. So, the samples existing in well A1 will all be overlaid 
on one plot, while the next will be an overlay of all samples in well A2, etc. 

• Build Parameter Combinations – highlighting a plate and selecting Build 
Parameter Combinations will result in a plate being created for every 
parameter contained within the FCS file. The parameter will then be set in 
the heatmap settings tab. If a parameter-dependent statistic is selected, 
then each plate will have a different result displayed in the statistics tab in 
the plate side drawer. 

• Export Plots – highlighting a plate in the Plate List tab and selecting Export 
Plots will open a window allowing the heatmap (plate view) to be saved as 
one of six different file types, as shown: 

 
 

 



 130 

If multiple plates are highlighted when Export Plots is clicked, then each 
heatmap will be saved once after another. 

 

• Copy Plots – in computers running Microsoft Windows, the plate image will 
be copied to the clipboard. 

• Re-sizer – the re-sizer tool, located below the Plate List window, can be 
used to increase and decrease size of all plots open in the Data Array 
Workspace together. If one or more plates have been re-seized manually 
by clicking and dragging the bottom right-hand corner of the plate, the re-
sizer tool will return all plates back to the same size. 

 

• Plate display window – plates are displayed in the Plate display window in 
a similar fashion to plots in the Workspace. The arrangement of plates in 

the display window can be optimized by clicking Edit → Plate Arrangement 
(see the topic about the Edit menu for more details). 

 

 
 

• Plate side drawer – each plate has a plate side drawer, which can be open 
by clicking the button in the top left-hand corner of the plate or by selecting 
the plate and pressing the space bar. Tabs are located at the top of the side 
drawer, containing a range of different display and analysis functions. 
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The plate side drawer tabs are as follow: 
 

 
 
Plate Setup – set up the plate to best represent the design of your experiment. 
By default, the setup represents a 96 well plate. 
 

• Plate Dimensions – set the width and height of the plate (number of wells) 
by typing in a number into the field or by using the up and down arrows. The 
plate will update in real time. 

• Width – the width determines the number of columns. 

• Height – the height determines the number of rows. 

• Fill Direction – the fill direction determines where samples will be 
automatically placed when either imported one after the other or when a 
selection is imported at once.  

• Horizontal – horizontal fill direction means that samples will continue to 
fill up an entire row before moving to the second. E.g. sample one will 
be placed in well A1 and sample two in A2, etc. 

• Vertical – vertical fill direction means that samples will continue to fill up 
an entire column before moving to the second. E.g. sample one will be 
placed in well A1 and sample two in B1, etc. 

• Well Shape – choose to display the wells as circles, squares, large 
squares or fill. 
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• Numeric Axis – choose to have either of the axes labeled numerically. If 
the numerical option is not selected, the wells will be labeled 
alphabetically. In most cases, it is best to have one axis labeled 
numerically and the other alphabetically. 

 

• Display Settings – the display setting options allow the viewing of different 
levels of the hierarchy, depending on the type of statistic that is being 
viewed. 

• Non-Parametric Statistic Selected – these are the statistics that are not 
related to the parameters where the gates have been created, such as 
event count and % parent. In many instances, it may be desired to view 
the statistics in relation to the parent plot. That is, if a gate is drawn, 
viewing the gate on the parent plot rather than the resulting daughter plot 
provides more information. The three different options are:  

• Display Selected Level 

• Display Parent 

• Display File 

• Parametric Statistic Selected – these are the statistics that are related to 
the parameters where the gates have been created, such as the mean 
fluorescence. In many instances, it may be desired to view the statistics 
of the populations resulting from a gate. The three different options are: 

• Display Selected Level 

• Display Parent 

• Display File 



 133 

• Mirror datasets on Insert – this feature, when enabled, creates datasets 
in the plate that match groups from the File Inspector. The group color 
is applied to the matching dataset. Datasets are groups of 
wells/samples. Individual datasets can be modified without impacting 
other wells in the plate. For example, the same 5 files can be added to 
a plate three times, each in its own dataset. If there are a few gates 
associated with the files, then each dataset can be set to a different level 
of the hierarchy and/or statistic. 

 

 
 

• Insert In Plate Order – samples are added to the plate in the order of A1, 
A2, A3, etc. 

• Dataset Settings – the datasets can each be modified in terms of 
representative color and name. Comments or descriptions can also be 
added for each dataset. 

• C (color) – to change the dataset color, click on the color in the ‘C’ 
column and choose a new one from the options provided. 

• Name – double-click on the dataset name to type in a new one. 

• Comment/Description – double-click in the comment/description field 
to add a note relating to the dataset. 

• Delete Dataset – to delete a dataset, highlight the dataset by clicking on 
its name and click Delete Dataset. This will delete the dataset but not 
the files in the wells. 

• Synchronize Datasets – if FCS files are placed in groups in the File 
Inspector after they have been added to the plate, synchronizing the 
samples will create datasets based on the groups in the File Inspector. 
The result is the same as with mirrored datasets. 
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• Heatmap Settings – the heatmaps generated in the plate can be set up in 
the heatmap settings tab. Heatmaps are modified for each dataset 
individually. 

• Dataset name – defined datasets are listed at the top of the Heatmap 
Settings tab in the side drawer. To edit the heatmap settings for a 
dataset, click on the dataset name prior to changing the settings. 

 
 

 
 
 

• Heatmap and Plot Display Settings 

• Gate – choose the population that you wish the data array feature to 
take the settings from to create the heatmap. Click on the Gate drop-
down menu to select the population by gate name. 

• Stat – click the statistic drop-down menu to choose the statistic that 
you wish the heatmap to be generated for. The statistics available 
are: Mean, GeoMean, StdDev, CoefVar, RCoefVar, %Total, 

%Parent, Event Count, %Selected, RStdDev, Cells/ml, Cells/. 

• Parameter – for statistics that refer to a particular parameter, such as 
the mean, choose the parameter from the parameter drop-down 
menu. 

• Advanced Statistics 

• C – the color for each range in the heatmap can be changed by 
clicking on the color in the in the column titled ‘C’. 

• A (bottom of range) – this column shows the value defining the 
bottom end of the range and can be changed by double-clicking 
within the filed in the column labeled ‘A’ and typing a new one. 

• Type – this is the rule defining each particular range in the 
heatmap, in relation to the values in columns ‘A’ and ‘B’. The type 
options are: 
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• Less than A 

• Less than or Equal to A 

• Greater than or Equal to A 

• Equal to A 

• Greater than or Equal to A and Less than B 

• Not Greater than or Equal to A and Less than B 

• B (top of range) – this column shows the value defining the top end 
of the range. The value can be changed by double-clicking within the 
filed in the column labeled ‘B’ and typing a new one. 

• Right-click on a heatmap range to open a window with options to add a new 
range by inserting it before the selected range, after a selected range, delete 
a range or copy a range. Selecting copy range will add a copy of the 
selected range immediately after the copied range. If Set Automatic 
Heatmap is enabled, the range associated with the new copy will be 
recalculated. If Set Automatic Heatmap is not enabled, the range associated 
with the new copy will be the same as the range that it was copied from. To 
apply changes made to the heatmap settings for one dataset to another, 
click Apply to Dataset and select the dataset from the options. Click Table 
Setup to change the font and number of decimal places displayed in the 
heatmap setting table. 

•  
 

 
 
 

• Set Automatic Heatmap – when this option is selected, a heatmap 
will automatically be generate when samples are imported into a 
plate. The values for columns A and B cannot be edited if Set 
Automatic Heatmap is enabled. 
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• Statistics – the statistics tab displays statistics that have been created in 
the Heatmap Settings tab. There are two table formats: 

• Statistic Table 1: table matches that in the plate setup tab. 

 
 

• Options at the bottom of the window allow the statistics to be colored 
based on the dataset or on their value where the colors match those 
from the heatmap. Both color options can be applied to the background 
(coloring the cell, not the text), the foreground (coloring the text, not the 
cell) or the background for one and the foreground for the other. 

 
 

 
 

• Right-click on the table opens a window allowing the statistics to be 
saved as a CSV file. 

• Selecting Table Setup allows for the font and number of decimal places 
to be changed. 
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• Statistic Table 2: the data is set out in columns. The columns in Statistic 
Table 2 are Pos (plate position), Name, Param (parameter), Stat 
(statistic), Value, Comment 1 and Comment 2. Double-click in the 
Comments columns to make notes related to specific samples. 

• The same dataset and coloring options are available for Statistic Table 
2 as described for Statistic Table 1. 

 

 
 
 

• Clicking on the dataset names above the table will display the results for 
the individual datasets in the same format as Statistic Table 2. 

• The results in Statistic Table 2 can also be set to show an individual 
dataset by right-clicking on the table, selecting Show and selecting the 
desired dataset. Right-clicking, selecting Show and All will display all of 
the datasets. 

• The results in Statistics Table 2 can also be sorted into ascending or 
descending numerical order by right-clicking in the table, selecting Show 
and Sort Ascending or Sort Descending. Selecting No Sort (when a table 
has been sorted) will return the results back the sample order. 
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• Right-click in the dataset table to: 

• Export Plate Statistics - opens a window allowing the statistics to be 
saved as a .csv file. 

• Copy from a Cell 

• Paste to Cell(s) 

• Sort: No Sort, Sort Ascending, Sort Descending 

• Table Setup: Change Font, choose number of decimal places 
 

 
 
 

• Plot Viewer – the Plot Viewer tab allows the histogram or dot plot for each 
individual well to be inspected. Simply hover over the well in the plate to 
view the dot plot in the side drawer. The population displayed is determined 
by the setting in the Plate Setup tab under the Display Settings. The 
parameter to be displayed is determined by the settings in the Heatmap 
Settings tab. 

• Right-click: Remove Control – samples can be set as controls for data 
arrays by right-clicking on the samples in the File Inspector and choosing 
Set as control. This will overlay the control in the plate when viewing the 

plots in the Plot Viewer tab in the plate side drawer. Right-click → 
Remove Control removes control from the Plot Viewer tab when 
inspecting the wells. 

• View Histo – with this option selected, hovering over the wells will display 
a histogram. 

• Fill – with this option selected, a displayed histogram will be filled. 

• The dot plot display option will mirror what is set when the dot plot is 
open in the Workspace. To change this, double-click on the well to open 
the plot in the Workspace. Then, choose from a new plot display option 
from the Toolbar. The dot plot in the plate side drawer will be updated to 
reflect the selection. 
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• Advanced Functions – the Advanced Functions tab allows for 
comparisons between different parameters, gates and datasets. Choose an 
option to compare, select the two statistics and choose the action to be 
performed. The row should read like an equation, e.g. Gate 1 – Gate 2. 
When the equation is set, select the input dataset from the Ratio Input 
window and click Apply. This will create a new dataset with the result. The 
new data set will also be displayed in the plate itself. 
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• Plate Outlier Detection 

• Data can be viewed in relation to a quadratic curve (Q. Curve), linear line 
or an asymmetrical 5PL curve, with outliers represented by a hollow 
circle. Double-click on a circle to open the dot plot in the Workspace. 

• If multiple datasets are displayed on the same graph, normalize the data 
to so that they can all be viewed. 

• Pull up the drawer at the bottom of the graph for options to Add or 
Remove datasets. 
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• Dilution Table – a dilution table saved as a .csv can be imported by right-
clicking in the side drawer under the dilution table tab and selecting ‘Load 
csv’. 

 

 
 
 

• BeadLogic Export – wells can be defined as Standards, Blanks, 
Unlabeled, Unknowns and Controls before exporting to Beadlogic for 
multiplex analysis. 
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• Plate options – right-click on a well 
 

 
 

 

• Select → allows the quick selection of groups of wells in a plate: 

• All – right-click anywhere in a plate and choose ‘Select’ → ‘All’ to 
highlight all wells. 

• Extend Horizontally – highlight a well from one or more rows, 

right-click and choose ‘Select’ → ‘Extend Horizontally’ to select 
all wells in the highlighted rows. 

• Extend Vertically – highlight a well from one or more columns, 

right-click and choose ‘Select’ → ‘Extend Vertically’ to select all 
wells in the highlighted columns. 

• Dataset → to select all samples from a particular dataset, right-

click anywhere in the plate and choose ‘Select’ → ‘Dataset’ → 
and choose the dataset by name. 

• Inverse – an inverse selection is useful if you wish to exclude a 
relatively small number of wells. To make an inverse selection, 
highlight the wells to be excluded (using the options described 
above or by selecting them with the mouse), then choose ‘Select’ 

→ ‘Inverse’. 

• None – to clear all selections, right-click anywhere in the plate 

and choose ‘Select’ → ‘None’. 
 

 

• Datasets – individual datasets can be manipulated separately, allowing the 
same group of samples to be imported multiple times into a single plate but 
analysed independently (e.g., different gates or stats of the same files in the 
one plate): 

• Add to new dataset – adds the selections to a new dataset. 

• Add to new dataset (horizontally) – creates a new dataset for 
each row in the plate. 

• Add to new dataset (vertically) – creates a new dataset for each 
column in the plate. 

• Dataset (set/delete) – deletes the dataset but samples remain in 
the plate. 
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• As Overlay will create overlays based on the specific selection of wells: 

• Selection – creates a dot plot overlay of the samples highlighted 
in the plate. 

• Selection (Horizontal) –creates an overlay containing all samples 
that exist in the same row as the selected well. 

• Selection (Vertical) – creates an overlay containing all samples 
that exist in the same column as the selected well. 

• Dataset → creates an overlay containing all samples that exist in 
the same dataset as the selected well. 

 

• As Plot opens a dataset or selection of files as dot plots in the Workspace, 
either from the selection of individual wells or datasets. 

 

• Clear will clear all files from within selected wells. This does not delete the 
dataset: 

• All – deletes all samples from the plate 

• Selection – deletes the selected samples from the plate 

• Dataset → deletes the samples contained within a dataset. 
 

• Delete will delete an entire row or column from the plate. 

• Selected Row(s) – deletes the selected row or rows and all data 
contained within them. 

• Selected Column(s) – deletes the selected column or columns 
and all data contained within them. 

 
 

• Export a plate by either saving it as a file or copying it to the computer’s 
clipboard. 

• To File – opens a window allowing the plate to be saved as one 
of a number of image file types. 

• To Clipboard – copies the image of the plate to the computer’s 
clipboard to be pasted elsewhere. 

 
 

• Compensation displays differences in compensation matrices. The top 
corners of each well are colored. The left-colored corner represents the 
original compensation matrix. If this is the same in multiple wells then they 
all have the same original matrix. The right corner represents a post-
acquisition change in compensation. If the two corners of a well are different 
it indicates that the compensation has been changed. Compensation 
matrices can be copied from one file in the plate and pasted onto another. 

• Show Comp Matrix – colors the corners to depict the applied 
compensation 

• Copy – copies the compensation matrix from a selected 
well/sample. 

• Paste → All/Selection – applies the copied compensation matrix 
to a selection of samples or to all within a dataset. 
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• Show plots displays each file as a dot plot. There are additional options to 
color the dots to match the heatmap colors, to color the background to 
reflect the different datasets and a combination of both. 
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Building Plates from the File Navigator 
Plates (data arrays) can be created directly from the File Navigator for all files 
contained in an experiment folder. This is particularly useful if you wish to 
display each gated population, as depicted in the population hierarchy) as a 
separate dataset. This enables all plots in the experiment to be displayed in the 
plate view. 
 

Set Statistics 
The set statistics tab is in the Advanced Functions is where the type of statistics 
to be calculated is set to display in the View Statistics tab. 
 

• Highlight the files in the File Inspector for which to calculate statistics. If files 
are contained in a group, selecting one of the grouped files will result in 
statistics being calculated for all files in the group. 

• Open the Advanced Functions drawer and tick the boxes that correspond to 
the populations/gates. The statistics are separated into two windows. The 
left-hand window displays statistics that are linked to the selected files in the 
File Inspector. The right-hand window lists parameter-specific statistics that 
are linked to populations highlighted in the Populations column in the left-
hand window. In the example that follows, the mean fluorescence will be 
calculated for the Pacific-Blue-A and Pacific-Orange-A parameters on the 
CD8+ population only. If multiple populations are highlighted in the 
Populations column prior to selecting a statistic in the right-hand window, 
then the parameter-specific statistic will be calculated for all selected 
populations. 
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• Population statistics include Number of Events, % Of Total, % Of 
Parent, % Of Selected, along with data contained in the keywords: 
CELLS, SRC and TAGs. 

• % Of Selected means that a specific population can be shown as a 
percentage of any other population higher in the hierarchy, not just 
the parent (one level higher in the hierarchy) or total (the top level in 
the hierarchy). To define the selected population, click in the column 
in the row that corresponds with the gate of interest. Then, from the 
drop-down menu, choose the selected population. 

• The parameter statistics include the mean fluorescence (Mean), 
geometric mean fluorescence (GeoMean), median fluorescence 
(Median), standard deviation (StdDev), coefficient of variation 
(CoefVar), robust coefficient of variation (RoCoefVar) and robust 
standard deviation (RoStdDev). 

• Double-clicking on the column title will tick all boxes in that column. 

• The columns in both windows can be reordered by dragging 
the header 

• Double-clicking on the parameter title in the right-hand window will 
tick all statistics for that parameter. 

• To view the calculated statistics, click on the View Statistics tab in 
the Advanced Functions drawer. 
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View Statistics 
• Once statistics have been set in the Set Statistics tab, click on the View 

Statistics tab to display the statistics tables. 

• Right-click on the table to copy, export or change the table setup. 

• Within the View Statistics table, the settings for specific statistics 
can be copied and pasted from one file to another (or multiple). 
For example, if statistics for one file have been calculated, 
highlight that file in the table, right-click → Copy Statistic Settings, 
highlight remaining files in the View Statistics table, right-click → 
Paste Statistics Settings. All statistics calculated for the first file 
will then be calculated for all remaining files. 

 

 
 
 

• To clear the statistics, right-click in the File Inspector and choose Delete → 
Delete all statistics. 
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Parameters 
• All parameters are listed in the Parameters tab. 

• Custom Labels can be changed by double-clicking in the field and typing 
the new name. Display the custom labels on plots by selecting to display 
Custom Labels in the program preferences. 

 

 
 

 

 
 
Virtual parameters can be created by selecting an input parameter followed by 
an operation and another input parameter or value. Click ‘Add’ to create the 
new parameter. To delete a virtual parameter, select the parameter in the 
‘Parameter’ drop-down list and click ‘Delete’. 
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CompLogic – Auto-compensation 
FlowLogic can perform auto-compensation given appropriate single-color 
controls. 

• From the Advanced Functions drawer, select the CompLogic tab. From 
the samples list on the left of the drawer, select your single-color controls 
then click ‘Set FCS’. 

• In the parameters box highlight the parameters that you want to 
compensate and click ‘Set Parameters’. The boxes in the ‘Auto’ column 
will be ticked. 

 

 
 

 

• In the parameters box highlight the parameters that you want to 
compensate and click ‘Set Parameters’. The boxes in the Auto column 
will be ticked. 
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• Verify that the suggested file listed in the FCS Files column matches the 
parameter as shown in the Parameters column. If not, click on the FCS 
file title and choose the matching FCS file from the available options. 
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• When you have matched the FCS files and parameters click ‘Set Gates’. 
FlowLogic will create a FSC-A vs. SSC-A plot with a polygon gate and 
the daughter population histogram for each parameter. The polygon gate 
itself, will automatically detect the population of greatest density. Adjust 
the polygon and histogram markers to select the negative and positive 
populations. 

 

• To make viewing easier, change the number of windows displayed per 

row to two. Click Edit → Plot Arrangement → Number of Windows → 2. 
 

 
 

• When all gates have been corrected, click Compensate. FlowLogic will 
then calculate the compensation matrix. 

 

• The newly calculated compensation matrix will be displayed. You can 
now save the compensation matrix or apply it to all samples within a 
folder with one click. 
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• The MFI is calculated for the positive and negative populations in all 

spillover channels. A line is subsequently drawn connecting these two 
values. A horizontal line indicates correct compensation. 
 

• The original compensation created at acquisition remains saved with the 
file and can be re-applied at any time. 

 

• Auto-compensation can be performed as many times as you wish. 
 

• The compensation for each individual file can be checked by opening 
the appropriate dot plots. Fine adjustments can be made in the plot side 
drawer and the new matrix saved and applied to all other files. 
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In the CompLogic window, tick ‘Full Display’ to view all events on each plot. 
Unticking ‘LogScaled’ will revert the axis to a logarithmic scale for all plots. 
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Metadata 
Each FCS file has associated metadata that can be viewed in this tab. 
 

• A specific metadata keyword and its associated value can be added to the 
File Inspector table for each sample. To add the keyword to the File 
Inspector, right-click on the specific row and choose ‘Add Custom Field’. 

• To remove a keyword from the File Inspector, right-click in the Metadata 

table and select ‘Remove Custom Field →’. 

• Use the Search field at the top of the pull-up drawer to search for specific 
items within the metadata. 

 
 

 
 
 

Compensation 
The compensation matrix for each FCS/MQD file can be viewed in this tab. 
 

• To view a compensation matrix, highlight the FCS/MQD file in the File 
Inspector. The matrix will automatically be displayed. 

• Right-clicking on the matrix will provide an option to export the matrix as a 
TXT file. 

 
 
Cell Cycle, Proliferation, Curve Fit and Kinetics Tabs 
These tabs provide statistical summary tables from the Cell Cycle, Proliferation, 
Curve Fit and Kinetics features. Statistics can be exported from the tables by 
right-clicking within the table and choosing the export option. This data can also 
be imported directly into GraphLogic by right-clicking in the Workspace and 
choosing to add the table related to the specific analysis type. 
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GraphLogic – Graphing and Statistical Analysis 
 

Overview 
GraphLogic enables the graphing and statistical analysis of data derived from 
FCS/MQD files. All sections in FlowLogic are linked, so any adjustment to gates 
in GateLogic will automatically update the graphs and statistics tables in 
GraphLogic. 
 
Below is an overview of the GraphLogic window.  

• The panel on the left contains the File Navigator with three tabs: 
GateLogic (dot plots, histograms and overlays), PlateLogic 
(plates/heatmaps) and statistics (the table as exists in the ‘View 
Statistics’ tab of the Advanced Functions pull-up drawer).  

• Selected elements from the File Navigator can be dragged directly into 
the Workspace Spreadsheet at the bottom of the window. After adding 
files to the spreadsheet, the gate/population and related statistic can be 
defined. Data tables can be dragged into Table folders to the left of the 
spreadsheet. From here, graphs can be displayed in the Graph 
Workspace at the top of the window and statistical analyses can be 
performed in the analysis pull up window.  

• Clicking on specific parts of a graph (bars, axes, labels, titles, etc.) 
displays the corresponding Formatting Panel on the right of the screen. 
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The GraphLogic File Navigator 
 

 

 

Selecting the GateLogic tab will display all of the FCS/MQD files. The 
appearance is similar to the File Inspector in GateLogic, except that the 
gates/subpopulations are hidden and there is no right-click menu. This is 
because files are added to the spreadsheet where the population and statistic 
is defined. It is possible to display the gates by ticking “Show Gates” above the 
Workspace folders. 

 

 

For more detail about adding files to the spreadsheet, see page 159. 

Show Gates – by default, gates are hidden and only the file name is displayed. 
In GraphLogic, it is generally only necessary to view the files themselves, with 
the ability to show gates only necessary to be reminded of the gating hierarchy 
without having to click back to GraphLogic. 
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Workspace Folders 
 

 

 
Data existing in the Workspace arranged within graph templates (see page 
159) can be dragged and dropped into Table folders from which graphs are 
automatically generated and displayed in the Graph Workspace. Statistical 
tests can also be performed on data in the graph table folder in a few easy 
steps. As the FCS derived data in the tables remains linked to GraphLogic, all 
graphs and statistical analyses are updated automatically. Data can also be 
imported from CSV files or typed directly into the spreadsheet. Data contained 
in the Workspace can also be exported as a CSV file or as a MS Excel (.xlxs) 
file, with the latter exporting with all color and formatting. 
 
Right-click menu for the GraphLogic folder: 
The GraphLogic folder contains all subfolders. By default, one Workspace 
folder containing a Table folder with the associated Analysis and Graph sheets 
are created. Additional Workspace folders (with a table, analysis and graph) 
can be created by right-clicking on the GraphLogic folder, followed by ‘Add 
Workspace’. 

 

Right-click menu for the Workspace folder: 

 

Workspace folders can be renamed using the first option in the right-click menu. 
Additionally, new Table folders can be added to a single Workspace folder. In 
this way, multiple graphs can be generated, and statistics test performed from 
all of the data in one Workspace spreadsheet. 

There is also an option to clone a given Workspace and all of its subfolders. 
This can be very useful if you have a lot of formatting and calculations in one 
Workspace that you wish to duplicate and then replace the data. Once a 
Workspace has been cloned, the data can be deleted and new files or values 
can be imported.  

Finally, a Workspace can be deleted or removed using the last option, ‘Remove 
Selected’, in the right-click menu. 
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Right-click menu for the Table folder: 

 

When FCS files are dragged into the Workspace, the naming template is 
automatically created around the data. When this same data is dragged into a 
Table, the Table folder name will take the name in the ‘Table’ cell form the 
Workspace. However, if you are importing non-FCS data, you have removed 
the ‘Table’ name from the Workspace or you wish to change it, this can be done 
from the ‘Rename’ option in the right-click menu. 

Tables can also be cloned. This is useful if you have formatted graphs and 
performed particular statistical tests. The easiest way to replicate this is to clone 
a Table and then drag the new data into the clone. This will then update all 
current graphs and statistics. 

As with Workspaces, individual Table folders can be deleted by right-clicking 
on the desired folder and choosing ‘Remove Selected’ from the menu. 

 

Right-click menu for the Analysis and Graph icon: 

 

The analysis and graph can be renamed to help with identification. Renaming 
is particularly useful when adding elements to a DocLogic report. 

 

Workspace Spreadsheet 
The Workspace spreadsheet can accept FCS data, which remains linked to the 
original gates so that any adjustments in GateLogic are automatically updated 
in the GraphLogic spreadsheet. In addition, non-FCS data can be imported 
from CSV files, and numbers and text can be typed directly into the cells. 

Common editing features exist, allowing cells and text to be colored, the 
merging and splitting of cells, changing the font type, style and size, changing 
text and number alignment within cells and selecting the number of decimal 
places to be displayed. A detailed description of each of these features can be 
found from page 169. 
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Mathematical functions can be applied to any data in the Workspace, such as 
adding, subtracting, multiplying or dividing one cell by another. The equation 
defining the calculation can be created in the formula field above the 
Workspace or directly in the spreadsheet. For example, to add the values in 
cells A1 and A2, type “=A1+A2” and then press enter. 

 

Adding FCS-linked Data 
The feature that makes the GraphLogic Workspace so useful is the ability to 
drag in FCS files, or import files contained in a plate, and then display any gate 
or parameter statistic using the drop-down menus at the top of the Workspace. 
Data can then be dragged into a Workspace Table, which automatically 
generates a graph. Statistical analyses can also be performed with a few clicks. 
In addition, FCS-linked data in the spreadsheet can be duplicated and set to a 
different gate or parameter statistic whilst maintaining all other generated 
graphs and tables. 
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When FCS files are dragged into the Workspace, a template is automatically 
created with titles for the Table (dataset) name, the experimental group names 
and the sample count. 

• Table name: the table name refers to the table containing the dataset that 
the associated graph is derived from. For example, this could be 
Lymphocytes %Parent. 

• Group names: the group name relate to the experimental groups, which are 
reflected as separate bars in a bar graph, for example. This is unrelated to 
the groups created for group analysis. In the same example, there might be 
two groups: treatment and control. 

• Sample number: this refers to individual samples within each experimental 
group, or the n value. 

 

 

 

The linked data exists in the red border above. Highlight these cells and choose 
a population and statistic from the toolbar above the Workspace. Graphs can 
be created by highlighting the entire data table (within the green border) and 
dragging it directly to a Table folder in the window to the left. The table name 
and group names will automatically be applied to the Table folder and graph, 
respectively. Updating these names in the Workspace after the data has been 
added to the table will update the table folder and the groups in the graph. 
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Selecting gate and parameter statistics 
When FCS files are dragged into the Workspace, by default the value for each 
sample will be 100.00, relating to the %Parent, All Events.  
 
Use the drop-down windows above the table to select the population (gate) and 
the type of statistic (event count, %parent, %total, mean, etc.) to graph. Finally, 
you can specify the number of replicates performed. 
 

 
 
Importing PlateLogic Data  
An alternative method for adding FCS-derived data into a GraphLogic 
Workspace is to import files that are already arranged in plates within 
PlateLogic. Files that have been imported into a plate in PlateLogic can be 
added directly to the Worksheet in GraphLogic by selecting the desired plate 
from the list of plates under the PlateLogic tab in the File Navigator. The data 
will be imported into the Worksheet in the same arrangement as the files exist 
in the plate. Files can be added to a plate before gating or at any time after 
gates have been created. 
 
There is no need to define the statistics in PlateLogic as the selection can be 
made in GraphLogic. The data remains linked to the gates in GraphLogic and 
so will update automatically if a gate is adjusted. The same ‘plate’ can be 
imported multiple times, or an imported dataset can be copied and pasted 
elsewhere in the Workspace. The data from either form of duplication can be 
changed using the drop-down menus to define a different population or statistic. 
When importing plate data, the table structure with a Table name, Group names 
and Sample counts will automatically be created in preparation for generating 
a graph. 
 

Once any of these datasets have been imported into a GraphLogic Workspace, 
the data can be rearranged for graphing and statistical analysis. Data imported 
via PlateLogic remains linked to the gates and so any adjustment to gates in 
GateLogic will update the data in GraphLogic. 
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Importing Statistics Tables  
In a similar way that PlateLogic data can be imported into a GraphLogic 
spreadsheet, other statistics tables can be selected from the statistics tables 
tab in the File Navigator and imported using drag-and-drop. The types of tables 
include: 

• The statistic table displayed under the View Statistics tab in the 
Advanced Functions pull-up drawer 

• The statistics tables in the PlateLogic side drawer 

• Cell cycle, proliferation, curve fitting and kinetics analyses statistics 
under the View Statistics tab in the Advanced Functions pull-up drawer 

If an adjustment is made to the gates used to derive the cycle, proliferation, 
curve fitting and kinetics analyses after importing into GraphLogic, re-import the 
data to display the updated values.  
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Add Cell Cycle, Proliferation, Curve Fit and Kinetics table data 
Data derived from Cell Cycle, Proliferation, Curve Fit and Kinetics analyses can 
be added to the GraphLogic Workspace by selecting the desired statistic table 
from the list of tables under the Statistics tab in the File Navigator, as described 
above. 

 

The Workspace Right-Click Menu 
 

 

 
 
Clear Selected 
Selecting ‘Clear Selected’ cells from the right-click menu after highlighting in 
the Workspace will clear all data, formulae, font formatting, cell alignment and 
color settings. 

Copy 
Cells can be copied, by highlighting and selecting ‘Copy’ from the right-click 
menu, and be pasted elsewhere in the same Workspace, in a different 
Workspace or into a Table folder. This process copies all data, formulae, font 
formatting, cell alignment and color settings. The original, copied data will 
remain after replicated data is pasted to another position in the Workspace. 

Cut 
The Cut function removes the data in the selected cells, along with all formulae, 
font formatting, cell alignment and color settings and pastes it to the specified 
destination. When pasted, the Cut data will overwrite all data and formatting in 
the location where they are pasted. 

Paste 
The Paste function adds the Copied or Cut data to a specified location in the 
same orientation. 

Paste Transpose 
The Paste Transpose function flips the orientation so that Row 1 becomes 
Column 1, Row 2 becomes Column 2, etc. Data can only be transposed within 
the Workspace and not into a Table folder. 
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Set Group Name → 
The group name for a data set can be set using several different references. 
This is achieved by selecting the cells containing the group titles to be renamed, 

right-clicking and selecting ‘Set Group Name’ → and one of: 

• Via Gate  

• Via Parent + Gate  

• Via CSV file 

 

 

Via Gate – This function is for data derived from FCS files that are dragged into 
the Workspace from the File Inspector or imported via a plate. To rename the 
Group, highlight the Group Name cells, right-click and select Set Group Name 

→ Via Gate. The Group name will then be updated with the gate name, which 
is displayed it the gate drop-down menu in the toolbar. 

Via Parent + Gate – This function is also for data derived from FCS files that 
are dragged into the Workspace from the File Inspector or imported via a plate. 
It functions in the same way as the ‘Via Gate’ option but adds the parent gate 
name before the population gate name. 

Via CSV file – This function allows groups to be named from a .csv file. Multiple 
Group Name cells can be named at once, as long as they are highlighted prior 
to naming. This feature can be very useful if the same experimental groups are 
used consistently over a number of analyses or experiments. 

It is important, however, to set up the .csv file in the correct format. The names 
in the .csv file need to be listed horizontally, with one name per cell if created 
in a spreadsheet or having each name separated by a comma if created with a 
text editor. However, FlowLogic will apply these names vertically, assuming 
each experimental group is displayed one on top of the next. In addition, only 
the selected number of Group name cells will be named, even if the list in the 
.csv file is longer. For example, if the names in the .csv file are ‘Group A’, ‘Group 
B’, Group C’, Group D’ and Group E’ but only two cells are highlighted in the 
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Workspace, only the names ‘Group A’ and ‘Group B’ will be applied. Similarly, 
if more cells are highlighted than names exist in the CSV file, not all cells will 
be renamed. 

It is also possible to set up a .csv file with spaces between the names. For 
example, here is a .csv file with a gap between ‘Group 2’ and ‘Group 3’: 

 

 

 

When cells A3 to A7 are highlighted and this .csv file is imported, the third 
name, corresponding to cell A5, is left blank. 
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Set Column Name → 
The column name for a data set can be set using several different references. 
The column name refers to the title above each sample, which are numbered 
by default. 

 

Select the cells containing the group titles to be renamed, right-clicking and 

selecting ‘Set Column Name’ → and one of: 

• Via Count 

• Via $SRC 

• Via $CELLS 

• Via TAG 

• Via CSV file 

Via $SRC – This function allows columns to be named from the $SRC keyword 
contained in the FCS file. This keyword can differ from cytometer to cytometer 
and can be defined at the time of acquisition with certain acquisition programs. 

Via $CELLS – This is another keyword contained in the FCS file. 

Via TAG – tags applied to a sample can be used to name the column titles. If 
multiple tags have been applied to a sample, these will all be listed in the 
column name. 

Via CSV file – naming columns via a .csv file works in a similar way to naming 
the groups. Select the column titles to be named, right-click and choose Set 

Column Name →Via CSV file. The names in the .csv file need to be listed 
horizontally and any spaces in the .csv file will result in a cell being missed in 
the Workspace. 
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Exporting Table 
The Workspace table can be exported as either a .csv file or Excel XML 
Workbooks (*.xlsx) file. The .csv export option will record all text and numbers 
in the displayed table format without any formatting. Formulae will not be saved 
in the .csv file, only the resulting value displayed in the cell. The .xlsx file will 
save all the text and numbers along with text and cell formatting, such as 
coloring, alignment within cells, font style/type/size and formulae. 
 
Importing Data from CSV Files 
Data saved in the .csv file format can be imported into the Workspace by right-
clicking in the destination cell and selecting ‘Import data via CSV’. 

Manually Adding Data 
Data can also be added to the Workspace by selecting a cell and typing text 
and numbers with the keyboard. 
 

 
Workspace Toolbar 
 
The Formula Field 
Formulae can be created to apply mathematical functions to selected cells. 
Addition, subtraction, multiplication and division of cells, typed values or a 
combination of both can be performed by defining the equation in the formula 
field in the toolbar above the Workspace. 

Examples of each of these situations are as follow: 

• To add the values in cells B3 and B4, select a destination cell (B6 in this 
example), then type “=B3+B4” and press Enter. Alternatively, type “=B3+B4” 
directly into the cell where the answer is to be displayed. 

    or   

 

• To add a series of numbers and display the result in one cell, select a 
destination cell, then click in the formula field and type the equation, e.g. 
“=1+2”. Then press enter on the keyboard and the result (3) will be displayed 
in the destination cell. 
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• To multiple a cell by a number (e.g. B3*100), select a destination cell (B5 in 
this example), then click in the formula field, click cell B3 and in the formula 
field type “*100”. Finish by pressing enter on the keyboard. The final value 
will be calculated and displayed in the destination cell. 

 

 

 
Much more complex formulae can be created using all combinations of 
mathematical functions (+, -, *, /). 

If a formula has been created based on the relationship between a specific 
selection of cells and numbers, it can be copied and pasted to a new selection 
of cells, with the formula in the new cells referring to cells with the same spatial 
relationship. To copy a cell, right-click in the cell and select ‘Copy’. Then, select 
the destination cells, right-click and select ‘Paste’. 

For example, if the formula in A3 is A1+A2, then copying A3 to B3 and C3 will 
result in: 

• A3=A1+A2 

• B3=B1+B2 

• C3=C1+C2 
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Coloring Text and Cells 
Color can be applied to cells and text in the Workspace spreadsheet. This can 
be achieved using the icons in the toolbar. Each function (background color and 
foreground/text color) has two associated icons: select color (the colored 
rectangle icon) and apply color (drop icon for cells and ‘A’ icon for text). 

 

 
To color the cell (background), highlight the cells to be colored and click the 
background color selection icon. This will open a color palette. Click to choose 
the desired color and then click ‘OK’. This will apply the chosen color to the 
highlighted cells. You will notice that the Select Color and Apply Color icons 
have taken the most recent color choice. To continue filling cells with the same 
color, simply highlight the cells and click the Drop icon. 
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The same process applies to coloring text within cells. Text is colored black by 
default but to change the text color, highlight the desired cells and click the 
select color icon next to the ‘A’ icon. Choose a color and click ‘OK’. The ‘A’ icon 
is now colored with the most recent selection. To continue to color text with the 
selected color, highlight the desired cells and click the ‘A’ icon. 

 

 

 

Split and Merge Cells 
Multiple cells in the Workspace can be merged to form a single larger cell and 
merged cells can be split back into their original components. To merge or split 
cells, highlight them in the Workspace and then click the appropriate button in 
the toolbar. 

 

 

Cells running horizontally, vertically or a block spanning a number of columns 
and rows can be merged (are subsequently split). 

 
Text Alignment 
Text can be aligned to either the left, centre or right of a cell using the three 
icons in the toolbar. To change the alignment, select the cell(s) and click on the 
appropriate icon. 
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Font Settings 
Three font setting options can be accessed in the toolbar, being the font type, 
size and style. To change the font settings, highlight the cells in the Workspace 
and select from the different options in the font settings drop-down menus. 

 

Decimal Places 
The number of decimal places that are displayed in individual cells can be set 
by selecting the cell(s) and choosing an option ranging from no decimal places 
through to ten. Individual cells within the same Workspace can be set to display 
different numbers of decimal places. 

 

 

Population Statistic Menus 
The population statistics menu allows for the selection of specific gate and 
parameter statistics to be displayed for a single FCS sample, or a group of FCS 
samples, that have been dragged into the Workspace. 

To define a statistic, highlight the cell or cells containing data derived from an 
imported FCS file and select the desired gate, statistic and parameter (if 
applicable). The value in the cell will update to reflect the defined statistic and 
can be changed to any other statistic without having to re-import the sample. 
The statistics will also update following any changes or adjustments to the 
defining gates in GateLogic. 

The Population Statistic Menus can also be used to verify the statistic in a 
selected cell. Clicking on any cell containing FCS-derived data will prompt the 
three population statistic menus to display the gate, statistic and parameter for 
that cell. If multiple cells containing different statistics are selected, the display 
in the menus will reflect the first cell in the selection. 

 

For more information regarding importing and displaying FCS-derived data, see 
page 159. 
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Defining Replicates 
If values from all technical replicates have been imported, the number of 
replicates can be defined with the average of the technical replicates being 
displayed in merged cells. 

 

Gate/Value Display 
The Gate/Value Display function allows the for the gate name linked to the 
gate/parameter statistics to be displayed within the cells instead of the statistic 
itself. This can be useful if you wish to check the origin of a selection of cells 
without having to click on the cells one-by-one to view the gate in the Population 
Statistic ‘Gate’ menu. 

To change the information displayed in the cells, select them in the Workspace 
and choose the desired option in the Display drop-down menu. 

 

 

Adding Data to a Table Folder for Statistical Analysis and 
Graphing 
 
When data exists in the Workspace within the data template as shown below, 
it is very easy to add it to a Table folder in order to perform statistical analyses 
and graph. Simply select the data (not the Group or column names) and drag it 
into a Table folder. When you release the data on top of the table folder, choose 
either to ‘Replace’ the existing data (even if the table folder is empty) or 
‘Overlay’, which allows for overlaying of regression curves.  

 

The Table folder will be automatically renamed the dataset title and the groups 
in the graph and statistical analyses will be named automatically renamed from 
the group names in the Workspace.  
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Performing Statistical Analyses 
 

 
 

• After data has been added to the data table (see page 159), select a 
statistical analysis sheet. This opens the Analysis window. The workspace 
from where the data originates can be viewed by selecting the Workspace 
in the Graph Data window or by clicking on the Table folder associated with 
the particular analysis sheet. 

 

• To perform a statistical test, select the experimental groups to analyse and 
the specific statistical analysis test (and post-test if applicable) from the 
drop-down menus. 

 

 
 

• The result will be displayed in the Description and Analysis columns 
adjacent. 
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Analysis Groups 

• t test (parametric and non-parametric) 

• ANOVA (parametric and non-parametric) 

• Simple statistics 

• Regression analysis 

Analysis Type 

• Unpaired t tests with Welch-Satterthwaite approximation 

• Unpaired t test 

• Unpaired t test equal variance 

• Paired t test 

• Mann-Whitney 
 

• One-way analysis of variance 

• Kruskal-Wallis test 

• Two-way analysis of variance 
 

• Linear regression 

• 4 PL 

• 5PL 
 
Post Analysis Type 

• Bonferroni 

• Tukey 
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Two-way ANOVA and Automatic Stars of Significance 
 

GraphLogic can also display graphs with two independent variables. This 
requires merging the cells above the column counts to define the second 
variable. In addition, stars of significance and be automatically added to these 
graphs after performing a two-way ANOVA with a Bonferroni multiple 
comparisons test. 

 

Data Table Structure for the Two-way ANOVA   
When dragging files into the GraphLogic workspace, experimental groups are 
defined by rows. However, it is also possible to define a second independent 
variable within a row by merging the cells above the column count for an entire 
experimental group. The resulting table can be analysed using a two-way 
ANOVA. 
 
The example below shows two groups from one timepoint. 
 

 
 
 
When there is a second independent variable, add the data immediately to the 
right of the existing data. Then, merge the cells above the column count for the 
groups by highlighting the cells and clicking the Merge Cells icon in the toolbar. 
Type the group name into the merged cells. Finally, select the whole table and 
drag it into a Table Folder. 
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The final table and resulting graph are as follows: 
 

 
 
 
Performing a Two-way ANOVA 
With the data organized as described in the section above, drag the entire data 
table from the spreadsheet into a Table Folder, then select the Analysis tab.   
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From the drop-down menus, select ANOVA and Two-way Analysis of Variance. 
There is also the option for a Bonferroni or Tukey multiple comparisons post. 
Test. Finally, tick the groups to be compared. 
 

 
 

 
The statistical analysis summary will be shown in the panel to the right. 
 

 
 

 
Automatic Stars of Significance 
Stars of significance can be added to graphs automatically following a two-way 
ANOVA with a Bonferroni multiple comparisons test (as described above). 

If there is a significant difference, the P-value and corresponding stars of 
significance will be displayed in the last two columns. These can be added in 
the graph in the correct position between the two groups being compared.  

To add the stars, select the relevant graph and click on the “****” in the top right 
to display the relevant formatting panel. Tick the elements to be displayed, such 
as stars, P-values and connecting bars. Then in the statistical analysis 
summary table, click the cell in the “Show” column next to the stars that you 
wish to add to the graph. The work “OFF” will switch to “ON”. 
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Other formatting option allow the font size, 
color style and type to be set for the stars and 
P-values.  

 

 

 

 

Bar ends (up and down) can be added to the 
horizontal bar connecting the two groups. 

The bar end height, bar thickness and color 
can also be set. 

 

 

 

 

 

The stars, P-values and bars will be added to the graph once set to “ON”. The 
bars will be positioned between the two groups the statistics describe. These 
bars can only be moved up and down, so will always be connecting the correct 
groups. The stars and P-value can be moved independently of the bar and 
positioned where you wish. 
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As with all other data in GraphLogic, the stars of significance on graphs will 
update if gates are adjusted in GateLogic. 

If more space is required above the graph, consider adjusting the margins. The 
margin formatting panel can be displayed by clicking in the area within the 
graph window surrounding the graph. For more information, see page 186. 
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Creating a Graph 
To graph your data, select the GraphLogic window at the top of the program 
and select a Workspace folder to the left of the spreadsheet. Then, highlight 
the data within a workspace template and drag it into a Table folder (see page 
172). 
 
Click Graph in the Data Folder window to create a bar graph of the imported 
data. The graph appears in the Graph Window. 
 
 

 
 
 

Formatting Graphs 
Graphs can be formatted using the formatting panel on the right-hand side of 
the screen. Specific formatting panels can be displayed by clicking on the part 
of the graph that you wish to edit. For example, click on the x axis to display the 
options to change the x axis scaling, the tick thickness and length, and to turn 
on a vertical grid. Or click on the graph title to change the text and font colour, 
size, style and type. Some formatting panels are represented by words 
positioned in the corners of a selected graph. These include the Graph Type, 
items associated with statistical analyses (represented by ****), STATS for the 
type of average and error bars, the Legend and an INFO window.  
 
The different parts of the graph that can be specifically clicked and formatted 
are shown below. This information window can also be displayed by clicking on 
the “Info” within each graph. 
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Graph Type – choose a different type of graph 
****  – stars of significance, P-values and bars 
Stats  – displayed statistic and error bars 
Legend – drag the legend to the desired position  
Colors – click on a bar to set the group color 
X & Y axis – click on the x or y axis for scaling options 
Axis labels – format the labels on each axis 
Titles – edit and format the text for each title 

 
The following is a description of each of the formatting panels: 
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Graph Type 

 
 
Click on the text “GRAPH TYPE” in the top left corner of the graph to display 
the list of graph types in the formatting panel. Choose from a range of graph 
types, including Bar, Stacked Bar, Pie, Line, Column Scatter, Box and Whisker, 
Linear Regression, 4PL Regression, 5PL Regression. 
 
 
****  

Clicking the four stars (****) in the top left corner of a 
selected graph will display the formatting panel 
associated with statistical analysis tests. 

If a Bonferroni multiple comparisons post-test has 
been performed following an ANOVA, it is possible to 
automatically display the resulting stars of 
significance on the graph. This is done by ticking the 
“Show” option next to each set of compared groups 
in the statistical analysis summary table (see page 
177 for more detail). 

Items that can be formatted include the stars 
themselves, which can be hidden or changed in 
terms of the font size, color, style and type. 

The calculated P-value can also be displayed and 
formatted in terms of the font size, color, style and 
type. 

The horizontal bar connecting the two compared 
groups can also be displayed, along with vertical bar 
ends that extend up and/or down. The color, 
thickness and bar end heights can also be changed. 

Finally, the number of stars associated with each 
range of P-values can be defined at the bottom of this 
panel. 
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Stats 
The stats formatting panel provides options to set the 
type of average to be displayed on the graph (mean 
median or geometric mean). 

The type of error displayed by the error bars can be 
chosen from standard deviation, confidence 
intervals, standard error of the mean and the range. 

The error bar itself can be displayed and hidden, 
displayed above and/or below the average and 
with/without top and bottom caps. The centre can 
also be denoted with a line. 

Finally, the cap width, bar thickness and color can 
also be defined. 

 

 

 

 

 

 

Legend 
Each graph has a legend. However, this can be 
hidden if desired, such as when the x axis labels 
depict the groups. 

When displayed, the legend font size, color, style and 
type can be set. 

A border around the legend can be displayed and the 
border thickness set. A background color can also be 
chosen. 

Each group has a shape assigned to it. This is set in 
the color panel, by clicking on the bar or data point. 
Within the legend formatting panel, the shape size, 
height and gap between the shape and the text can 
be defined. 

Finally, a border around the shape can be turned on, 
the border thickness increased, and the border color 
changed. 
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Colors 
The color for each group can be set by 
clicking on the data, such as within a bar 
in a bar graph or on the data point in a 
line graph. To change the color, click on 
the color displayed next to the group 
name and choose a new one form the 
pop-up window. 

 

Each group has a shape assigned to it, which is displayed on line graphs and 
in the graph legend. The shape for each group can be changed by clicking on 
the shape name and choosing a new one from the drop-down list. 

 

X & Y Axis 

 

The x and y axes can be formatted individually. Clicking on each axis displays 
an identical formatting panel. By default, each axis is auto scaled, depending 
on the data. However, this setting can be turned off and the minimum and 
maximum range values can be entered manually. 

The interval tick thickness, length and color can be set and a grid extending 
from each tick across the entire graph can be displayed. The color for these 
grid lines can also be defined. 
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Axis Labels 

 

The axis label elements that can be formatted include the font size, color, style 
and type. The number of decimal places can be set, and the labels can be 
rotated by a specified number of degrees. 

 

 

Titles 

 

Clicking on the graph title or either of the axis titles displays a formatting panel 
with options to enter new text and change the font size, color, size, style and 
type. 
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Graph Area 
The graph area formatting panel is displayed by 
clicking in the area defined by the axes but not on a 
bar, line or data point. 

Here, the background (area outside the graph area) 
and the plot background (within the graph area) can 
be set. 

A plot area border can be displayed with options to 
set its thickness and color.  

Data borders for bars and shapes (line graphs) can 
be shown/hidden, their thickness increased and color 
changed. 

 

 

 

 

Margins 
The margins formatting panel is displayed by clicking 
in the space surrounding the graph but within the 
selected graph window. The left, right, top and 
bottom margins can be independently set. These 
settings will be transferred to graphs added to reports 
in DocLogic. 
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Regression Analysis 
 
Linear, 4PL and 5PL regression analyses can be performed. Individual curves 
from one data set can be displayed and analysed by themselves or multiple 
datasets can be analysed together, with the curves overlaid on a single graph.  
 
For 4PL and 5PL regressions, the EC50 (or any defined percentage) can be 
calculated and displayed on the graph, individual datapoints can be weighted 
or hidden, and in the case of an overlay of many curves, the sample with the 
lowest EC50 value can be identified as the ‘most potent’.  
 

The table name can be replaced with either the analyte name or a title that 
describes the comparison in the case of regression overlays. 

 
Regression data 
Regression data can be imported into GraphLogic as linked data from 
GateLogic analyses, or by typing or importing directly into GraphLogic. The 
latter will not update automatically as it is not linked to any other source. 

The data is arranged in the GraphLogic spreadsheet in a similar manner to that 
mentioned in the ‘Adding FCS-linked data’ section of this manual but with one 
difference. Instead of the default column count values of 1, 2, 3, etc., replace 
these with the corresponding sample concentration. It may help to rename the 
second row in the table with “Conc.”, “Concentration”, and with the relevant 
units. 

 

 

Generate regression graphs  
To generate a regression graph, follow the steps below: 

• Arrange data in the GraphLogic spreadsheet by dragging in linked files 
and choosing to display the relevant statistic from the toolbar options 
(e.g., MFI for a given gate/analyte) or by importing/typing in the data. 

• Replace the sample column count with the concentration values that 
correspond to each of the samples. 

• Rename to the table (the default name is ‘Table Name’) to make it easily 
identifiable and to help when auto-naming the Table Folder when the 
data is added. 

• Highlight the complete data table and drag into a Table folder in the 
panel to the left (the Table will automatically be renamed with the table 
name as exists in the spreadsheet). 

• Upon dropping the table into the Table Folder, select either ‘Replace’ 
(even if there is no existing data) or Overlay in order to plot multiple 
curves on the one graph. 
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• Click on the Graph tab to open the graph in the workspace. 

• To change the graph type to a regression plot, select the graph and click 
on the ‘GRAPH TYPE’ keywords in the top left of the graph window. This 
will open the corresponding formatting panel to the right of the 
workspace. From here, choose one of Linear Regression, 4PL 
Regression or 5PL Regression. 

Regression graph formatting panel 
The regression plots can be formatted using the range of options in the graph 
formatting panels. Options specific to different parts of the graph can be viewed 
by clicking on the relevant sections of the graph itself. 

Some useful formatting options include: 

• Click on the x-axis to display the X Axis Scaling panel. Change the scale 
to a logarithmic scale using the ‘Log’ option. 

• Additional decades above zero can be added by deselecting ‘Auto-scale 
X min and reducing the value in the X min field. With the log scale 
displayed, the values within the X min field represents the exponent to 
base 10. 

 

 

• Click within the graph space to display the Graph Area formatting panel. 
This will present some options specific to the 4PL and 5PL regression 
plots, shown in the EC/IC section 
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o Define the EC/IC percentage (e.g., 50 to calculate EC50/IC50) 
o Mark the defined EC/IC value on the graph using a combination of 

horizontal and vertical lines. These begin at the relevant axis and finish 
at the point on the regression curve. The ‘Full Horizontal’ option spans 
the entire width of the graph. 

o The thickness of the lines marking the EC/IC value can be increased and 
decreased 

o The colour of the lines can also be changed 

 
Performing regression statistical test 
To a regression analysis, click on the Analysis tab under the corresponding 
Table Folder. This will switch the display from the spreadsheet to the statistical 
analysis window. From here: 

o From the Analysis Groups, choose Regression Analysis 
o From the Analysis Type, choose one of linear, 4PL or 5PL regression 
o From the list of groups/analytes to be included in the calculations. The 

results will be displayed in the panel to the right 
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Auto-updating of graphs to changes in data 
If the data represented in a regression analysis is derived from gates within 
GateLogic, then the any adjustment to the gates will automatically update the 
graphs and statistical test results. 

The graphs and statistical test results will also update to reflect new data when 
performing a File Replacement or when applying an Analysis Template derived 
from a regression analysis.  

 
Weighting and Hiding Data 
To change the weighting of data and to hide data points on the graph, highlight 
the table folder in the spreadsheet, right-click and select Weight and hide data. 
A pop-up window will open showing the values for each concentration, a 
weighting value and a ‘Show’ tick box. 

 

 

 

 

 

 
For any given data point, type in a new value and press Enter. The graph and 
results will update automatically. A weighting value of zero, will mean the data 
point is completely ignored. By default, all values are given an equal weighting 
of one. 

 
Replicating and overlaying regression curves 
There are two methods for overlaying two curves on the one graph: overlaying 
different data tables in one table folder or combing data for multiple analytes in 
one large data table. 

To overlay multiple data tables, generate one regression table as described 
above and then drag a second data table into the same Table Folder. Upon 
releasing the data, select ‘Overlay’ form the pop-up menu.  Click the Graph tab 
to update the graph. 
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To create a regression overlay from one large data table, append the initial data 
table by adding additional datasets to the rows immediately beneath the initial 
dataset. Then drag the entire data table into a table folder.  

 

Data table format 

 

 

Select and drag into a Table Folder 

 

 

Resulting Graph for this dataset with some curves hidden for simplicity 

 

One tip when creating this type of table is to name the analytes with the gate 
name they are derived from is by highlighting the names in the spreadsheet, 

right-clicking and selecting Set Group Name → Via Gate. 
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DocLogic – Reports and Presentations 
 
DocLogic is the document and report building function in FlowLogic. It allows 
you to arrange and annotate plots, graphs, plates, heatmaps, tables and more. 
DocLogic is also linked to GateLogic and GraphLogic, so, any changes made 
to the gates or graphs will automatically update in the report.  
 
To create a report, select the DocLogic tab at the top of the program window. 
In the centre of the screen is the report itself, displaying one page at a time. 
Above the report is the formatting toolbar. On the left of the screen is the File 
Navigator, where tabs allow you to drag elements from GateLogic, PlateLogic 
and GraphLogic into a report. On the right of the screen is the list of documents, 
page preview and the element formatting panels. 
 

 

 
 
 

The DocLogic File Navigator 
Click on the GateLogic, PlateLogic and GraphLogic tabs at the top of the panel 
on the left to view the elements from these sections. Click-and-drag selected 
elements directly to the page. 
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Dot plots, histograms and overlays can be added to a report from within the 
‘GateLogic’ panel. Once selected, individual or multiple plots can to the using 
drag-and-drop. Plates/heatmaps and corresponding statistic and summary 
tables can be added to a report from the ‘PlateLogic’ panel, whilst graphs, 
statistical analysis tables and data tables can be added from the GraphLogic 
panel. 
 
 

Document and Page Preview 
A page preview window exists to the right of the report window. Within the 
window are thumbnails for each page in the document. Clicking on a page 
thumbnail will display that particular page of the document. 
 
The Page Preview window can be resized by clicking and dragging the window 
border or turned off using the ‘Display Page Preview icon in the toolbar. 

 

 

DocLogic Toolbar 
The DocLogic toolbar contains a variety of formatting functions. Below is a 
description of the toolbar buttons: 
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Adding dot plots, histograms and overlays 
Dot plots, histograms and overlays can be added to a report by selecting them 
in the File Inspector and dragging them onto the page. The GateLogic File 
Inspector can be displayed by clicking the GateLogic tab at the top left of the 
screen. If a single plot is selected, it will be placed at the position where the 
mouse is released on the page. If multiple populations are added at once, the 
plots will be tiled. Individually plots can then be dragged to other areas on the 
page. 

Plots will be displayed in DocLogic as they were defined in GateLogic. So, to 
switch a dot plot to a histogram or to change the color of backgated populations, 
make the changes in GateLogic. The report will subsequently be updated to 
reflect the changes. 
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The list of overlays is displayed at the bottom of the File Inspector, as they are 
in GateLogic. 

 

 

 

By default, all populations (gates) are displayed in the DocLogic File Inspector. 
However, the gates can be hidden by unticking “Show Gates” above the toolbar. 

 

 

If you wish to select the same populations in all samples in the folder, make the 
selection on one sample and then click the Highlight Level button above the 
toolbar. These selected populations can then be dragged into a report together. 
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Adding plates/heatmaps and associated statistics tables 
 

PlateLogic elements, including plates/heatmaps, statistics tables, outlier 
graphs and summary tables can be added to a report by selecting them from 
the PlateLogic tab in the File Navigator and dragging them onto the page. 
These elements will be displayed in the report as they appear in PlateLogic. 
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Elements in the PlateLogic panel 

• Plate # - Plates will be listed with the name that is assigned in the data array 
tab in the GraphLogic Advanced Functions drawer. 

 

 

Listed under each plate in the DocLogic Components tab are a variety of 
statistics and data tables, as follow: 
 

• Stat Table 1 – this table shows the statistics defined in the plate side drawer 
and can be colored with the heatmap colors (foreground or background) as 
defined in the plate side drawer. 

 

 

 

• Stat Table 2 – this table shows the same data in a different layout and with 
the addition of two comments columns. Comments can be added from 
within the plate side drawer in GraphLogic. 
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• Outlier Graph – see page 140 

 

 

• Normalized Outlier Graph 

 

 

• Dataset Summary – datasets can be used to separate different samples or 
populations within a plate. This can be matched to the different groups 
created for group analysis. Alternatively, the same files could be added 
multiple times, labeled as different datasets and then analysed 
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independently. The datasets are defined by a color and a name and the 
dataset summary table provides this information. More information on 
datasets can be found on page 133. 

 
 
 

 
 
 
 

• Heatmap Summary 

 
 

 

Adding graphs, statistics tables and statistical analysis results 
 
The elements in the GraphLogic panel are displayed in a tree, as they are in 
GraphLogic. For each Workspace (the GraphLogic spreadsheet) there can be 
multiple Tables where data can be added in GraphLogic. Associated with each 
Table is a statistical analysis table and a graph. These elements, once created 
and customised in GraphLogic, can be added to a report in DocLogic. If the 
Table, Analysis or Graph have been renamed, then they can be identified by 
the new name. Here is a description of the four elements: 

• Workspace – the Workspace heading is for reference only and cannot be 
added to the report 

 

• Table – this is the data set used to build the associated graph 
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• Analysis – this is the resulting statistical analysis summary 

 

 

• Graph – this is the graph, as viewed in GraphLogic, derived from the data 
set in the associated Table. When imported into a report in DocLogic, it will 
retain all of the formatting. However, the same formatting panels form 
GraphLogic exist in DocLogic, so the graph can continue to be edited in 
DocLogic. 
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Adding Elements from the DocLogic Toolbar 
 

Text – a text box can be added to a report by clicking the Insert Text Box icon 
in the toolbar and then using click-and-drag in the report to define the size of 
the text box. By default, the word “TEXT” is added to new text boxes. Click twice 
in the new text box to display a flashing cursor and then start typing or double-
click to highlight any text. Typing when text is highlighted will overwrite with the 
new text. 
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Tables – empty tables can be added to a report by clicking the Insert Table 
Icon and then defining the dimensions of the new table form the drop-down 
menu. The new table will be automatically added to the report. 

Single-click and drag the table to a new position or click and release to select 
the table. Once selected, double-click in a cell to enter text or numbers highlight 
one or more cells in order to copy, paste or format the text or numbers in those 
cells. Click-and-drag a column header to resize individual columns. 

Resize the entire table by single-clicking to select the table and then dragging 
a corner or a corner node. 
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Metadata – Metadata derived form a specific file can be added to a report in 
the form of a keyword text box. These appear like a standard textbox except 
text cannot be entered using the keyboard.  

To create a keyword text box, click the Add Keyword Text Box icon and then 
click in the report. This creates the keyword text box. Then, select a specific file 
from the File Inspector (under the GateLogic tab) and drag it into the keyword 
text box. The Keyword Table window, containing all of the file specific keywords 
and values, will appear. Select one or more keywords (hold control/command 
for multi-selection) and then drag the selection into the keyword text box. 

Multiple keyword text boxes can be created for one or many files. The text can 
be formatted in the same way as the standard text box. 
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Arrows – click the Insert Arrow icon and then click-and-drag in the report to 
draw an arrow of a defined length. Click-and -drag the arrow to move it or click-
and-drag a node to resize it. 

 

 

Rectangles – click the Insert Rectangle icon and then click-and-drag in the 
report to define the size of the new rectangle. Click-and-drag to move a 
rectangle on the page or select and drag a corner node to resize the shape. 
When the rectangle is selected, the corresponding formatting panel is displayed 
on the right side of the screen. Here, the aspect ratio can be locked to resize 
proportionally, or the height and length can be set manually. The border and 
background colours can also be formatted here. 
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Images – PNG and JPG image files can be imported into a report by clicking 
the ‘Insert Picture’ icon in the toolbar and selecting the image by its file location 
and name. Imported images can be resized and positioned anywhere in the 
document. 
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Aligning, Distributing, Grouping and Reordering  
 
There are a range of new tools in the DocLogic toolbar to help arrange elements 
added to a report. These include the ability to align and distribute a selection of 
items, group and ungroup, reorder overlapping items and adding vertical and 
horizontal guides to visually align plots, graphs, plates, shapes and text boxes. 

 

Aligning Items 
 

 

Items in a report can be automatically aligned using one of six icons in the 
toolbar. To align items, select them using either click-and-drag (in the direction 
from top-left to bottom-right) or click to select while holding control/command, 
then click to align horizontally or vertically.  

Horizontal alignment can be by the bottom of the lowest side of any selected 
item, the middle (halfway between the highest and lowest side) or the highest 
side. 

Vertical alignment can be by the side furthest to the left, the middle (halfway 
between the furthest left and right sides) or the side furthest to the right.  

Once items have been aligned, they remain selected and can be repositioned 
all together by clicking and dragging. 
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Distributing Items 
 

 

Items can be distributed evenly both horizontally and vertically. To distribute 
items, select them using either click-and-drag (in the direction from top-left to 
bottom-right) or click to select while holding control/command, then click to 
distribute horizontally or vertically. This spaces the items evenly between the 
first and last in the selection.  

Items remain selected after distribution so can be moved together or aligned 
horizontally, as described above.  

In the following example, three dot plots are distributed horizontally and then 
aligned to the top. 
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Grouping and Ungrouping  
 

 

 

A collection of items can be grouped into a single element. Select the items to 
group and click the icon in the toolbar. Grouped items can be moved and 
resized as a single item. Grouped items can be copy/pasted or cloned as a 
single item. Additional elements can be grouped with already grouped items.  

Ungrouping items will ungroup everything in the group, even if some items were 
grouped into an existing group. To ungroup, select the group of items and click 
the ungroup icon in the toolbar. 

 
 
Reordering 
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Overlapping items are displayed in the order of creation, with the original item 
being on the bottom and the newest on top. The order can be changed using 
the reordering options in the toolbar. 

To reorder, select an item and choose to bring it forward one place or to the 
front, or send it backward one place or to the very back. Items don’t have to be 
overlapping in order to change their order on the screen.  

In the example below, the red square is sent backwards 2 places. 

 

 
Adding Horizontal and Vertical Guides 
 

 

Horizontal and vertical guides can be added to a page to help align different 
objects. While the aligning buttons can align the edge of an item, guides can 
help align elements within an item, such as an axis on a graph. 

To add a guide, click the icon and then click on the page. Move a guide by 
clicking and dragging. Delete a guide by clicking on the guide and then 
clicking delete on the keyboard.  

Multiple guides can be added to a page and guides will remain in the same 
position as you view different pages within a document.  
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Copy, Paste and Clone Items 
 

 

 

Items can be duplicated using the range of copy and paste icons. Select one or 
more items and click the Copy Selected icon. This copies the items(s) to the 
clipboard. Then click the Paste icon to paste the copy. If the item is pasted to 
the same page, then the copy will be offset from the original. However, if pasting 
to a different page, the items will be pasted to the same relative position as the 
original.  

Clicking Cut Selected will remove the original item(s) when the Paste icon is 
clicked. This effectively moves the selected item(s). 

Choosing Clone Selected will create a copy of the selected item(s) and offset it 
to the original. The result is effectively the same as choosing Copy Selected 
and Paste. 
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Copy and Paste Item Settings 
 

 

In the same way that objects can be copied and pasted, object settings can 
also be copied form one item and pasted to another. Examples of settings that 
can be copied include the size of an object and the graph type.  

To copy settings, select an item and click the Copy Selected Settings item in 
the toolbar. Then, choose one or more similar items and click the Paste Settings 
to Selected. 

Copied settings can also be pasted to an entire document or a selection of 
documents. After copying the settings from an item, select one or more 
documents and then click the Paste Settings to Selected Docs icon.  

Example 1 – resizing multiple dot plots: 
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Example 2 – copying and pasting different graph settings. In the first row of 
three graphs, the settings from the graph marked in red were pasted to the two 
graphs to its right. In the second row, all graphs have the same title text size 
and position, and the legend has been hidden.  

 

 

All graph settings are copied except for the titles themselves (it would be rare 
that all graphs would have the same title) and the group color. The group color 
is not copied to allow for settings to be copied and pasted to graphs containing 
different numbers of groups. 

 

Deleting Items from a Report 
 

 

To delete one or more objects from a report, select them and click the Delete 
Selected icon from the toolbar or ‘delete’ on the keyboard. 
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Adding Plot Statistics Tables 
 

Statistics calculated in the plot side drawer in GateLogic can be added to a 
report in DocLogic. To add the table after the plot has been added to a report, 
select the dot plot and then click “Add” under Plot Stat Table in the toolbar. The 
table is a separate element and can be resized and formatted if required. 

 

 

To add the table automatically when importing plots to the report, tick the “On 
Insert” option above the “Add” button. This results in the plot and table being 
grouped. Therefore, to format or move either element, independently from the 
other, select the plot and click the Ungroup icon in the toolbar. 
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Applying Grid Settings to Reports 
 

 

Items existing on a page can be placed into a grid using the options in the 
toolbar. To apply the grid to a page, set the number of rows (vertical value) and 
columns (horizontal value) and then click “Apply”. 

Alternatively, by ticking “On insert” will add objects directly into a grid 
automatically when they are added to the page. 

For example, if 15 plots were added to a page at once, they will be tiled. Setting 
a 5 x 3 grid and then clicking “Apply” will resize and arrange the plots into 3 
rows of 5 plots. 

 

 

If there are more objects than can fit on one page, additional pages will be 
added to the report. The items that don’t fit on the original page will be placed 
into a grid with the same dimensions on the successive pages. However, if the 
grid dimensions are changed and there are fewer items than grid positions, the 
additional pages remain and the items are arranged on the pages that they 
exist on. 

When the ‘1 tube/page’ option is selected when applying a grid setting, all plots 
belonging to a file will fill the defined grid on the initial page and a new page will 
be started for each subsequent file. In this way, the analysis will be arranged 
as 1 sample (or tube) per page.   
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The List of Documents 
 

 

 

Multiple documents can be created in one FlowLogic analysis. The list of 
documents is located on the right-hand side of the DocLogic window. Above 
the list of documents is a small toolbar with icons to create a New Document, 
insert a document between existing documents, export selected documents 
delete selected documents, clone selected documents and change the 
document settings (page size and orientation). 

Documents can be renamed by double-clicking on the existing name and typing 
in a new one. 

When documents are exported, the new file will be named with the document 
name. 

To delete one or more documents, select them and click the delete button in 
the toolbar. A warning window will open asking to confirm the action. 
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Exporting Documents as .pptx files 
 
In addition to the formatting tools available in the DocLogic toolbar, it is also 
possible to export a report as a .pptx file, which can be opened in Microsoft 
PowerPoint. In addition, elements can be further ungrouped for further editing 
and report generation. 

To export a report as a .pptx file, select the document and then choose the 
Export Document option in List of Documents toolbar. Select .pptx form the list 
of files pop-up window before defining the file name and location. 

 

 

When you open the file in PowerPoint, right-click and choose to ungroup 
individual elements or a selection. It may be that not all elements are converted 
to the .pptx file in the exact same format and location but the tools in PowerPoint 
can aid in easily formatting and arranging the items precisely.  
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Below is an example of the extent of the ungrouping in PowerPoint. The images 
show the extent to which further editing and formatting can be achieved. 

Two pages in DocLogic: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Same two pages opened in PowerPoint with all items ungrouped: 
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The Page Preview 
 

 

 

 

 

The page preview is located beneath the list of 
documents window. Click on a page in the preview to 
display it. Above the page preview is a small toolbar 
with icons to Add a New Page, Insert Page, Export 
Selected Pages, Delete Selected Pages and Clone 
Selected Pages. 

 

 

 

 

 

The page preview window is shared with the formatting panel. If an item in the 
report is clicked, the corresponding formatting panel is displayed. However, 
clicking on an empty part of the page or outside the page margins will return 
the panel to page preview.  

 

 

 

If a page has been zoomed, click on the particular page on the page preview to 
fit the page to the computer screen. 
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The DocLogic Formatting Panel 
 

Items added to a report, including dot plots, heatmaps, graphs and text, can be 
formatted in the formatting panel on the right side of the DocLogic window.  

The formatting panel shares the same space as the page preview and is only 
made visible when clicking on the item that you wish to edit. Each item has a 
unique formatting panel based on its attributes.  

Below, the DocLogic formatting panel is marked in red. 
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Formatting Graphs  
 
Graphs generated in GraphLogic have the greatest variety of formatting panels, 
as all aspects from the graph type, group colors, labels, fonts, axes and legends 
can be adjusted.  

Below is an overview of the different regions of a graph that can be clicked 
(marked in red) to display unique formatting panels. For a detailed description 
of these, see page 180. 

 
 
 

Graph Type – choose a different type of graph 
****  – stars of significance, P-values and bars 
Stats  – displayed statistic and error bars 
Legend – drag the legend to the desired position  
Colors – click on a bar to set the group color 
X & Y axis – click on the x or y axis for scaling options 
Axis labels – format the labels on each axis 
Titles – edit and format the text for each title 
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Formatting Dot Plots and Histograms  
 
There are four formatting panels relating to dot plots: the plot size and gate 
label font, plot title, y axis and x axis. 

 

Click inside the plot area to display the size and gate label 
font formatting panel. The aspect ratio can be locked to 
maintain the relative shape when resizing by dragging a 
corner of the plot or by changing the width and height 
values directly in the panel.  

The gate label font size, style and type can also be 
changed. 

 

 

 

 

Click on the plot title to change the font size, style and type.  
 
Click outside the x or y axis to change the axis title and label font size, style and 
type. Additionally, change the major and minor tick lengths and move the axis 
titles vertically and horizontally. The y axis panel also has an option to adjust 
the tick length for histograms. Click “Reset” to return all lengths to the default 
values.  
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Formatting Plates  

Click anywhere in a plate to display the Plate 
formatting panel.  

Here, the title font size, style and type can be defined. 

Choose to lock the aspect ratio and enter values to 
set the width and height dimensions. 

 
 
 
 
 
 
 

 
 
Formatting Tables  

There is one formatting panel for tables generated 
form the Insert Table icon in the DocLogic toolbar.  

* For tables generated in GraphLogic, edit the 
attributes in GraphLogic. As the two sections are 
linked, all formatting will be automatically updated in 
DocLogic. 

The font size, color, style and type can be set for text 
in individual cells. To format the font, highlight the 
desired cells and then change the attribute in the 
panel.  

The number of decimal places can be defined for 
individual cells. 

The alignment of text within individual cells can be 
set to the left, middle or right. 

A selection of multiple cells horizontally or vertically 
adjacent can be merged and merged cells can be 
separated. 

 

The grid color can be defined along with the cell fill color. Additionally, an 
alternating color scheme can be set by ticking the “Alternate” box and choosing 
two new colors by clicking on each of the color boxes. 
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Formatting Text Boxes  

The text box formatting panel has options to change 
the font size, style, type and color. 

A background color can be set for the text box. 

Text can be aligned to the left, middle and right of the 
text box.  

The setting described here are for the entire text box 
and cannot be applied to a selection of text only. 

 

 
 
Formatting Pictures 

Lock the aspect ratio and enter values to set the 
width and height dimensions. 

  

 

 

 

 

Formatting Rectangles  

Choose a fill color for rectangles. 

Change the border color, thickness and style. 

Lock the aspect ratio and enter values to set the 
width and height dimensions. 
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Global Analysis Templates 

 
Global analysis templates can be saved from an Experiment Folder and can 
contain all elements from an analysis including: 

• Gating hierarchies 

• Overlays 

• Plates and heatmaps 

• Graphs 

• Statistical analyses 

• Reports 

So, if an analysis is regularly repeated on the same type of files, a template can 
be created and simply applied to successive datasets. This can automatically 
generate every aspect of the analysis through to the report. After a global 
analysis template has been applied, the analysis is ‘live’, and can be edited and 
refined, such as adjusting gates on individual files. Whilst a template is saved 
from a single Experiment Folder, it can be applied to multiple Experiment 
Folders at once.  

There are some rules regarding global analysis templates: 

• A template can only be saved from one Experiment Folder and only 
one Experiment Folder can exist in the analysis at the time of saving 

• The number of files in the Experiment Folder that the template is 
being applied to needs to match the number in Experiment Folder 
when the template was saved 

• The files in the Experiment Folder that the template is being applied 
to must match the files in the template i.e. the same parameters 

A template can: 

• Be applied to multiple GateLogic Experiment Folders at once 

• Contain multiple GraphLogic Workspaces 

• Contain multiple DocLogic reports 
o Different reports can contain the same files 
o Reports can have any number of pages 

 

There are additional tools that can aid in creating and applying global analysis 
templates. Firstly, saving gate templates can be a quick way to reproduce all or 
part of a gating hierarchy (see page 90). Secondly, when applying global 
analysis templates, the right-click menu in the File Inspect has features to split 
a selection of files into individual Experiment Folders and copy a selection of 
files and paste copies to all Experiment Folders, such as global controls (see 
“Folder Action” on page 90). Finally, saved analysis files (.GLF and 

.gatelogicexperiment) can be imported through File → Open Append (see page 
27 for more detail). This can be useful to combine multiple analyses and 
generate new graphs or reports from the combined data. 
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Saving and Applying a Global Analysis Template 
 

 

 

 

To save the global analysis template, 
right-click on the single Experiment 
Folder in GateLogic and choose 
“Save Template from a Folder. 
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To apply a global analysis template, 
select one or more Experiment 
Folders, right-click and choose 
“Apply Template to Folders”. Then, 
locate the desired template and click 
“Open”. 

The process of applying folders can 
take some time depending on the 
number of folders and files within 
each folder. A pop-up window will 
indicate that the system is 
processing data.  The Experiment 
Folder name in the pop-up window 
indicates the progress. 

 

 

 

 

 

Tips for creating a useful global analysis template  

• As the number of files in the Experiment Folder must match the number in 
the template, if the number of files in each repeated experiment might vary, 
create the template with the maximum number that is likely. It is easier to 
delete files from an analysis after applying a template than incorporating 
them afterwards. E.g., if performing plate screenings, create a template with 
96 files. If the next run has 90 files, use 6 files from the original dataset and 
then delete the original files from the analysis. 

• File replacement can be a useful tool if you want to swap a selection of files, 
rather than applying a template to a complete dataset (for more information 
see page 81). 
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BeadLogic - Introduction 

BeadLogic is a multiplex data analysis tool. Initial sample gating and definition 
is performed in GateLogic (using PlateLogic, for plate layout and visualization) 
before being sent to BeadLogic for regression analysis, unknown sample 
interpolation and reporting. 

 

BeadLogic - FCS/MQD analysis and plate setup in 
FlowLogic 
 
Data acquired on a flow cytometer can be analyzed in FlowLogic flow cytometry 
analysis software and exported to BeadLogic with all plate setup parameters 
defined. 
 
Here is a step-by-step description on how to perform this initial part of the 
sample analysis in FlowLogic. For a detailed explanation of the features 
FlowLogic, please consult the FlowLogic manual and online video guides. 
 

Importing FCS/MQD files 
 
Files can be imported into FlowLogic by dragging a selection of FCS or MQD 
files directly into the Files Inspector. A folder containing these files can also be 
dragged into the File Navigator. Alternatively, from the main menu choose 

File→Import FCS-MQD-LMD-LXB… or Import Folders and select the files by 
their location. 
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OR 
 

 
 

Grouping files and gating on populations 
 
Creating groups can make analysis of multiple samples very quick and easy. If 
a gate is applied to one file in a group, it is automatically applied to the same 
parameters on all other files in the group. 

Select all files to be grouped, right-click and select Group → Add to new. 
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Double-click on a file in the File Inspector to open the plot in the Workspace. 
Click on the parameter labels on the plot to change them. Gate on populations 
by selecting the plot in the Workspace, clicking a gating tool from the Toolbar 
and then use the cursor in the plot to define the gate. 
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After a gate has been created, it will be listed beneath the sample in the File 
Inspector (in this case, R1). The gate name can be changed by right-clicking 
on the gate in the File Inspector. To open the subpopulation, double-click on 
the population in the File Inspector or double-click within the gate on the plot. 

 

 

 

 
 

If the files have been grouped, as in the above Adjustments to individual gates 
are automatically updated to all within the group. If not, highlight the gates in 

the File Inspector, right-click and choose Copy→Copy Gates. Then, highlight 
the files to which the gates need to be pasted to, right-click and choose 

Paste→Gates. 
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Continue gating on the specific bead populations that correspond to the 
different analytes. Naming the populations with the analyte name as the gates 
are created makes assessing the results in BeadLogic much easier. As the 
different populations can be relatively close together on the plot, a useful trick 
is to turn a gate off after it has been drawn. This is done by opening the plot 
side drawer by clicking on the button in the lower left of the plot window (or 
double-clicking within the plot but not within a gate) and selecting the first tab 
called the Gate List tab. Untick the box in the column titled ‘Show’ to turn the 
gate off. This does not delete the gate, it just hides it from view and makes 
drawing new gates easier. Once all gates have been created, tick all of the 
boxes in the ‘Show’ column to make them visible again. 
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Adding samples to a plate in PlateLogic 
 
After gating and naming the bead populations, add all of the samples to a plate 
in PlateLogic. PlateLogic is located in the Advanced Functions drawer located 
below the Workspace. 
To create a plate, click in the plate window and select ‘New PlateLogic’. To fill 
the plate, highlight a group of files in the File Inspector and drag them into the 
desired well in the plate. It does not matter which gate or level of the gating 
hierarchy is selected and dragged into the plate as only the sample is recorded. 
Once in the plate, the specific subpopulation (gate) can be set and analyzed. 

 

 

 

 

 

 

 

Once all files have been added to the plate, use the functions in the Plate Side 
Drawer to help analyze the samples. Specifically, the BeadLogic Export tab. 
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Plate setup 
 
In the ‘Layout tab’, define each of the samples by highlighting them in the wells 
and clicking on one of the sample type buttons. This will color the background 
of the wells to reflect the different sample types, being Standards, Blanks, 
Unlabeled, Unknown or Controls. 
 
Also, define if technical replicates were used. To do this, choose a replicate 
number for the corresponding sample type. This will result in an average value 
for the replicates being used in BeadLogic. 
 

 
 
 
In the ‘Analyte tab’, choose the analytes to export, set the reporting parameter, 
define the units and name the analyte. These functions can be aided using the 
right-click menu.  
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Right-click within the ‘Analyte’ window for the following menu options: 
 

 
 

In the ‘Standard’ window, define the expected concentrations for the standards. 
Highlight one standard and type a value in the ‘Expected’ column and right-click 
to choose a serial dilution factor in an ascending or descending order, 
depending on which standard you begin with. 
 

 



 235 

Once the expected values have been defined for one analyte, right-click and 
choose ‘Copy selected’ to copy the settings. Then, highlight other analytes, 
right-click and choose ‘Apply to selected’ to paste the same values to the 
highlighted analytes. 

 

 
 
Once all settings have been made, click the ‘Send to BeadLogic’ button. Then 
navigate to BeadLogic to continue with the regression analysis. 
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BeadLogic - Layout 
After importing new files or loading a saved experiment, BeadLogic will load 
with the following toolbar displayed at the top of the screen: 
 

 
 
To follow a basic workflow, use the functions located under each of the tabs, 
working from left to right, starting with Layout. 
 
When Layout is selected, a range of Plate Setup features is located on the left-
hand side of the screen. Click on each of these to access options to select 
between plates, define the sample configuration (plate layout), define 
replicates, assign attributes to samples, define dilution factors, display the set 
of analytes tested and to view sample metadata. 
 
In most cases, selecting one or more samples from the diagram to the right of 
the Plate Setup section will enable the various plate setup options to be 
accessed and changed.  
 
To view the Plate Layout, select Setup from the sub toolbar under the Layout 
tab. 
 

 
 
 

 

From the plate Setup tab, you can highlight wells and apply the settings from 
the menus from the left-hand side. 
 
Right-click in the plate layout and choose ‘Discontinuous Selection’ to make a 
selection of wells from across the plate (not just connected horizontally or 
vertically. 
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Plate Setup Features 
 

 
 
Files 

 
 
Listed in the Files window is a list of all ‘plate’ files, which have been imported 
into BeadLogic. A green square beside the plate name indicates that 
appropriate standards have been defined in the plate layout. A red square 
indicates that appropriate standards have not been defined in the plate layout. 
 
When a plate is highlighted in this panel, it is considered to be ‘in focus’ and the 
rest of the system will display its related properties and settings. 
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Sample Configuration 

 
 

 
This panel allows for wells to be defined as a standard, blank, unknown, 
unlabeled or a control. One or more wells have to be highlighted in the plate 
layout for the options in this panel to use. 
 
Standard: a well that is used for the calculation of the standard curve. 
Unknown: a well with an ‘Unknown’ value (an experimental sample being 
analyzed). 
 
Control: a ‘Control’ well, such as a high control or low control. These have a 
separate display on standard curves and output tables. 
 
Blank: a well that is used to record background or non-specific readings. The 
values from ‘blank’ wells are subtracted from all fluorescence intensity (FI) 
readings. 
 
Unlabeled: a well that is ignored from all output and reporting. 
 
Stat: select the desired statistic for use in the selected plate. Some file formats 
do not provide any options while others may give a large number of possible 
statistics to choose from. 
 
Auto-Rename: this will allow you to automatically apply replicate settings when 
assigning well types. 
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Replicates 
 

 
 

Direction: allows for the ‘direction’ of replicates to be set. The options are: 

• Horizontal - the next replicate in the series will be to the right of the 
previous one. Once the series of replicates is filled, the next series will 
start to the right of the previous series. When the end of the selection is 
reached horizontally, the allocation will continue from the next row. 

• Vertical - the next replicate in the series will be below the previous. Once 
the series of replicates is filled, the next series will start below the 
previous series. Once the end of selection is reached vertically, the 
allocation will continue from the next column. 

• Natural - the next replicate in the series will be to the right of the previous 
one (horizontal allocation). Once the series of replicates is filled, the next 
series of will start below the previous one until the end of the selection 
is reached vertically. The setting will then continue from the next column 
and allocate the wells horizontally. 

 

Replicates: this drop-down menu allows you to set the number of replicates in 
a given series. 
 
Sample Name: this text field allows you to set the ‘sample name prefix’ for wells 
prior to replication. A number is appended to the name to signal, which wells 
belong to which series. 
 
Auto-Number – if the name and replicate number is defined for a selection of 
wells, the auto-number feature will append each name with a number in 
ascending order. 
 
Clear All: resets all wells in the current plate, renaming them with their well ID. 
 
Clear: resets all selected wells, renaming them with their well ID. 
 
Apply: applies the settings to the selected wells. 
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Attributes 
 

 
 

This window provides a list of ‘attributes’ or keywords for highlighted wells. A 
drop-down box populated with ‘*’ indicates that the selected wells have different 
values for the given attributes.  
 
Right-click within this window to access options to add or remove keywords 
from the current plate as well as edit the global attributes list. 
 

 

 
Dilution 
 

 
 

This panel can be used to apply dilution factors to wells. If dilution factors have 
been applied, BeadLogic can signal if there is a difference in dilution between 
different wells. Dilution factors are also used in conjunction with the Curve Fit 
section (accessed in the main toolbar) to define serial dilutions of standards 
without having to define expected values manually. 
 
Dilutions can be defined using the features under either the Basic or Advanced 
tabs. 
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Basic: 

• Peak: the ‘Initial’ or ‘Neat’ concentration. 

• Dilution: the serial dilution ratio of subsequent wells. 
Advanced: 

• y[0]: the ‘Initial’ or ‘Neat’ concentration. 

• y[n+1]: an area where an equation can be entered for the 
calculation of the next value in the dilution series. 

 
Apply: when clicked, the Basic or Advanced settings will auto-populate the 
selected wells with the appropriate dilutions. 
 
Dilution Table: a table where dilutions can be both viewed and manually entered 
on a sample-by-sample basis. 
 
 

Analytes 
 

 
 
 

The analytes being analysed are displayed in this window. A green square next 
to the analytes indicates that all of the standards for that analytes fit within a 
defined acceptable error range. A red square indicates that at least one 
standard falls outside of the defined acceptable error range. To automatically fit 
the curves to the data, right-click on an analyte and select Auto-Fit. 
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Metadata 
 

 
 

The metadata window displays all of metadata associated with an imported file. 
Metadata can be exported by right-clicking in the metadata window and 
choosing Export Table. Choose to export the metadata as either a CSV or an 
Excel XML Workbooks file. Note: some file formats do not provide metadata. 
 
 

List (Data) 

 
 
The List (Data) tab provides a table display of the current data. To export the 
data, right-click within the table and select Export Table. 
 
Above the table are a number of table format settings. These are: 

• Table Value: select the type of value to be displayed in the table for the 
current plate 

• FI (Fluorescence Intensity): when selected the statistic for the 
table is the raw fluorescence intensity. 

• Observed: this is the observed (regressed) value without any 
markings whether the value is OOR or not 

• Observed (limit): this is the observed value, although if a value is 
considered to be OOR, it will be limited to the relevant upper or 
lower limit of quantization. 

• Observed (removed): this is the observed value but when it is 
considered OOR, it will be marked OOR> or OOR< appropriately. 

• Bead count: this is the recorded bead count for the sample. Note: 
some file formats do not provide bead count data. 

 

• Table Statistic: the aggregate statistic for the replicates used for the table. 

• Mean: the mean of all the selected ‘Table Values’ for the 
appropriate sample. 

• CV%: the Coefficient of Variation of the selected ‘Table Values’ 
for each sample. 

• SD: the Standard Deviation of the selected ‘Table Values’ for 
each sample. 

• Min: the minimum value of the selected ‘Table Values’ for each 
sample. 

• Max: the maximum value of the selected ‘Table Values’ for each 
sample. 

• Sum: the sum of the ‘Table Values’ for each selected sample. 
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• Highlight OOR: if enabled then the ‘Out of Range’ samples will be 
highlighted in red. 

 

• Background Color: provides the rules for the background color of the given 
wells. 

• No Background: If selected then there is no background color 
coloring 

• CV FI: if selected then the cell background will be colored yellow 
when the CV of the fluorescence intensity is outside the threshold 

• CV Obs: if selected then the cell background is colored yellow 
when the CV of the observed values of the given cells is outside 
of the threshold 

• CV% Thresh: The threshold that is applied to the background color settings. 

 
 
List (Attributes) 

 
 

 
The List (Attributes) tab provides a list of all samples and the 
Attributes/Keywords that have been applied to them. Right-click to export the 
entire table or to apply keywords to selected samples. 
 

 
 
 

List (Well Data) 

 
 
The List (Well Data) provides a quick view of all the raw data in the table not 
separated by sample. 
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BeadLogic - Curve Fit 

 
 
In the Curve Fit tab, curve-fitting functions can be performed manually or 
automatically. Manual adjustments (enabling and disabling standards) are 
performed individually, on a per analyte basis. 
 
Within the Curve Fit tab there are five windows. On the left-hand side are the 
Files and Analytes windows and in the workspace on the right-hand side are 
the Regression Curve, Regression Tornado and Regression Table windows. 
Click on the window headings to expand and collapse them. 
 
Files 
See Layout → Files for a more detailed explanation. 
 
Analytes 
 
 

 
 

 
The analytes in the current plate are displayed in this window. When an analyte 
is selected within this window the output in the Regression Curve, Regression 
Tornado and Regression Table windows will update to display the result for the 
specific analyte. 
 
A red square next to the analyte name signals that it has at least one standard 
with an error outside of the acceptable recovery range. If a given plate provides 
‘bead Id’ information, this can be used to apply a compatible kit info to the plate, 
which will pre-fill expected concentrations of standards. 
 
The right-click menu is as follows: 

• Copy Regression to All: copy the Acceptable Recovery Range and 
regression settings and apply it to all analytes in the plate. 

• Auto-Fit: runs the ‘Auto-Fit’ algorithm for all analytes in the plate. The results 
can then be checked visually. This algorithm progressively disables 
standards at the upper and lower limits of the range until all standards sit 
within the acceptable recovery range. 
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Regression Curve 
 

 
 
The Regression Curve window displays the standard regression curve. There 
is one ‘Log → Lin’ button on each axis to allow for the switching of axis 
transformations. This display is configurable from the right-click menu: 
 

• Show regression Curve: enables/disables the regression curve from the 
display. 

• Show Calculated Standards: enables/disables the ‘calculated’ standard 
values. 

• Show Raw Standards: enables/disables the ‘Raw’ standard values (non-
regressed). 

• Show Unknowns: enables/disables display of unknowns on the curve 

• Show Standard Wells: enables/disables the actual ‘wells’ that make up each 
standard sample. All wells are included in the calculation for a quick visual 
display of CV within a standard sample. 

• Show Controls: enables/disables the display of controls from the standard 
curve. 

• Show Legend: enables/disables the display of the Legend on the regression 
curve display. 

• Axis Font: allows the axis label font to be changed. 

• Number Font: allows the numeric axis label font to be changed. 

• Legend Font: allows legend font to be changed. 

• Title Font: allows regression plot title font to be changed. 

• Show Legend Outside of Plot: allows the location of the legend to be 
changed: 

•  outer right-hand side of the plot area 

•  top left-hand side inside the plot 
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• Regressed Standard Size: allows the size of the 'dots' for the regressed 
standards to be changed. 

• Standard Size: allows the size of the 'dots' for the raw standards to be 
changed. 

• Unknown Size: allows the size of the 'dots' for the unknowns to be changed. 

• Control Size: allows the size of the 'dots' for the controls to be changed. 

• Show All: displays all plot items for the standard curve. 

• Export: export the standard curve in one of a number of external file formats: 
 

 

 
 
 
Regression Tornado 

 

 
 
 
The Regression Tornado window provides a simple display to view the 
difference between expected and actual values for the standards. 
 
The plot is configurable via the right-click menu: 

• Background: change the background color for the plot. 

• Enabled Foreground: set the foreground color for a standard that is both 
enabled and within the acceptable recovery range. 

• Disabled Foreground: change the foreground color for a standard that has 
been disabled. 

• Out of Range foreground: set the foreground color for a standard that is both 
enabled and out of range. 

• Draw Text: if enabled, text appears on the inside of the tornado plot. 

• Plot Font: change the font inside the plot. 

• Title Font: change the font for the title (axis). 



 247 

Regression Table 
 

 
 
Within the Regression Table, standards can be enabled and disabled. The 
manual entry of expected concentrations can also be performed in this window. 
 
Right-click to display options to configure the table: 
 

 
 
 

 

• Serial Dilution (Descending and Ascending): allows for the setting of 
expected concentrations via a serial dilution (starting at the value of 
Standard 1). 

• Manual Dilution: set the defined dilution factor using the format: *x (where x 
is the dilution factor) 

• Copy Expected: once the dilution factor has been defined, the settings 
determining the Expected Values can be copied from one analyte and 
pasted into the Regression Table of other analytes. 

• Paste Expected: this option becomes available after copying the dilution 
settings from one analyte. This option allows the settings to be pasted into 
the Regression Table of other analytes. 

• Clear Concentrations: clears all concentration settings in the Expected 
column. 
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• Wells: displays the well ID and FI for an individual sample. 

• Calculate best fit: performs the best fit algorithm for the standards. 

• Apply Expected Values to All: this applies the Expected values from one 
analyte to all others in the analysis. 

• Export Table: export the table as either a CSV file or an Excel XML 
Workbooks file. 

• Table Setup: define the number of decimal places and the text font used in 
the table. 

• Print: allows for the printing of the Regression Table. 
 

Within the Regression Table panel are settings to define the Acceptable 
Recovery Range, Regression type and the concentration units. These are as 
follow: 
 
 

 
 
 

 

• Acceptable Recovery Range: the percentage for which a given standard’s 
expected value can fall in based on the regressed value. 

• Regression: use to set the current regression type. The options are: 

• Linear 

• Linear (Point to Point) 

• 4-PL Fit 

• 5-PL Fit 

• Cubic Polynomial 

• Units: the units to be displayed in reports and tables for a given analyte 

• Uloq and Lloq: the upper and lower limits of quantification. These values 
represent the highest and lowest fluorescence intensity values from the 
standards. 
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BeadLogic - Analysis 
 

 
 

 
The core of the analysis area is data mining and preparation for statistical 
analysis and reporting. 
 
Tables  
 

 
 

 
This is the primary list of tables, which are used for data mining and analysis. 
When a plate is imported a table is automatically created but a table should not 
be mistaken for a plate. Tables can contain the data from many plates. Rename 
a table by double-clicking on its name and typing the new name. 
 
A right-click within the table window brings up a menu with the following 
features: 

• New Table: creates a new table from a plate containing data. 

• Clone: creates an identical copy of the highlighted table. 

• Data: allows data from individual plates to be enabled/disabled.  

• Delete Table: deletes the highlighted table. 
 
Table Setup  
 

 
 
 
Three levels of control are available for data mining: Basic, Intermediate and 
Advanced. 
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Basic 
 

 
 

 
 
 
This is the simplest form of table generation. It does not provide any mining or 
aggregation tools, although it does make it simple to quickly produce a table of 
results. There is a number of buttons that enable/disable columns and rows in 
the data table. These are located in different subsections. 
 

• Value 

• FL: displays the Fluorescence Intensity columns in the table for each 
analyte. 

• Observed: displays the Observed value columns for each analyte. 

• Observed (Limit): displays the Observed (Limit) columns for each 
analyte. 

• In Range: displays the In Range columns for each analyte. 

• Bead Count: displays the Bead Count columns for each analyte. 
 

• Fields 

• Show Standard: displays all rows that where wells have been marked as 
standards. 

• Show Blanks: displays all rows where wells have been marked as 
blanks. 

• Show Controls: displays all the rows where samples have been marked 
as controls. 

• Show Unknowns: displays all rows where wells have been marked as 
unknowns. 

• Show Keywords: displays all the ‘Text’ columns for a given table. 

• Stat 

• Mean: displays the mean of the replicates for each displayed column.  

• CV %: displays the coefficient of variation between replicates for each 
displayed column. 

• Std. Dev.: displays the standard deviation between replicates for each 
displayed column.  

• Min: displays the minimum value of the replicates for each sample for 
the displayed columns. 

• Max: displays the maximum value of the replicates for each sample for 
the displayed columns. 
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• Sum: displays the sum of replicate values for each given sample for the 
displayed columns. 

 

• Sample Label: choose between displaying the sample name or other 
sample descriptions as defined in the Attributes panel of the Layout tab, 
through the right-click menu and the Add/Remove Keywords option. 

 
 
Intermediate 
 

 
 
The intermediate table setup allows for both data aggregation as well as data 
filtering and grouping. The features contained within the Intermediate window 
include: 
 

• Group By: creates an initial level of grouping. Once a column is selected as 
available for grouping, all of the rows will be ‘merged’ with the selected 
aggregation statistic. 

 

 
• Then By: provides the second and third levels of grouping. 

• Split Groups: when enabled, the sorting is kept but the groups are split back 
into their samples. This can be useful for a quick view of the source data 
without having to modify grouping settings. 

• Statistic: allows for the selection of the aggregation statistic for grouped 
data. 

• Table Value: allows for the selection of the source statistic for each sample. 

• Statistic Value: allows for the selection of the statistic calculation used to 
generate a single sample value. 

• Sample Label: allows the Value in the ‘sample’ column to be changed. 

• Visible (column): allows data columns to be made visible/invisible. 

• Sample Filter: Click on ‘Sample’ under ‘Column’ in the table to view the 
entire sample list to the right. Make a selection using the check boxes in the 
‘Included’ column, or by using the buttons below the panel, and click apply. 
The resulting sample list and statistics will be displayed in the Data Table 
below the Table Setup window. 
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• Numeric Filter: use the numeric filter to remove rows that do not meet certain 
criteria. The numeric filter will appear when a row is selected in the table. 

•  

 

 

 

• List table: once the setup is complete, click the ‘Apply’ button to apply the 
filter. There are a number of filter options available. 

• None: no filtering is performed. 

• Equals A: when a value from the given column matches the value 
entered in the text box for ‘A’ it will be included in the output. 

• Not Equals A: when a value from the given column does not match 
the value entered in the text box for ‘A’ it will be included in the output. 

• Less than A: when the value for the given column is less than A it will 
be included in the output. 

• Greater than A: when the value for the given column is greater than 
A it will be included in the output. 

• Less than or Equal to A: when the value for the given column is less 
than or equal to A it will be included in the output. 

• Greater than or equal to A: when the value for the given column is 
greater than or equal to A it will be included in the output. 
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Advanced 
 

 
 
The advanced table setup is similar to the intermediate table with the exception 
of having a full grouping window where the grouping level of any given analyte 
can be set from the main editor. 
 
 
Data Table 
 

 
 
Right-click in the table and select from the options to Export the data, define 
the number of decimal places, change the font and print. 
 
By clicking on the table column headers, you can sort the rows by a given 
column's values in either ascending or descending order. 
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Quick Heatmap  
 

 
 
 
 

 
 

 
The quick heatmap has all of the basic functionality of the ‘Data Table’. Each 
column’s values are separate in regard to the heatmap calculation and 
therefore the color, which is defined as the ‘maximum’ for that particular 
statistic. The heatmap is updated as the selections made in the Table Setup tab 
are changed. 
 
Color Scheme: this drop-down box different color options for the heatmap. The 
different color options are: 
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BeadLogic - Statistics 
 

 
 
Within the Statistics tab, values displayed in the Data Table of the Analysis tab 
can be graphed and analyzed. 

 

Bead Data: located to the left of the worksheets, the Bead Data window 
contains a list of all the 'tables' that have been built in the Analysis section. A 
default graph and analysis are created for each table. Double-click the graph 
name to open it in the workspace above the worksheet. Right-click on the graph 
name for options to rename it (along with adding a new experiment, opening a 
graph in the graph workspace and deleted the highlighted row). 

 

 
 

 
Data: the data section allows for mathematical manipulation and concatenation 
of data tables. 
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Graphing data 
 
Display all of the relevant data in the Data Table of the Analysis tab and choose 
the specific samples that you wish to be included in a graph. Note that the 
different values and specific analytes can be chosen in the Statistics tab but the 
selections of samples cannot. 
 
Once all desired data and the correct samples selection has been performed, 
return to the Statistics section. Choose the specific plate in the Bead Data 
window and the same data displayed in the Data Table will be displayed in the 
data window to the right. 
 
Select populations from the drop-down menus for the Primary Group and the 
Analyte. The table will automatically update to show the defined data. To open 

a graph for the defined data, double-click or right-click → Open Graph the 
‘Graph’ tab in the Bead Data tab. The graph will be displayed in the graph 
workspace above the data tables. 
 

 

 
Right-click on each axis of the resulting graph to display options to set the font 
type, color and alignment, define the number of decimal places and change the 
angle of the text. 
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Right-click within the graph area to display a different menu with options to 
change the color of individual samples, the background color, turn the graph 
border on or off, set the border color and export the graph. 

 

 

 
Each graph has a side drawer containing a range of formatting options. This 
can be opened by clicking on the double arrows at the bottom right of the graph. 
 

 

 

The side drawer is divided into five tabs: Graph Settings, Graph Axis Settings, 
Graph Color Settings, Graph Legend Settings and Graph Border and 
Background. 
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Graph Settings 
 

 
 

From the drop-down menu, choose from different graph types: 

 
 
Different graph formatting options will appear in the window depending the type 
of graph chosen.  
Graph types: 
 
Pie Graph 
 

 
 

• Output Value: allows for the selection of the statistic, which determines 
the output value of each slice. 

• Group Slice: turns the pie graph into a ringed pie graph. 

• Draw Border: enables/disables the border of each ring. 

• Labels: allows the Selection of ‘None’, ‘Percentage’, ‘Value’ or ‘Name’ 
as the labels for each slice. 

• Label Color: allows the color of the labels to be changed 

• Label font: allows the font of the labels to be changed. 
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Group Bar Graph 

• A bar graph that shows individual values without statistical manipulation. 

• Interleaved: if enabled, each group column is interleaved with the others.  

• Draw Border: enables/disables the border around each column 

• Border Color: allows the color of the column border to be changed. 

• Gap: define the gap between columns. 

• Group Gap: define the gap between groups. 

• Gap Alignment: allows groups of columns to be justified in different parts 
on the x-axis. 

 
Bar Graph 
 

 
 

 

• Includes statistical manipulation on values within groups to provide each 
portion of the bar. This Graph type can also be used to create box and 
whisker plots. 

• Bar Height: allows the height of each column to be defined based on a 
statistic for a given group 

• Error Bar 1: allows the position of one of the error bars to be defined 
based on a statistic for a given group 

• Error Bar 2: allows the position of the other error bars to be defined 
based on a different statistic for a given group 

• Bar Style: allows for the manipulation of how the error bars are drawn 

• Bottom: allows for the location of the 'bottom' of the bar to be set. 

• Stacked Bar Graph: the stacked bar graph shows multiple bars either 
stacked or overlapped 

• Superimposed: when enabled the bars are overlapped. Otherwise, they 
are stacked on top of each other. 

• Gap: allows for the setting of a 'gap' between bars. 

• Alignment: the alignment of the bars on the X axis. 

• Dot/Line 

• Draw Lines: if enabled, lines are drawn 

• Draw Points: if enabled, points are drawn instead of lines. 

• Regression Plot 

• Histogram 

• Column Scatter 
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Graph Axis Settings 
 

 
 

Various formatting options for the x and y axes are available in the Graph Axis 
Settings tab. These are divided into the categories of General, Labels, Scale, 
Major Tick Lines and Minor Tick Lines. 
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Graph Color Settings 
 

 
 

Click on the Fill color associated with a particular sample to choose a new color. 
 
Graph Legend Settings 
 

 
 

Format various elements related to the graph legend. 
 

 

Graph Border and Background 
 

 
 

Choose a color for the border and graph background. Choose to display or hide 
the border. 
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Statistical Analysis 
To perform a statistical analysis on data contained in a graph, in the Statistics 
section click ‘Analysis’ associated with the particular graph in the Bead Data 
window. This displays the available statistical tests and the list of samples to 
compare in the ‘Analysis’ window.  
 
To perform a statistical test, choose an Analysis Group along with an Analysis 
Type from the drop-down menus. 
 

 
 

Select the groups that you wish to compare and click ‘Apply’. The result will be 
displayed in the Description and Analysis columns adjacent. 
 
 

 
 
 

The options with the Analysis Group are: 
• t tests (Parametric and non-Parametric) 
• One-way ANOVA (Parametric and non-Parametric) 
 
For t tests, the options with the Analysis Type are: 
• Unpaired t tests with Welch-Satterthwaite approximation 
• Unpaired t tests 
• Unpaired t test Equal Variance 
• Paired t tests 
• Mann-Whitney 
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For One-way ANOVA, the options with the Analysis Type are: 
• One-way analysis of Variance 
• Kruskal-Wallis test 

 
Another option for graphing data is in the Graph Modify Data Window. This can 
be accessed by selecting a Worksheet in the Data window (next to the tab for 
the Bead Data window. 

 

 

 

This is where calculations involving group data (as displayed in the Graph Data 
Worksheets) can be performed. For example, proportions of one group (or 
individual samples) can be compared to another, with the result automatically 
converted into a new graph. 

 
For example, the percentage that Group 1 is of Group 2 can be calculated as 
follows: 
 

 
 
Enter a number in the Value 3 field and click ‘Apply’. 
 
 
By default, the first graph in the Graph Data window is titled ‘Graph 1’ and the 
first Graph in the Graph Modify Data window is ‘Graph 2’. This is why when 
adding a new graph to the Graph Data window it appears as ‘Graph 3’. Names 
of all graphs, analyses, worksheets and experiments can be renamed by 
clicking on the title when it is selected. 
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BeadLogic - Report 
 
Reports can be generated, containing any of the elements created as part of 
the data analysis. 
 

 
 
 
These elements along with various formatting options can be selected from the 
panels below the tabs to the left of the page layout. These tabs are: 
 

 
 

To add an element, click-and-drag it from the panel directly onto the page.  
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Reports can be annotated and edited using the elements in the toolbar at the 
top of the screen. These include: 
 

 
 

 
Layout and library templates: To create a layout template, click the template 
button in the toolbar and press ‘Save’. This allows the user to save a basic 
report template including headers and footers. Data is then added to the report 
manually. To save a Library Template, create a report including all data 
(graphs, tables, heatmaps, etc.). Then, click Library at the bottom of the screen 
and click ‘Save’. Enter the library name and description and click ‘Ok’. To load 
a Library Template, select ‘Library’, choose a library and click ‘Apply’. This will 
load the library template and repopulate all the data-associated elements with 
the results from the new analysis. 
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Click through the tabs above the File Inspector to customize and manage your 
document. 
 
 
A default report showing all regression curves can be generated by right-
clicking on an analyte in the Analytes panel in the Curve Fit tab and selecting 

‘Send all to report’ → ‘Default Analyte Report’. 
 
 

 
 

 


